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1. Introduction

Bienvenue au Guide de l’utilisateur de Mahara. Ce guide a été écrit dans le but d’expliquer rapidement et simplement l’utilisation de Mahara à toutes celles et ceux qui vont l’utiliser au quotidien. Le public cible de document est celui des utilisateurs de base qui y trouveront une explication aux différentes fonctionnalités de Mahara. Les administrateurs de sites et d’institutions trouveront des informations plus techniques dans une section qui leur est dédiée dans ce guide.

Sans plus de fleur de rhétorique, allons-y !


1.1. Qu’est-ce que Mahara ?

Si vous vous demandez ce qu’est Mahara ou un ePortfolio en général, et pourquoi vous devriez en créer un pour vous, veuillez lire ce qui suit — vous comprendrez alors en quoi cet outil peut vous aider.

Pour faire simple, Mahara c’est deux choses différentes : c’est avant tout un système de gestion d”ePortfolios [http://fr.wikipedia.org/wiki/ePortfolio], mais aussi d’un système de réseau social [http://fr.wikipedia.org/wiki/R%C3%A9seau_social], combinés. Un système de gestion d’ePortfolios est un système qui permet aux étudiants de collecter et ordonnancer leurs preuves « d’apprentissage tout au long de la vie » — comme des essais littéraires, des travaux artistiques ou tous autres documents qu’ils produisent dans le monde numérique. Ces documents sont appelés artefacts ou productions dans Mahara. En ce qui concerne les réseaux sociaux, ils sont déjà rentrés dans les moeurs et ne nécessitent pas beaucoup d’explication; pensez notamment à Bebo [http://bebo.com/], Facebook [http://facebook.com/] ou MySpace [http://www.myspace.com/]. En résumé, ils permettent à des personnes d’interagir avec des contacts et de créer ses propres communautés dans un monde virtuel, en ligne.

But Mahara is much more than just a place to store files. Mahara also includes blogging, a resumé builder, and Moodle [http://moodle.org/] integration.




1.2. Le cadre d’application de Mahara

Avec Mahara, vous contrôlez quelle information de votre ePortfolio vous désirez montrer, à qui, et pour combien de temps. Ces différentes informations sont nommées artefacts ou productions. Pour faciliter l’accès à ces productions, chacune d’elles peut être placée ensemble dans un ou plusieurs emplacements. Dans Mahara, ces emplacements sont appelés des pages. Vous pouvez créer le nombre de pages que vous désirez, chacune contenant les productions différentes en fonction de l’usage de votre portfolio et du public cible auquel vous désirez le montrer. Les personnes à qui vous désirez donner l’accès à vos pages peuvent être soit : d’autres utilisateurs de Mahara; des membres d’un groupe; voire des personnes à l’extérieur de Mahara.

Par exemple, vous pourriez créer :


	une page pour vos amis et votre famille qui inclut des photos de vacances et un journal de bord


	une page pour votre tuteur, qui contient vos devoirs pour évaluation ainsi qu’un journal réflexif sur vos apprentissages


	a page to showcase your best pieces of work and your resumé for potential employers


	…




Une seule page ou une collection de pages peuvent faire partie de votre portfolio. Bien que des productions soient sur des pages de votre portfolio, vous seul pouvez les consulter, à moins que vous ne permettiez l’accès aux personnes de votre choix. Vous pouvez utiliser les documents que vous auriez téléversés ou des articles de journaux que vous auriez écrits dans votre blogue, dans autant de pages qu’il vous plaira. Quel que soit le nombre de fois que votre production est utilisée dans des pages, vous n’en aurez besoin que d’une seule copie dans votre gestionnaire de fichiers.

Imagine you collected all your artefacts in a shoe box. Whenever you have a new artefact, you add it to the shoe box. When you are ready to create your portfolio, you take a look at the artefacts in your shoe box and choose those that you want ot make available on a portfolio page. You can arrange the artefacts on that page to your liking.


[image: artefact box]
Travailler avec Mahara



Le diagramme ci-dessous vous montre un exemple de productions, de pages et de groupes pour illustrer comment le contenu peut être partagé et réutilisé dans différents contextes, ou pour différents publics, avec Mahara.


[image: Mahara framework]
Cadre d’application de Mahara






1.3. Comment s’intègre Mahara dans un schéma e-learning

Si vous pensez aux LMSs [http://fr.wikipedia.org/wiki/Learning_management_system], tels que Moodle, Sakai ou Blackboard, formant le côté structuré et formel de l’e-learning, eh bien Mahara en est le côté social et réflectif. Un LMS et un système de gestion d’ePortfolio sont complémentaires dans un environnement numérique d’apprentissage.

De plus, comme les API de Mahara sont ouvertes à tous, Mahara s’interconnecte avec Moodle de manière native et standard, procurant aux utilisateurs une expérience unique d’outils pour leurs apprentissages. Depuis Moodle 2.0, la collaboration des deux outils n’est plus limitée au simple système de connexion avec authentification unique (SSO) avec le réseau MNET, mais permet aussi aux étudiants d’exporter depuis Moodle dans Mahara leurs travaux évalués, leurs blogues et bien d’autres productions. Ces dernières peuvent bien entendu ensuite être placées dans des pages de Mahara.




1.4. Que faire si Mahara ne possède pas une fonction dont j’aurai besoin ?

Mahara a été construit sur un mode prônant l’ouverture et la modularité par système de plug-ins. Créer des nouveaux types de productions, d’autres systèmes d’authentification, accéder à d’autres systèmes de gestion de données, etc. peuvent être développés au moyen d’une documentation technique et des API à disposition des programmeurs. Ceci signifie qu’il est possible de modifier simplement Mahara, par vous-même, pour qu’il corresponde aux besoins qui sont les vôtres. Un support payant est possible [http://www.mahara.org/partners], en contactant un membre de notre réseau de partenaires Mahara.




1.5. Autres choses à faire

Maintenant que vous avez une vue générale que ce qu’est Mahara, vous pouvez :


	Lire la liste des fonctionnalités de Mahara.


	Explore the demo [http://demo.mahara.org/] or download mahara for yourself to play with.


	Devenir membre de la communauté sur mahara.org [http://mahara.org/registration.php] et commencez à poser des questions et contribuer dans les forums [http://mahara.org/interaction/forum/index.php?group=1] (en anglais) ou dans ceux de la communauté francophone [https://mahara.org/group/view.php?id=6].


	Continue reading this user guide!







1.6. Où puis-je trouver des idées pour utiliser au mieux Mahara ?

Le livre Mahara 1.4 Cookbook [http://www.packtpub.com/mahara-1-4-cookbook-for-training-education/book] par Ellen Marie Murphy a été publié en septembre 2011. Il contient plus de 50 idées sur comment utiliser Mahara dans différents contextes. Le livre peut être acheté au format papier et/ou PDF sur le site de l’éditeur ou au format papier dans les bonnes librairies.




1.7. Obtenir de l’aide


	Des bulles d’aide contextuelle sont disponibles sur la plupart des sections de Mahara. Cherchez l’icône d”aide [image: help]. Cliquez sur cet icône pour avoir plus d’informations sur l’opération que vous désirez effectuer.


	Vous pouvez aussi poser vos questions sur les forums en anglais [http://mahara.org/interaction/forum/index.php?group=1] ou  les forums en français [https://mahara.org/group/view.php?id=6].










          

      

      

    

  

    
      
          
            
  
2. Tableau de bord

After you successfully logged in to Mahara, you see your dashboard. This is your homepage where you can see the latest activity of you and other users on Mahara. You can customise the dashboard so that you always see the items that are most important to you.

Vous seul avez accès à ce tableau de bord. Personne d’autre ne peut le voir ou l’accéder.


2.1. Aperçu

Vous pouvez changer certains aspects de votre tableau de bord, formellement les informations spécifiques à l’utilisateur. Toutefois, un grand nombre d’informations que vous voyez sur cet écran sont statiques, vous permettant de vous déplacer facilement aux différents outils et sections de Mahara.


[image: the full dashboard]
Your homepage is your dashbaord from which you can access a number of areas in Mahara conveniently.




	General navigation bar: Move from one area of Mahara to the next.


	Préférences : Ce lien vous permet d’accéder à la page des Préférences et Notifications.


	Boîte de réception : Ce lien vous permet d’accéder à votre Boîte de réception pour consulter les messages reçus. Quand vous avez des messages non lus, le compteur indique le nombre de messages en attente de lecture.


	Déconnexion : Lien pour vous déconnecter de votre session courante.


	User search: Search for users who have an account to view their portfolio pages / collections.


	Informations personnelles : Dans ce bloc figure un nombre d’informations personnelles fixes et variables :


	Votre nom est aussi un lien vers votre page de profil


	Votre image du profil est aussi un lien vers votre page de profil


	Si vous êtes membres d’un ou de plusieurs groupes, ils sont affichés ici.


	Pending friend requests are displayed.


	Si vous avez attaché le mot-clé « portfolio » à des productions ou des pages, des liens vers elles sont placés ici.






	Online users: If this sidebar block is enabled, you see all users who have been logged in during the last 10 minutes.


	Quick links: These quick links take you to certain areas of Mahara fast.


	Informations spécifiques à l’utilisateur : Vous pouvez personnaliser cette zone sur votre tableau de bord, avec des blocs que vous aimeriez consulter à chaque fois que vous vous connectez.







2.2. Guide d’utilisation

Quand vous vous connectez à Mahara pour la première fois, vous voyez ce bloc avec les liens suivants :


	Créer et rassembler :  Développer votre portfolio


	Organiser   Présenter votre portfolio


	Partager et réseauter :   Se connecter à un réseau d’amis et collaborer en groupe de travail





[image: Dashboard boxes]
Informations sur Mahara



Avec les liens sur les différentes parties de ce bloc, vous pouvez accéder rapidement aux différentes sections et outils de Mahara, directement depuis votre tableau de bord.


Note

If you removed these boxes from your dashbaord but want to get them back at a later point, you can re-active them under Settings -> Show information about Mahara on the home page.






2.3. Informations spécifiques à l’utilisateur

Le tableau de bord par défaut inclut les blocs suivants :


	Latest Pages


	My Pages


	Recent Activity


	Topics I’m Following




These areas are filled with content once you start using Mahara and create pages, receive messages from other users, have access to others” portfolio pages and use the forums for discussions. You can customize this area to your liking by editing your dashboard in Portfolio -> click the Edit button [image: edit] next to the dashboard page -> change the blocks like you would change them on any page in Mahara.


Voir aussi

Référez-vous aux informations sur l’éditeur de pages pour plus d’informations sur comment ajouter et supprimer des blocs d’une page.









          

      

      

    

  

    
      
          
            
  
3. Contenu



	3.1. Profil
	3.1.1. À propos de moi

	3.1.2. Contact information, Messaging, General





	3.2. Profile Pictures
	3.2.1. Déposer des images dans votre profil

	3.2.2. Avatars distants





	3.3. Fichiers
	3.3.1. Téléverser un fichier

	3.3.2. Téléverser plusieurs fichiers

	3.3.3. Créer un dossier

	3.3.4. Supprimer un dossier ou un fichier

	3.3.5. Quota d’espace disque





	3.4. Journal
	3.4.1. Modifier les préférences du journal

	3.4.2. Ajouter un article

	3.4.3. Ajoutez des annexes à votre article de journal

	3.4.4. Ajouter une image à un article de journal
	3.4.4.1. Lier une image en ligne

	3.4.4.2. Ajouter une image depuis Mahara









	3.5. Curriculum vitae
	3.5.1. Introduction
	3.5.1.1. Ecrire votre lettre motivation

	3.5.1.2. Indiquer les informations personnelles





	3.5.2. Education & Employment

	3.5.3. Résultats

	3.5.4. Objectifs

	3.5.5. Compétences

	3.5.6. Centres d’intérêt





	3.6. Projets
	3.6.1. Créer un nouveau projet

	3.6.2. Ajouter des tâches à un projet

	3.6.3. Editer des tâches d’un projet









L’onglet Contenu contient tous les types de productions, ou artefacts, que vous pouvez créer ou téléverser et utiliser dans votre portfolio. Toutes les informations que vous créez sont initialement accessibles par vous seul, à part :


	votre nom d’affichage, ou si vous n’en avez pas, votre vrai nom


	la photo de votre profil




Both these are visible in the Online Users side bar if that is activated. Your display name, but not your profile picture, is also visible on your profile page per default.

C’est au moment où vous mettez vos productions dans des pages de votre portfolio ou que vous les partagez avec d’autres utilisateurs dans des groupes, que celles-ci deviennent accessibles à d’autres.





          

      

      

    

  

    
      
          
            
  
3.1. Profil

Your profile page is visible to other users on Mahara by default. If the site administrator allowed it, you can also make it visible to anybody on the Internet.

Par défaut, seules les informations suivantes sont affichées sur votre page de profil :


	Votre nom d’affichage (ou votre vrai nom si vous n’avez pas de nom d’affichage)


	Vos pages qui sont accessibles à toutes les personnes pouvant accéder à votre page de profil


	Vos groupes


	Votre mur


	Vos amis




Nous vous conseillons de ne pas vous servir de votre page de profil comme d’un portfolio, car vous n’avez pas le contrôle sur l’information que vous placez dans la page de votre profil. A minima, tous les utilisateurs de votre plateforme Mahara ont accès à votre profil; au plus, il peut s’agir de n’importe qui ayant un accès Internet. Rappelez-vous de toujours considérer votre sécurité personnelle lorsque vous divulguez de l’information vous concernant sur une page publique ou ouverte à d’autres utilisateurs de votre plateforme Mahara.

Use regular pages to create your portfolio and your profile to make these pages accessible to other people and to establish your digital identity.

Your Profile area (Content -> Profile) stores your contact and personal information. Each of the profile fields can be considered separate artefacts which may be added independently to your profile page or any portfolio page. Thus, you can reveal as little or as much information about yourself to others as you wish.


Voir aussi

You can edit your profile page like any other page in Mahara. You can find more information about editing a page in the page editor.




3.1.1. À propos de moi

You must provide a first and last name. All other information is optional. You name is visible to other Mahara users. You may choose to have a Display Name. You can change the information here at any time unless an administrator locked certain fields.


	First Name: Your real given name


	Last Name: You real last name


	Identifiant étudiant : À remplir si utilisé par votre institution


	Display Name: The name by which you want to be known around Mahara. If you have a display name, your real name will not be visible to regular Mahara users. Only administrators can see your real name and your username at all times.


	Introduction : Vous pouvez écrire un texte vous présentant. Ce texte est placé automatiquement sur votre page de profil, à moins que vous réécriviez ce texte directement cette dernière.







3.1.2. Contact information, Messaging, General

Vous pouvez renseignez toutes ou certaines de ces informations que vous pourrez ensuite placer sur une page. Toutes les informations que vous donnez ici seront visibles aux autres utilisateurs seulement lorsque vous les aurez placées sur une page. En attendant, vous seul avez accès à celle-ci.

L’adresse de messagerie électronique avec laquelle vous vous êtes enregistré sur Mahara est affichée par défaut. Vous pouvez ajouter à votre profil vos autres adresses de messagerie électronique, afin de les utiliser plus tard dans votre portfolio.


Note

Quand vous ajouter une nouvelle adresse de messagerie électronique, assurez-vous que vous ne cliquez pas simplement sur le bouton Ajouter en face de la rubrique dans laquelle vous venez d’entrer l’adresse, mais aussi sur le bouton Enregistrer le profil au bas de l’écran. Une fois une nouvelle adresse de messagerie électronique ajoutée, celle-ci doit être contrôlée. Vous allez donc recevoir un courriel et vous devrez suivre les instructions qu’il contient, afin que l’adresse soit définitivement ajoutée à votre compte utilisateur de Mahara.



If you use instant messaging services, you may wish to provide the details on those so that you can use them in your portfolio later easily.







          

      

      

    

  

    
      
          
            
  
3.2. Profile Pictures

Votre image du profil peut être soit une photo de vous-même ou une image d’un avatar de votre choix.


3.2.1. Déposer des images dans votre profil

You can upload up to 5 profile pictures into Content -> Profile Pictures. Alternatively, you can use a Gravatar [http://gravatar.com] if you have one and if the site administrator allows its use.

The pictures you wish to use must be between 16x16 and 1024x1024 pixels in size. Ideally, your profile pictures are square. Please use an image editing software before you upload your pictures to Mahara to reduce a photo’s dimensions to the required ones.


Note

The recommended size of your profile pictures is 100x100 pixels. Then the picture looks good on your profile when you want to include it there and also in the smaller sizes around Mahara.



L’image pour votre profil que vous désirez téléverser dans Mahara doit être présente sur votre ordinateur personnel. Choisissez de téléverser une image à la fois. Vous pouvez aussi lui donner un titre.


	Cliquez sur le bouton Naviguer pour choisir votre image depuis votre ordinateur.


	Cliquez sur Ouvrir.


	Optionnel :   Donnez un titre à votre image.


	Cliquez sur Déposer.


	Your picture appears in the list of profile pictures and you can now choose it as default picture.





[image: Profile pictures]
Liste de vos images du profil




Note

Profile pictures can be used in an portfolio page, but they are not listed in the Files area.



Lorsque vous avez plus d’une image pour votre profil, vous pouvez décider laquelle devient l’image par défaut. Elle sera alors affichée dans Mahara et dans les résultats de la recherche du bloc des Utilisateurs en ligne.

You can delete any of your profile pitures at any time. If you have 5 pictures uploaded and want to upload another one, you have to remove one of the first 5.


Note

Veuillez avant tout vous assurer que vous avez les droits d’utilisation des images avant de les utiliser dans votre portfolio.






3.2.2. Avatars distants

Si l’administrateur du site a activé l’option d”Afficher les avatars distants, comme Gravatar [http://gravatar.com], et que vous avez êtes déjà enregistré sur un tel service, votre image de profil par défaut sera celle que vous avez placée sur votre compte distant; à moins que vous décidiez d’utiliser une autre image que vous auriez téléversée dans votre espace de fichiers de votre profil.







          

      

      

    

  

    
      
          
            
  
3.3. Fichiers

The Files area is a repository, i.e. a document storage for folders and files that you can  use within your portfolio. Both folders and files are considered artefacts and as such can be added to a page. You may create any number of folders or sub folders. To view which sub folders and files sit within a folder, click on the folder name. Use the Home link to return to the top level folder directory.

You can arrange files and folders by dragging and dropping the icon in front of the file / folder name onto another folder icon. A suitably named and organised filing structure will help you with the long term organisation and retrieval of your artefacts. If you want to move a file or folder out of a sub folder, move it onto the icon of parent folder.

Vous pouvez observer que des dossiers ont été automatiquement créés par le système, comme fichierscopies. Ce dossier contient les fichiers contenus dans les pages que vous auriez importés dans votre portfolio. Comme avec les autres fichiers, vous pouvez déplacer ces fichiers dans un dossier différent, si vous le souhaitez.


Note

Le fait de déplacer des fichiers ou des dossiers dans votre zone de fichiers ne change rien à l’organisation que vous avez faite sur vos pages de votre portfolio. Vous n’avez pas besoin de recréer les liens dans vos pages sur vos fichiers après les avoir déplacés. De même que vous pouvez les renommer sans que cela n’ait d’impact sur le contenu de vos pages.




3.3.1. Téléverser un fichier

Avant de téléverser un fichier, assurez-vous que vous en avez le droit. Pour toutes les productions que vous publiez dans votre portfolio, vous devez détenir les droits nécessaires. Cela signifie notamment que :


	les productions sont des documents dont vous êtes l’auteur ou


	you are allowed to reproduce and distribute it -> it does not violate any copyright legislation and


	les productions sont en adéquation avec le contrat Termes et Conditions d’utilisation du site Mahara que vous utilisez.




It can be that you have to agree to an upload agreement before you can upload any files to your files area. The site administrator decides about that Site Administration -> Extensions -> Plugin Administration -> Plugin type: artefact: file.

Vous pouvez sélectionner un fichier depuis votre ordinateur en cliquant sur le bouton Choisir le fichier…. Assurez-vous que la taille du fichier à téléverser ne dépasse pas la taille maximale autorisée.

Quand le fichier a été transmis avec succès, il apparaît dans votre liste de fichiers. Vous pouvez alors modifier ses paramètres, en cliquant sur le bouton Modifier pour :


	modifier son nom (en conservant son extension)


	ajouter une description qui vous aidera à identifier le contenu du fichier


	ajouter des mots-clés qui vous permettent de retrouver votre contenu à travers votre portfolio


	autoriser les commentaires et les évaluations sur cette production





[image: Upload and edit a file]



	Téléverser un fichier


	Créer un dossier


	Edit a file (continue with Step 5)


	Delete the file


	Change the name of the file


	Give the file a description to find it again more easily


	Give the file one or more tags. You can choose from your existing tags if you wish. Separate your tags with commas.


	Decide if users should be allowed to comment directly on the file.


	Save the changes




You can also move your file to a folder by clicking on the icon before the file’s name and then dragging and dropping it onto a folder icon.




3.3.2. Téléverser plusieurs fichiers

You cannot upload multiple files by simply selecting them. That is a Mahara 1.5 functionality. However, you can place them all into a compressed file, a .zip file, and upload that to Mahara. Modern computers allow you to create a zip file from any number of files that you have selected in your document managemant program by making a right mouse click and selecting Compress… (or something similar).


[image: Zip files in MacOSX]
Créer une archive zip sur le Bureau de MacOSX




[image: Zip files in Ubuntu]
Créer une archive zip avec Nautilus d’Ubuntu




[image: Zip files in Windows]
Créer une archive zip dans Windows Explorer



Une fois téléversés, vous n’avez plus qu’à dézipper votre document. Cliquez sur le bouton Décompresser [image: unzip], à gauche du bouton Modifier [image: edit]. Suivez ensuite les instructions figurant sur l’écran suivant.




3.3.3. Créer un dossier

Nommez votre dossier en utilisant la rubrique prévue à cet effet puis cliquez sur le bouton Créer un dossier. Vous pouvez modifier les propriétés du dossier en cliquant sur le bouton Modifier [image: edit]. Alors, vous pouvez :


	modifier son nom


	ajouter une description qui permettra de retrouver le dossier plus facilement


	ajouter des mots-clés qui vous permettent de retrouver votre contenu à travers votre portfolio


	autoriser les commentaires (ce réglage peut être modifié au niveau de la production sur une page)







3.3.4. Supprimer un dossier ou un fichier

Vous pouvez supprimer un fichier ou un dossier avec son contenu, en cliquant sur le bouton Supprimer [image: delete] à la fin de la ligne du fichier ou du dossier.

Si vous avez utilisé un fichier comme pièce jointe dans un journal et/ou sur une page, une confirmation supplémentaire vous sera demandée, afin d’éviter de supprimer un dossier ou un fichier par accident.




3.3.5. Quota d’espace disque

L’administrateur de votre plateforme Mahara décide du quota d’espace disque à votre disposition pour stocker des fichiers. Cette valeur peut être différente dans chaque institution. Vous pouvez connaître l’état d’utilisation de votre quota dans la marge de droite de votre « zone de fichiers ».


[image: file quota]
Quota d’espace disque









          

      

      

    

  

    
      
          
            
  
3.4. Journal

Le journal est un outil qui permet de capturer, vos réflexions et vos expériences. En ajoutant l’ensemble d’un journal, ou des articles de celui-ci, à une page, vous pouvez rendre ces informations accessibles à d’autres utilisateurs. Ces derniers peuvent alors commenter et participer à vos travail réflexif.

Par défaut, chaque utilisateur ne possède qu’un seul journal


Astuce

If you wish to use more journals, e.g. to put your writing into categories so that you can make all posts from one category available in a page without having to select each journal entry, you can go to your Settings and select Enable multiple journals.




3.4.1. Modifier les préférences du journal

Vous pouvez modifier le titre de votre journal par défaut (ainsi que celui de tous les autres journaux si vous avez activé l’option de gestion des journaux multiples) et ajouter une description ainsi que des mots-clés.


	Cliquez sur le bouton Réglages de votre journal


	Modifiez le titre


	Ajoutez une description pour votre journal. Vous pouvez formater le texte comme vous le désirez.


	Add tags to your journal for easier searching later on. Tags that you have already used elsewhere are available to you under Show my tags.


	Cliquez sur Enregistrer les réglages







3.4.2. Ajouter un article

Chaque nouvel article de journal est initialement privé, jusqu’à ce que vous décidiez de le placer sur une page. De ce fait, la publication d’un journal/article de journal se fait en trois temps :


	Vous écrivez un article et vous l’enregistrez


	Dans une page, vous choisissez soit le bloc pour afficher l’entier d’un journal ou celui qui permet de placer un seul article d’un journal.


	Vous donnez les droits d’accès aux personnes que vous désirez.




When you are ready to post your journal entry:


	In your journal, click on New Entry.


	Provide a title for your journal entry.


	You must also write something in the Body. The visual editor helps you format your journal entry.


	Add tags to your entry to find it more easily later on. You can choose from tags that you have already used and / or enter new ones. Separate each tag with a comma. You may also choose tags from the ones that you have created previously.


	Add an attachment or more to your journal entry, e.g. pdf files associated with it or images. You can add files either from your files area or upload new ones directly onto your journal entry.


	Mark your entry as draft if you have not yet finished it. This is especially helpful if you have published your journal in a page, but do not want anybody to read this particular entry (yet). It is always visible to you, but not others.


	Allow comments if you want to receive them on the journal entry.


	Save your entry.







3.4.3. Ajoutez des annexes à votre article de journal


	Cliquez sur le bouton Ajouter un fichier puis Sélectionnez le(s) fichier(s) que vous désirez inclure, depuis votre Zone de fichiers.


	D’une autre manière, vous pouvez aussi Téléverser des nouveaux fichiers.


	Si vous avez placé en annexe un fichier que vous ne voulez plus, vous pouvez le Retirer des pièces jointes.


	Lorsque vous avez terminé, cliquez sur le bouton Fermer.





[image: Options on the file attachment screen]
Pièces jointes à un article de journal






3.4.4. Ajouter une image à un article de journal

Vous pouvez ajouter des images à un article de deux manières différentes :


	lier une image qui est accessible depuis un site web sur Internet


	utiliser une image déjà présente dans votre Mahara





3.4.4.1. Lier une image en ligne

Les images qui sont accessibles en ligne sont faciles à ajouter à un article de journal. Toutefois, veuillez vous assurer que vous possédez les droits d’utilisation pour tout document que vous voulez inclure à votre portfolio.


	Allez dans l’éditeur de texte et cliquez sur le bouton Insérer/éditer l’image [image: tinymce_image].


	Paste or type the image URL into the Image URL field. It must start with http:// or https://.


	Provide a brief description for your image.


	Select the alignment to the text for your image.


	Change the dimensions of your image if they are too large. If the image is recognised correctly, you have the image’s dimensions displayed.


	Add a border to your image if you wish to do so.


	Add more space around the image by adding a number in Vertical space and / or Horizontal space.


	Click the Insert button.





[image: Insert an image into a journal post]
Placer une image externe dans un article de journal




Note

Les dimensions sont exprimées en pixel. La première valeur correspond à la largeur et la deuxième à la hauteur. Modifiez une seule valeur et effacez la deuxième pour obtenir une nouvelle taille d’image en gardant intactes les proportions.



Si vous n’êtes pas satisfait avec la manière dont l’image est affichée dans votre message, sélectionnez-la (des poignées carrées apparaissent alors) et cliquez à nouveau sur le bouton Insérer/éditer l’image [image: tinymce_image] pour procéder à des ajustements.




3.4.4.2. Ajouter une image depuis Mahara


	Attach the image to your journal entry.


	Allez dans l’éditeur de texte et cliquez sur le bouton Insérer/éditer l’image [image: tinymce_image].


	Choose the image from the drop-down list Attached image.


	Provide a description for your image.


	Select the alignment to the text for your image.


	Change the dimensions of your image if they are too large. IF the image is recognised correctly, you have the image’s dimensions displayed.


	Add a border to your image if you wish to do so.


	Add more space around the image by adding a number in Vertical space and / or Horizontal space.


	Click on the Insert button.




Si vous désirez modifier l’alignement ou les dimensions de l’image dans votre article de journal, sélectionnez-la et cliquez à nouveau sur le bouton Insérer/éditer l’image [image: tinymce_image] pour éditer ces informations.









          

      

      

    

  

    
      
          
            
  
3.5. Curriculum vitae

The résumé plugin allows you to create an online résumé / curriculum vitae. You can either publish the entire résumé or individual components of it in your portfolio.


3.5.1. Introduction

In the introduction you can write a Cover Letter and also provide some Personal Information.


3.5.1.1. Ecrire votre lettre motivation

It is advisable that you write your cover letter in a word processor. That will allow you to spellcheck your writing. Alternatively, a site administrator could install the spellchecker for the editor.

Par contre, vous devez absolument faire la mise en page dans l’éditeur de texte de Mahara, afin d’éviter des modifications d’affichage entre Word et Mahara.

Click the Save button right below the editor window when you are happy with your cover letter to save it to Mahara for future use.


Note

Si vous avez écrit votre lettre dans Microsoft Word, veuillez utiliser le bouton « Coller depuis Word* [image: tinymce_word] pour enlever toutes les informations de mise en page venant de Word que l’éditeur ne peut pas interpréter correctement.






3.5.1.2. Indiquer les informations personnelles

None of the fields under Personal Information are required. You can choose to include as much or as little information as you wish. Most fields are free form fields.


Note

Comme Mahara est utilisé aux quatre coins de la planète, certaines informations du curriculum vitae, ici ou plus loin, peuvent ne pas s’appliquer à vous. Si vous n’avez pas besoin de ces rubriques, simplement ne les renseignez pas.




	Date of birth: Either choose your date of birth from the calendar or enter it in the format YYYY/MM/DD, e.g. 1978/01/30 when you want to say that you were born on 30 January 1978.


	Lieu de naissance : Entrez ici l’endroit où vous êtes né. Vous pouvez aussi entrer le pays en plus ou en lieu est place de l’endroit.


	Citoyenneté : Indiquez celle qui figure sur votre passeport.


	Type de visa : Comme les règles légales varient d’un pays à l’autre, vous avez la possibilité d’indiquer ci le type de visa (tourisme, permis de travail, permis d’établissement) que vous possédez et qui vous paraît important dans votre CV.


	Sexe : Choisissez celui qui s’applique à vous.


	État civil : Indiquez ici ce qui correspond à votre situation actuelle.




Click on Save when you want to keep that information.






3.5.2. Education & Employment

Cette partie de votre curriculum vitae vous permet de créer une liste de toutes vos activités académiques, de formation, ainsi que l’ensemble de votre expérience professionnelle.

La procédure pour créer une nouvelle entrée dans le parcours éducatif et dans le parcours professionnel est similaire. De ce fait, la procédure ne sera expliquée qu’une seule fois.


	Cliquez sur le bouton Ajouter pour créer une nouvelle entrée.


	Saisissez les rubriques marquées en rouge et possédant un *. Ces rubriques doivent être renseignées avec un minimum d’information.


	Remplissez les autres rubriques si elles ont du sens pour votre situation personnelle.


	Click the Save button right below the « Qualification Description » to save your entry.


	Cliquez sur le bouton Ajouter pour ajouter d’autres items.





Note

Vous pouvez entrer les dates comme vous le désirez. Cette rubrique n’est pas un calendrier avec un format de date particulier, car ce format varie d’un type de CV à un autre.




[image: Education History table]
Interpreting the Education History table




	Utilisez les flèches vers le haut et vers le bas [image: move_up] [image: move_down] pour modifier l’ordre de chaque item dans la liste.


	La date de début est affichée comme vous l’avez entrée.


	La date de fin est affichée comme vous l’avez entrée.


	Your qualification along with the institution is shown.


	Utilisez les boutons Modifier [image: edit] et Supprimer [image: delete] pour modifier, respectivement supprimer, chaque item.





Note

Il est important de ne pas oublier d’enregistrer en cliquant sur le bouton Enregistrer au bas du formulaire après chaque entrée.



Les items sont listés sous forme de listes. Modifier le contenu de chaque ligne en cliquant sur le bouton Modifier [image: edit]. Quand vous avez terminé, enregistrez vos modifications et retournez à cette page. En cliquant sur le bouton Supprimer [image: delete], vous supprimez le contenu de la ligne.

Si vous avez entré une description au sujet de votre qualification, cliquez sur le nom de la qualification pour afficher ou cacher cette information.




3.5.3. Résultats

Dans l’onglet Résultats vous allez collectionner les informations sur :


	les certificats, les autorisations d’exercer, les prix académiques (par ex. : Certificat de capacité en mécanique, Avocat enregistré au barreau de Casablanca, César du meilleur acteur, …)


	les livres et les articles publiés


	appartenance à des associations professionnelles (par ex : l’European Institute for E-Learning ou l’Association Romande des Médiamaticiens).




The process of adding, editing and moving entries is similar to the process for Education & Employment.


	Cliquez sur le bouton Ajouter pour créer une nouvelle entrée.


	Saisissez les rubriques marquées en rouge et possédant un *. Ces rubriques doivent être renseignées avec un minimum d’information.


	Remplissez les autres rubriques si elles ont du sens pour votre situation personnelle.


	Cliquez sur le bouton Enregistrer sous la rubrique « Description » pour valider votre saisie.


	Cliquez sur le bouton Ajouter pour ajouter d’autres items.


	Utilisez les flèches vers le haut et vers le bas [image: move_up] [image: move_down] pour modifier l’ordre de chaque item dans la liste.


	Cliquez sur le bouton Supprimer [image: delete] pour supprimer une ligne de la liste.





[image: Achievements table]
Achievements provided in the Résumé




Note

Click the title of your certification, accredidation, award, book or professional membership to see its full description.






3.5.4. Objectifs

Les Objectifs sont divisés en trois sections :


	les objectifs personnels


	les objectifs académiques


	les objectifs professionnels




Goals added here may be included in your portfolio pages.

Personal or career goals are often provided in résumés so that employers can understand how a particular role might suit your ambitions.

You can also use the academic goals section to describe achievements you are seeking in your programme of study.

Write your goal description into the appropriate box and click on the Save button once you are done editing. You can come back at any time and edit your goals.


[image: Goals section]
Ecrire les objectifs à atteindre que vous aimeriez afficher dans le portfolio






3.5.5. Compétences

Les Compétences sont divisées en trois sections :


	compétences personnelles


	compétences académiques


	compétences professionnelles




Skills added here may be included in your portfolio pages.

Employers are always interested in what skills you can bring to a role. You can also use this section to display the attributes that you would bring to a collaborative community or working group.

Write your skills descriptions into the appropriate box and click on the Save button once you are done editing. You can come back at any time and edit your goals.


[image: Skills section]
Example of work skills






3.5.6. Centres d’intérêt

The Interests section allows you to list your personal and / or professional interests. This might include your hobbies, sporting activities, volunteer work, areas of research and expertise etc. Listing your Interests will help employers form a better picture of who you are and what you would bring to their organisation.

Write your interests into the editor window and click on the Save button once you are done editing. You can come back at any time and edit your interests.


[image: Interests section]
Exemple d’intérêts personnels à donner dans un CV









          

      

      

    

  

    
      
          
            
  
3.6. Projets

Les projets sont en fait de simples listes de tâches à faire. Cet outil est particulièrement bien adapté pour structurer des objectifs à moyen et long terme. Un projet est formé d’un ensemble de tâches individuelles pour lesquelles une date d’achèvement est ajoutée.


3.6.1. Créer un nouveau projet


	Go to Content -> Plans.


	Cliquez sur le bouton Nouveau projet.


	Give your plan a title.


	Give your plan a description. It is visible when you select a plan for inclusion into a portfolio page.


	Click Save plan.




Désormais, vous pouvez ajouter des tâches à votre projet




3.6.2. Ajouter des tâches à un projet

Il existe plusieurs méthodes pour ajouter des tâches à un plan.


	Cliquez sur le bouton Nouvelle tâche pour ajouter des tâches à un projet


	Click on Content -> Plans -> the title of the plan -> New task.


	Click on Content -> Plans -> the Manage tasks button [image: manage] -> New task.




Once you are in the New task screen, you can create your new task:


	Enter a title for your task.


	Provide a completion date. This is compulsory and allows for tasks to be marked overdue.


	You can provide more detailed information about the task in the Description field.


	If you have already completed the task, you can tick the checkbox.


	Click Save task.


	Add more tasks or come back to them later.





[image: A plan with several tasks]
Projets dans l’onglet Contenu




[image: Plan on a portfolio page]
That’s what a plan looks like in a portfolio page. Clicking on the title of the task shows / hides the task description.






3.6.3. Editer des tâches d’un projet


	Click on Content -> Plans -> the Manage tasks button [image: manage] or the title of the plan.


	Cliquez sur le bouton Modifier [image: edit] à côté de la tâche que vous désirez modifier.


	Effectuez les modifications désirées ou marquez cette tâche comme terminée.


	Cliquez sur Enregistrer tâche pour valider vos modifications.










          

      

      

    

  

    
      
          
            
  
4. Portfolio



	4.1. Pages
	4.1.1. Tableau de bord

	4.1.2. Créer une nouvelle page

	4.1.3. Edit a page

	4.1.4. Afficher une page

	4.1.5. Donner accès à votre page à d’autres utilisateurs





	4.2. Editeur de page
	4.2.1. Éditeur de navigation
	4.2.1.1. Modifier titre et description

	4.2.1.2. Modifier présentation





	4.2.2. Sélecteur de productions

	4.2.3. Zone de mise en page

	4.2.4. Choix du thème optionnel





	4.3. Collections
	4.3.1. Ajouter une collection

	4.3.2. Edit collection pages

	4.3.3. Gérer les pages d’une collection

	4.3.4. Gérer vos collections

	4.3.5. Donner aux autres utilisateurs l’accès à vos collections.





	4.4. Partager
	4.4.1. Modifier l’accès pour les utilisateurs enregistrés

	4.4.2. Restreindre l’accès dans le temps

	4.4.3. Choisissez d’autres options supplémentaires

	4.4.4. Modifier l’accès pour des utilisateurs sans compte





	4.5. Exporter

	4.6. Commentaires

	4.7. Commenter pour évaluer
	4.7.1. Soummettre une page à l’évaluation

	4.7.2. Commentaires des évaluateurs





	4.8. Mots-clés
	4.8.1. Nuage de mots-clés

	4.8.2. Mes mots-clés

	4.8.3. Modifier les mots-clés









Le « Portfolio » est un emplacement dans Mahara où vous pouvez assembler sur des pages les productions que vous avez collectées dans « Contenu ». Vous pouvez alors partager vos pages avec d’autres utilisateurs ou simplement les conserver pour votre propre usage.

Dans cette section vous apprendrez à :


	créer des pages de portfolio


	créer des collections de pages de portfolio


	partager vos pages et/ou vos collections


	exporter votre portfolio


	donner des commentaires sur les pages et les productions


	afficher votre nuage de mots-clés et modifier les mots-clés








          

      

      

    

  

    
      
          
            
  
4.1. Pages

Une page contient une sélection de productions que vous pouvez arranger et présenter aux autres utilisateurs. Cela comprend :


	une sélection de fichiers


	des informations de votre CV


	du texte (commentaires, instructions, consignes)


	les articles de journaux


	des vidéos et des fichiers audio


	des flux RSS provenant de blogues externes


	etc.




Vous pouvez réutiliser les mêmes productions que vous avez collectionnées dans Contenu, dans autant de pages que vous le souhaitez.


[image: Content in multiple pages]
La même production peut apparaître sur plusieurs pages




4.1.1. Tableau de bord

On the landing page of the portfolio, you can do the following:


	Créer un nouvelle page.


	Copier une page de votre portfolio ou de celui d’un autre utilisateur.


	Effectuer des recherches dans votre portfolio


	Modifier votre page d’acceuil.


	Modifier la page de votre profil


	Modifier ou supprimer les pages de votre portfolio





[image: Overview pages of "Portfolio"]
La page d’accueil de votre portfolio






4.1.2. Créer une nouvelle page

Vous créez une nouvelle page dans votre portfolio lorsque vous désirez afficher des productions, par exemple : pour les présenter à d’autres utilisateurs, ou faire montre de vos progrès dans la réalisation d’un projet, etc.


	On the Pages page, click the Create Page button. You are taken to the page editor.


	Decide what type of artefact you wish to display in your page.


	Choose the desired artefact block and drag it into the content editor area.


	Follow the on-screen instructions for selecting the content you wish to display and click the Save button.


	Choose further artefact blocks and configure them.


	Cick on the tab Edit Title and Description to give your page a title, description, and tags.


	Click the Save button to return to the page editor.


	Click the tab Edit Layout to change the layout for your page from the standard 3 columns to 2 columns or another choice.


	Click the Save button to return to the editor.


	Click the Done button at the bottom of the page to finish editing this page. You are taken back to the overview page.





Voir aussi

See Editeur de page for detailed information on the individual elements of the editor.




[image: A finished portfolio page]
An example portfolio page. When you are the author, you can click on the Edit button and make changes.



The individual elements in the screenshot are the following:


	Title of the portfolio.


	Auteur de la page


	Description de la page


	Le bouton Modifier la page n’est visible que pour l’auteur de la page.


	Les productions qui ont été placées sur la page.


	La zone de commentaires en bas de la page affiche les commentaires des utilisateurs.


	Place feeback button can be used by yourself and others to leave comments on the page.


	If a page contains offensive artefacts, users can report that to the administrator.


	Le bouton Imprimer permet d’imprimer la page


	Le bouton Ajouter la page à la liste de suivi permet de vous tenir informé de toutes les modifications qui seront faites à cette page dans le futur.







4.1.3. Edit a page

Vous pouvez modifier une page existante de deux manières différentes :


	Cliquez sur le bouton Modifier contenu et présentation [image: edit] quand vous êtes dans la zone Pages de l’onglet Portfolio.


	Cliquez sur le bouton Modifier cette page quand la page en question est affichée à l’écran.





Avertissement

Text boxes and links to external content such as embedded external videos and RSS feeds to an external blog are completely deleted when you remove the respective blocks from your portfolio page. You cannot recover them. There is no revision history. All other artefacts are not deleted when you remove them from a page because they reside in your Content area.






4.1.4. Afficher une page

Vous pouvez afficher une page afin de contrôler son apparence quand une personne vient à y accéder. Allez dans la zone Pages de l’onglet Portfolio et cliquez sur le titre de la ge que vous désirez afficher.

At the bottom of any page (except the profile page) that you have access to you can perform a number of actions.


[image: Actions at the bottom of a page]
Actions at the bottom of a page




	Place feedback for the page or artefact author.


	Report objectionable content to the administrators, e.g. when content on the page does not comply with the terms and conditions of the page, is offensive etc.


	Print the page.


	Add the page to your watchlist and receive notifications when the content of the page changes.


	View the number of comments that have been left on the page.







4.1.5. Donner accès à votre page à d’autres utilisateurs


Voir aussi

Veuillez vous référer à la section partager vos pages et collection pour plus d’information.









          

      

      

    

  

    
      
          
            
  
4.2. Editeur de page

L”éditeur de page est un outil important dans Mahara car il permet de composer les pages de votre portfolio. Il est divisé en plusieurs parties :


	Éditeur de navigation


	Sélecteur de productions


	Zone de mise en page





4.2.1. Éditeur de navigation


[image: Page editor navigation]
Barre de navigation dans l’éditeur de pages




	Edit Content: Place your content on a page. See Sélecteur de productions, Blocs and Zone de mise en page.


	Edit Title and Description: Add and modify your page title, description and tags.


	Edit Layout: Change the overall layout of your page.


	Afficher la page : Permet de prévisualiser la page comme les autres utilisateurs pourront ultérieurement l’accéder.


	Share page: Decide who shall have access to your page. See Partager for more details.





4.2.1.1. Modifier titre et description

Vous devriez donner à chacune de vos pages un titre unique afin de les retrouver plus facilement plus tard. La description de son contenu vous aidera aussi déterminer ce qu’elle contient et pourquoi vous l’aviez créée. Des mots-clés pertinents vous permettront aussi de la retrouver à l’aide du moteur de recherche.


[image: Title and description screen]
Indiquez un maximum d’informations pour pouvoir distinguer les objets les uns des autres et pour que vous puissiez ensuite facilement les retrouver. Vous pouvez modifier ces informations en tout temps.




	Page Title: You must provide a title for your page. Automatically, every page is called « Untitled ».


	Page Description: You can write a brief description for your page, e.g. its purpose. this description is displayed on the overview page and on the portfolio page itself.


	Mots-clés : Si vous avez déjà utilisé des mots-clés dans des productions ou pour d’autres pages, vous pouvez en sélectionner directement de la liste des mots-clés existants. Cette fonctionnalité permet d’éviter des erreurs de saisie.


	If you either do not yet have tags or need to use a new ones, you can write them into the text box. Separate multiple tags by commas.


	Name display format: You must choose which name should be displayed when somebody else views your portfolio.


	Cliquez sur le bouton Enregistrer pour valider vos modifications.







4.2.1.2. Modifier présentation

Vous avez 10 choix de présentation en colonnes de votre page; de 1 colonne à 5 colonnes par page. Les formats en 2-3 et 4 colonnes permettent d’individualiser la taille de certaines colonnes en permettant des colonnes plus larges que les autres. Les icônes sur cette page vous assistent afin de vous permettre de prendre la bonne décision de présentation. Par contre il n’est pas possible de définir expressément la largeur d’une colonne.


Note

Faites attention si vous choisissez un format en 4 colonnes ou plus. Votre page pourrait s’afficher correctement sur votre moniteur de 21 », mais un utilisateur sur un ordinateur portable pourrait ne pas avoir la même expérience. Dans la plupart des cas, une présentation en 3 colonnes donne les meilleurs résultats.



Click the radio button above the layout that you wish to apply to your page. You can change it at any time. When you reduce the number of columns, your blocks simply move to the first column. You can then move them around to their correct position (see Zone de mise en page).


[image: Overall page layout editor]
Edit the overall layout of a page by choosing the number of columns




Note

Vous pouvez ajouter ou supprimer des colonnes directement dans la page, si vous avez activé l’option Afficher des boutons d’ajout/suppression de colonnes lors de la modification des pages dans la page Préférences du compte.




[image: Add and remove buttons in the page layout area]
Vous pouvez utiliser les boutons Ajouter et Supprimer pour effectuer rapidement des modifications de présentation, pour autant que vous les ayez activés dans vos préférences.








4.2.2. Sélecteur de productions

Les différents types de productions ainsi que les blocs qui extraient et intègrent des contenus externes dans les pages, sont accessibles par le Sélecteur de productions.


[image: Artefact chooser]
All artefacts are accessible via a number of tabs in the page editor




	Contenu externe : contient des blocs pour placer sur la page des flux RSS, le contenu de média externes ou des documents de GoogleDocs, etc.


	Files, images and video: holds blocks for Mahara files that can be displayed as links, in folders, or in the case of images and videos directly in the page


	Général : blocs permettant de placer du contenu général


	Journaux : différents blocs pour placer un journal/des articles de journaux sur la page


	Profil : choisissez les informations de votre profil à afficher dans un bloc


	Résumé: display your entire résumé or only parts of it





Voir aussi

The functionality of each block that you can use in your portfolio pages and in group pages, is outlined in the section on the individual artefact blocks.






4.2.3. Zone de mise en page

La zone Modifier le contenu vous permet de placer et déplacer vos productions sur votre page. Vous devez connaître les points suivants sur cette zone :


	Toutes les productions sont placées sur la page en glissant-déposant les blocs dans cette zone.


	Les productions sont arrangées en une succession de blocs dans chacune des colonnes.


	Il n’y a pas de ligne seulement des colonnes. Les blocs sont placés les uns en dessous des autres au sein d’une même colonne, mais il ne sont pas aligné par rapport aux autres blocs des autres colonnes; a moins que chacun des blocs vis à vis aient la même hauteur.


	Vous pouvez déplacer les blocs en cliquant sur leur en-tête.


	Vous pouvez modifier les préférences d’un bloc en cliquant sur le bouton Configurer ce bloc [image: manage].





[image: Drag a block into the page layout area]
Drag and block into the page layout area and configure its settings




	Cliquez sur le bloc du type de production que vous désirez placer sur votre page et glissez-le dans la zone de construction.


	Une zone traitillée apparaît vous montrant où le bloc va être placé. Lâchez-le à l’endroit que vous désirez.


	Follow the on-screen instructions on choosing the specific artefact you wish to display. Please refer to the artefact block for more information on each block’s settings.





Voir aussi

Please refer to the section edit layout to learn how to change the number of columns on a page and make certain columns wider than others.






4.2.4. Choix du thème optionnel

You may be able to choose a theme for your portfolio page. If that is the case, you see a Theme drop-down menu below the artefact chooser. That allows you to select a theme in which that page is displayed to others who view your portfolio page.


[image: Select a theme for your page]
Select a theme for your page




Voir aussi

L’administrateur du site doit avoir autorisé l’usage des thèmes pour les pages du portfolio dans les  réglages de l’utilisateur.









          

      

      

    

  

    
      
          
            
  
4.3. Collections

A collection is a set of pages that are linked to one another and have the same access permissions. You can create as many collections as you like, but a page cannot appear in more than one collection.


4.3.1. Ajouter une collection

You add a collection under Portfolio -> Collections.


[image: Create a collection]
Créer un collection




	Click the New Collection button.


	On the next screen, provide a title for your collection.


	Optionally, you can also write a short description about your collection. You do not have a visual editor, but just a plain text box.


	Choose whether you wish to display a tabbed navigation or not. If you choose not to, you will have to include the navigation block so that you can go from one page to the next.


	Click the Next: Edit Collection pages button.







4.3.2. Edit collection pages

Dans l’étape suivante, après avoir créé votre collection, vous choisissez les pages du portfolio que vous souhaitez inclure dans la collection. Sont affichées toutes les pages que vous pouvez potentiellement inclure. Si vous avez déjà placé une page dans une autre collection, celle-ci n’apparaît plus dans la liste.


[image: Edit collection pages]
Ajouter une page à une collection




	Cochez chaque page que vous souhaitez ajouter à votre collection.


	Cliquez sur le bouton Ajouter pages pour ajouter les pages à votre collection.


	Cliquez sur le bouton Terminé pour finir cette étape.







4.3.3. Gérer les pages d’une collection

Après avoir ajouté des pages à votre collection, vous pouvez les déplacer ou les retirer.


[image: Manage collection pages]
Gérer les pages qui sont affichées dans votre collection




	Utilisez les flèches Déplacer vers le haut*|move_up| et *Déplacer vers le bas [image: move_down] pour réarranger vos pages dans un ordre différent.


	Cliquez sur le bouton Retirer pour retirer une page de la collection. La page elle-même n’est pas supprimée.


	Cliquez sur le bouton *Enregistrer ».




Vous pouvez ajouter d’autres pages à une collection depuis la boîte Ajouter des pages à la collection.


[image: The finished result]
Une collection avec un menu de navigation par onglets






4.3.4. Gérer vos collections

On the overview page of the collections, you can:


	Create a new collection by clicking on the New Collection button.


	Click on the collection title to go to the first page of a collection.


	Cliquer sur un titre de page dans une collection pour y accéder directement.


	Cliquer sur le bouton Gérer [image: manage] pour déplacer, ajouter ou supprimer des pages dans une collection.


	Cliquer sur le bouton Éditer [image: edit] pour modifier le titre et la description d’une collection.


	click on the Delete button [image: delete] to delete the collection. The pages will still exist.





[image: Overview page for collections]
Aperçu des collections






4.3.5. Donner aux autres utilisateurs l’accès à vos collections.


Voir aussi

Veuillez vous référer à la section partager vos pages et collection pour plus d’information.









          

      

      

    

  

    
      
          
            
  
4.4. Partager

When you have created portfolio pages (and collections), you may wish to share them with others, e.g. to receive feedback. You can set the access permissions on the Edit access page. It is accessible via Portfolio -> Share or directly from the page editor when you edit a portfolio page.

La page Partager vous donne les informations suivantes:


	Your collections and pages sorted alphabetically.


	La liste des utilisateurs et / ou des groupes qui ont accès à une collection ou à une page en particulier


	The Edit Access button [image: edit_access] which allows you to change the permission of who can view a page or collection.


	Le bouton Modifier l’accès par URLs secrètes [image: edit] vous permet de créer et gérer plus d’une URLs secrètes pour une page ou une collection. Le nombre d’URLs que vous avez créées est affiché à côté du bouton.





[image: Share overview page]
Aperçu des accès aux pages




4.4.1. Modifier l’accès pour les utilisateurs enregistrés

The Edit Access page allows you to set the permissions for a single user or multiple users for if and when they should be able to view your portfolio pages or collections.

You can assign access to a single page or collection at a time or to multiple pages and / or collection at once.


[image: Edit access permissions]
Les utilisateurs et les groupes auxquels vous pouvez donner l’accès à vos pages et/ou collections



You have a number of choices of selecting who shall be able to see what:


	Choose the collection or collections for which you want to give access. If you made a mistake in your selection, either take the checkmark off or select All or None to check or clear all respectively.


	Choose the page or pages for which you want to give access. If you made a mistake in your selection, either take the checkmark off or select All or None to check or clear all respectively.


	Public : toute personne connaissant la ou les URLs peut accéder aux pages / collection.


	Utilisateurs connectés : tous les utilisateurs qui possèdent un compte sur la plateforme que vous utilisez peuvent afficher le contenu de votre sélection de pages / collections.


	Amis : tous vos amis sur Mahara peuvent accéder à la sélection de pages / collections.


	Tous mes groupes : tous les membres de chacun des groupes auxquels vous appartenez pourront accéder les pages / collections que vous avez sélectionnées.


	Un groupe particulier : tous les membres de ce groupe pourront accéder aux pages / collections que vous avez sélectionnées.


	If none of the above choices are what you are looking for, you can search for specific users or groups. Make your selection.


	Saisissez le nom d’un utilisateur ou d’un groupe que vous recherchez. Un nom partiel donne souvent les meilleurs résultats et est plus rapide.


	Add the user or group. You can click on the name of the user or group to verify that it is the correct one.





Note

Your friends or individual users with whom you shared your pages / collections receive a notification. Group members also receive a notification that you shared a page with them if the group administrator allowed that. You do not receive a notification when a user shared his page with the public or al logged-in users.






4.4.2. Restreindre l’accès dans le temps

En plus de pouvoir restreindre l’accès à un certain nombre de personnes, vous pouvez aussi restreindre l’accès à vos pages / collection en instaurant une limite temporelle.


[image: Restrict access time]
Restreindre l’accès à vos pages / collections




	Each user or group of people can receive their own time restrictions that are independent of other access groups. You can specify a start date.


	You can also specify an end date.


	You can click the Remove button [image: remove] to completely take a user group off your access list.







4.4.3. Choisissez d’autres options supplémentaires

Vous pouvez de plus choisir un nombre d’options supplémentaires qui peuvent être attribuées à toutes les pages / collections que vous avez sélectionnées.


[image: Advanced access options]
Options avancées dans le paramétrage de l’accès aux pages / collections




	Autoriser les commentaires : Cette option est sélectionnée par défaut pour vous encourager et encourager les autres utilisateurs de placer des commentaires sur les pages.


	Modérer les commentaires : si vous désirez lire les commentaires avant de les rendre publics (et donc visibles aux autres utilisateurs qui ont accès à la page sur laquelle a été placé le commentaire), cliquez sur cette boîte à cocher.


	Permettre la copie : Sélectionnez cette option si vous désirez que les autres utilisateurs qui ont accès votre page puisse en faire une copie pour eux-mêmes. Chaque boîte de texte, chaque dossier, chaque fichier qu’elle contient seront transférés dans leur portfolio. Pour le contenu des journaux vous pouvez décider s’il sera copié aussi ou non. Les information du profil, les projets et les informations du CV ne sont pas copiées.


	Overriding Start / stop dates: Here you set the time frame for when all users who have access to your page / collection can view your page. The dates here override any individual dates you may have set.




Si vous n’avez pas donné de droit de copie, vous pouvez tout de même activer les commentaires pour certaines personnes ou des groupes de personnes depuis vos listes d’accès. De cette manière vous pouvez contrôler précisément qui a le droit de placer des commentaires sur vos pages / collections, et qui ne peut pas.


[image: Comments per user]
Permettre les commentaires au cas par cas




Note

Si vous modifiez une page d’une institution, vous verrez alors un autre option lorsque vous désirez autoriser la copie d’une telle page. Avec cette option, vous pouvez placer directement cette page dans le portfolio d’un nouvel utilisateur. Les utilisateurs existant doivent quant à eux continuer à utiliser le bouton de copie pour en faire une pour eux.






4.4.4. Modifier l’accès pour des utilisateurs sans compte

En marge des possibilités de donner accès à vos pages à des utilisateurs ou des groupes d’utilisateurs particuliers, vous pouvez aussi donner accès à une personne qui n’a pas de compte sur la plateforme que vous utilisez. Cette option permet de ne pas rendre la page / collection publique, mais de donner un lien qui permettra à une personne externe au système d’afficher vos pages sans connexion préalable et en évitant qu’elles soient référencées par un moteur de recherche. Ceci peut être par exemple intéressant dans les cas suivants :


	vous désirez créer un portfolio pour répondre à une offre d’emploi et voulez donner accès à celui-ci à votre futur employeur seulement, sans qu’il ait à créer un compte sur la plateforme.


	vous désirez partager votre portfolio avec vos parents afin d’obtenir des commentaires de leurs part.


	quand un expert ou un tuteur externe doit évaluer votre travail.




Vous pouvez créer une URL secrète de la manière suivante, lorsque vous êtes dans la page Partager et que vous cliquez sur le bouton Modifier l’accès par URL secrète [image: edit].


	Click the Add button to generate a new secret URL.


	You can now copy this URL and put it into an email to send to somebody.


	You can click on the Edit button [image: edit] to add a time restriction for access to your page / portfolio via this URL and then click the Save button.


	Click on the Delete button [image: remove] if you do not want to use this secret URL anymore.


	Click on the Add button to generate another secret URL for this page to which you can assign different time restrictions.





[image: Add a secret URL]
Ajouter une ou plusieures URL secrètes à une page ou à une collection




Note

Logged-out users or those who do not have an account can only leave comments on public pages or pages which they can access via a secret URL if the site administrator turned on the Anonymous Comments function under Site Administration -> Configure Site -> User Settings.









          

      

      

    

  

    
      
          
            
  
4.5. Exporter

You can export your portfolio to keep your files and Mahara-created content offline. You have two options for the export. Both are downloaded as zip file which you can then uncompress in the case of the HTML web site:


	HTML web site: A self-contained web site with your portfolio data is created. You cannot import this into Mahara or another portfolio system again, but it is readable in a standard web browser and you do not need a Mahara in order to view it.


	Leap2A : Crée un fichier zip contenant un dossier structuré selon les spécifications du format standard Leap2A [http://wiki.leapspecs.org/2A/specification]. Vous pouvez importe ce fichier dans un autre système de gestion de portfolios qui supporte le format Leap2A [https://wiki.mahara.org/index.php/Developer_Area/Import//Export/Interoperability], ou demander à votre administrateur Mahara de l’importer au moment de la création d’un nouveau compte.





Note

Il est recommandé d’effectuer des exportations dans les deux formats (HTML et Leap2A) car on ne sait jamais réellement par avance si l’on va vouloir importer à nouveau ses données dans un autre système de gestion de portfolios.



To export your portfolio:


	Go to Portfolio -> Export.


	Choose either Standalone HTML Website or Leap2A. You can run through the export twice in order to get both formats.


	Sélectionnez ce que vous désirez exporter :


	All my data: Everything that is stored in your account in Content and Portfolio. Excluded are any group contributions.


	Just some of my pages: You can then choose which pages and the artefacts that go with it you want to export.


	Just some of my collections: You can select which collections and their artefacts you want to export.






	If you have chosen to just export some pages or collections, you can select them here. You may also preview a page first.


	Cliquez sur le bouton Génération du fichier d’exportation pour lancer le processus d’exportation.





[image: ../_images/export_options.png]


En fonction de la taille de votre portfolio, le processus de génération de l’exportation peut prendre plus ou moins de temps. Quand tout est terminé, un fichier sera téléchargé automatiquement sur votre ordinateur. La manière dont cette étape se passe dépend de la configuration de votre navigateur web.


Note

If your export gets stuck in the process and the progress bar does not move along at all, your server settings may prevent long operations to avoid slowing down. You will need to contact your site administrator, e.g. via the « Contact Us » form in the footer of your Mahara instance.







          

      

      

    

  

    
      
          
            
  
4.6. Commentaires

Travailler avec les commentaires et évaluations des autres est un élément important dans la gestion d’un ePortfolio. Vous pouvez placer des commentaires non seulement sur des productions, mais aussi sur des pages entières du portfolio.

Le propriétaire d’un document ou d’une page du portfolio peut décider s’il autorise ou non de recevoir des commentaires/évaluations. Pour les documents, l’option d’activation des commentaires peut être activée au moment où le fichier est téléversé ou modifié; pour les pages l’option se trouve dans les options avancées.

Quand l’auteur d’une page l’autorise, pour pouvez placer des commentaires sur les productions et les pages auxquelles vous avez accès.


[image: Provide feedback]
Ajouter un commentaire




	Cliquez sur le lien Envoyer le commentaire en bas de la page du portfolio ou sur la page de détail d’une production pour laquelle vous désirez laisser un commentaire.


	Ecrivez votre commentaire dans la fenêtre de l’éditeur.


	Si l’administrateur du site a choisi   Activer l’évaluation par note, vous pouvez utiliser un système d’étoile (de 1 à 5) pour évaluer la production ou la page, en plus de vos commentaires écrit er / ou de l’envoi d’un fichier.


	Activez l’option Rendre public lorsque vous souhaitez que votre commentaire puisse être lu par toutes les personnes ayant accès à cette page. Si vous n’activez pas cette option, votre commentaire ne sera visible que pour vous et l’auteur de la page.


	Click the Browse button to attach a feedback file from your computer. This file is place into the files area of the author of the page.


	Cliquez sur le bouton Envoyer le commentaire pour placer votre évaluation ou votre commentaire sur la page.


	Cliquez sur le bouton Annuler pour annuler l’opération.


	Une fois votre commentaire envoyé, l’auteur de la page reçoit automatiquement une notification dans sa boîte de réception.





Note

Les auteurs des commentaires ne reçoivent, quant à eux, aucune notification sur le commentaire qu’ils ont fait.






4.7. Commenter pour évaluer


4.7.1. Soummettre une page à l’évaluation

Si vous êtes membre d’un groupe cours contrôlé, vous pouvez envoyer une page pour l’évaluation par le ou les tuteurs du groupe. Ceci a pour effet de bloquer votre page et de ne plus vous permettre d’en modifier la plupart du contenu.


[image: Submit a page to a course controlled group]
Submit a page to a course controlled group




	Allez sur la page d’accueil du groupe dans lequel vous voulez envoyer une page pour évaluation. Choisissez la page à envoyer depuis le menu déroulant sous Envoyer la page à ce groupe.


	Cliquez sur le bouton Envoyer pour envoyer et bloquer le contenu de la page.




Vous n’avez pas besoin de donner des droits d’accès à cette page, ceci est effectué de manière transparente par le système. Quand vous avez envoyé votre page, les tuteurs et les administrateurs du groupe peuvent commenter et évaluer votre page.

Durant cette phase d’évaluation, vous **ne pouvez plus* effectuer des modifications aux productions suivantes :


	les fichiers


	les articles de journaux


	le contenu des boîtes de texte


	les liens vers des contenus externes




Par contre vous pouvez toujours modifier :


	vos projets


	vos informations du profil


	les rubriques de votre CV







4.7.2. Commentaires des évaluateurs

Une fois qu’une page a été envoyée pour évaluation à un groupe de type cours contrôlé, vous pouvez y placer des commentaires sans que les autres utilisateurs puissent effectuer des modifications à la plupart des productions contenues sur la page. Une liste de toutes les pages en cours d’évaluation est affichée dans votre Tableau de bord, avec en face de chaque page, la date et l’heure de l’envoi.


[image: Submitted page with time stamp]
Submitted page with time stamp



Vous pouvez dès lors placez vos commentaires sur la page puis cliquer sur le bouton Libérer la page afin que son auteur puisse continuer de travailler avec cette dernière.







          

      

      

    

  

    
      
          
            
  
4.8. Mots-clés

Les mots-clés ou tags vous permettent de donner du sens et de décrire le contenu des productions et des pages dans votre portfolio, et aussi de les retrouver plus facilement.


Note

L’administrateur du site doit avoir activé le paramètre Activer le nuage de mots-clés pour que vous puissiez utiliser cette fonction.




4.8.1. Nuage de mots-clés

Vous pouvez voir votre nuage de mots-clés dans la colonne de droite de votre page lorsque vous êtes dans les zones Contenu et Portfolio de Mahara. Vous pouvez choisir le nombre de mots-clés que vous désirez afficher, en vous rendant sur la page des Préférences du compte.


[image: Tag cloud]
Nuage de mots-clés




	Cliquez sur le titre Mots-clés du bloc pour vous rendre dans la page Mes mots-clés.


	Cliquez sur un mot-clé pour afficher la liste de toutes les productions et pages de votre portfolio pour lesquelles vous avez attribué ce mot-clé.





Note

Plus vous utilisez un mot-clé pour vos fichiers, articles de journaux, et vos pages, plus celui sera affiché en grand dans votre nuage.






4.8.2. Mes mots-clés

Sur la page Mes mots-clés vous pouvez afficher tous les mots-clés que vous avez associés à vos productions et à vos pages. Un ensemble de filtres vous permettent de n’afficher que certaines catégories d’objets liés à ces mots-clés.


[image: My tags overview page]
Aperçu de mes mots-clés




	The default view is to sort your tags alphabetically. Capitalised tags are treated before non-capitalised tags.


	Vous pouvez trier les mots-clés sur d’autres critères, comme la fréquence afin d’afficher les mots-clés les plus utilisés.


	Vous pouvez cliquer sur chaque mot-clé pour limiter l’affichage aux productions et aux pages qui comprennent ceux-ci. Le nombre entre parenthèses correspond au nombre de fois que le mot-clé a été utilisé dans votre portfolio.


	Le terme filtré est répété


	Vous pouvez aussi trier le résultat par titre ou par date.


	Vous pouvez filtrer vos résultats par type de productions ou n’afficher que les pages de votre portfolio.


	Le titre de la ressource, sa description si disponible et les mots-clés associés sont affichés.


	La date et l’heure de création en plus du type de ressource sont affichés.


	Cliquez sur le bouton Modifier les mots-clés pour modifier le contenu de vos mots-clés.







4.8.3. Modifier les mots-clés

Vous pouvez modifier les mots-clés pour y corriger des erreurs typographiques ou les supprimer.


[image: Edit your tags]
Modifier mes mots-clés




	Sélectionnez le mot-clé que vous désirez modifier


	Après avoir sélectionné un mot-clé, son nom est sélectionné en gras dans la liste et deux nouveaux boutons apparaissent. Vous pouvez donner un nouveau nom à votre mot-clé en modifiant la rubrique Nom.


	Cliquez sur le bouton Envoyer pour enregistrer vos modifications.


	Alternativement, cliquez sur le bouton Supprimer pour supprimer ce mot-clé.


	Vous pouvez aussi cliquer sur le bouton Mes mots-clés pour retourner à la page d’aperçu de tous vos mots-clés associés aux ressources.










          

      

      

    

  

    
      
          
            
  
5. Groupes



	5.1. Mes groupes

	5.2. Trouver des groupes

	5.3. Créer un groupe
	5.3.1. Create a group as a user, staff or institution admin

	5.3.2. Créer un groupe en tant qu’administrateur du site

	5.3.3. Modifier les paramètres généraux du groupe





	5.4. À l’intérieur d’un groupe
	5.4.1. Page d’accueil du groupe

	5.4.2. Membres

	5.4.3. Forums
	5.4.3.1. Créer un nouveau forum

	5.4.3.2. Ajouter un sujet de discussion

	5.4.3.3. Répondre à un sujet de discussion ou à un message

	5.4.3.4. Effacer un message, un sujet de discussion ou un forum

	5.4.3.5. Actions en lot sur les forums





	5.4.4. Pages
	5.4.4.1. Page d’accueil du groupe

	5.4.4.2. Pages de groupe régulières





	5.4.5. Fichier





	5.5. Mes amis

	5.6. Rechercher des contacts
	5.6.1. Envoyer une demande de contact

	5.6.2. Accepter la demande de devenir l’ami d’un utilisateur

	5.6.3. Refuser la demande d’un utilisateur de venir dans sa liste d’amis





	5.7. Pages partagées

	5.8. Discussions





Groups in Mahara can be used for collaboration among users as they offer the possibilities to


	converser dans des forums


	créer et modifier des pages ensemble


	partager des fichiers


	partager des pages


	submit pages for assessment





Note

Groups can be created by every user, staff or administrators only. The site administrator decides that in Site Administration -> Configure Site -> Group Settings.



Le menu Groupes possède un grand nombre de sous-menus :


	My Groups: Displays the groups that you administer or in which you are a member. You can create new groups from here if you have the appropriate rights.


	Find Groups: Lists all groups in the system and allows you to join or request membership in them if groups allow that.


	My Friends: Displays your friends and gives you easy access to their profile pages.


	Find Friends: Search for users in Mahara that you may wish to add to your friends list.


	Shared Pages: Lists the pages that were shared with you directly, with you as a friend or member of a group.


	Discussions : Affiche les derniers messages des forums de votre groupe.








          

      

      

    

  

    
      
          
            
  
5.1. Mes groupes

Cette page liste l’ensemble des groupes dans lesquels vous avez de l’intérêt, en tant que propriétaire, membre, ou ceux desquels vous avez été invité ou avez demandé à rejoindre.

If your site administrator allowed you to create groups yourself, you see the Create Group button.


[image: My Groups overview page]
The My Groups page lists all your groups




	Choose the filter you wish to apply to view only a subset of your groups and then click the Filter button. You can filter for:


	Tous vos groupes


	Les groupes que vous avez créés


	Les groupes dont je suis membre


	Les groupes dans lesquels vous avez été invité


	Les groupes que vous désirez rejoindre






	Click the Create Group button when you want to set up a new group.


	If you are a member of a controlled membership group, you cannot leave the group. You can leave other groups that are not controlled at any time.


	Click the Accept or Decline button to join an invite group or to decline membership in that group.


	Click the Edit button when you want to update the details for your group. Click the Delete button only when you want to delete your group permanently.




In addition to the filter options above, you can filter for group categories if the site administrator allowed them and had them set up.


[image: Filter according to a group category]
Filter your search results according to a group category




Avertissement

When you delete a group, all its content and contributions from users are gone and cannot be retrieved again.







          

      

      

    

  

    
      
          
            
  
5.2. Trouver des groupes

You see all groups that exist on Mahara and get basic information about the groups.


[image: List of all groups on Mahara]
A list of all groups on Mahara and certain actions you can perform




	Search for a certain group using a word from the title or description. You can search either all groups, groups you are a member of or groups you are not in.


	If you want to become a member of an open group, click the Join this group button and you will be a member immediately.


	Si vous avez été invité à rejoindre un groupe, simplement cliquez sur Accepter ou Refuser l’invitation.


	If you want to join a group that needs the approval of the group administrator first, click the Request to join this group button next to the group.


	You can also find out more about a group by


	clicking on the group name to see the group homepage


	clicking on the name of the group administrator to get to his profile page


	clicking on the member link to see who is already a member of this group








In addition to the filter options above, you can filter for group categories if the site administrator allowed them and had them set up.


[image: Filter according to a group category]
Filter your search results according to a group category




Note

Normalement, vous ne pouvez accéder ni aux forums, ni au pages ou aux documents du groupe, avant d’en devenir membre. Si un groupe est rendu disponible publiquement vous voyez directement les forums de discussions.







          

      

      

    

  

    
      
          
            
  
5.3. Créer un groupe

You can create a number of different groups depending on your role on Mahara.


	All user roles



	Ouvert : n” importe quel utilisateur du site peut devenir membre du groupe, simplement en visitant la page d’accueil du groupe et en cliquant sur le bouton Rejoindre.


	Sur demande : n’importe quel utilisateur peut demander à rejoindre le groupe. Cependant, en tant que propriétaire, vous pouvez décider d’accepter ou de refuser cette demande. Votre réponse sera automatiquement notifiée au demandeur.


	Invite only: Only users that you explicitely invite may join your group. They can accept or decline your invitation.









	Staff and administrators



	Standard controlled membership



	Vous pouvez ajouter directement des utilisateurs à votre groupe.


	Les membres ne peuvent pas quitter ce groupe.









	Course controlled membership



	Vous pouvez ajouter directement des utilisateurs à votre groupe.


	Les membres ne peuvent pas quitter ce groupe.


	You can assign tutors to the group. They can only add new members.


	Group members can submit portfolio pages for feedback / assessment. These pages are locked until released by an admin or tutor.









	Course request membership



	Any user can request to join your group. However, as owner you can choose to accept or decline this request.


	The members can leave this group.


	You can assign tutors to the group. They can only add new members.


	Group members can submit portfolio pages for feedback / assessment. These pages are locked until released by an admin or tutor.


	This group is designed to be used for a course-based group where the membership is defined by an external system (such as an institution’s enrolment system) and you wish to replicate that membership in the group. However, you can also set up this group manually.



















Note

L” administrateur du site peut limiter la création de groupes aux utilisateurs ayant le rôle de personnel ou d’administrateur du groupe. Si vous ne pouvez pas créer de groupe c’est certainement parce que vous n” avez pas le rôle approprié. Contactez votre administrateur du site, par exemple par le biais du formulaire Contact afin de vous renseigner sur la procédure à suivre pour former un groupe.




5.3.1. Create a group as a user, staff or institution admin

If you are allowed to create a group, you see the Create Group button on the My Groups overview page.


[image: Create a group as a regular user]
Créer un groupe comme utilisateur




	Click the Create Group button on Groups -> My Groups.


	Group name: Provide a name for your group. You must fill in this field.


	Description groupe : Décrivez brièvement les buts de votre groupe.


	Group type: Choose a type for your group. For descriptions of the types and what user role can create which group type, see above.


	Group category: Choose a category if you want to associate your group to one, allowing you to filter groups on the My Groups and Find Groups page. This setting is only available if the site administrator turned it on.


	Publicly viewable group? Choose this option if anybody shall have access to this group. You only see this setting if the site administrator allowed you to have it. Anybody can see the group homepage, the members and the discussion forum. Only members of the groups can see the group’s pages, unless they have been made public, and the files area.


	Shared page notification: This check box has a check mark per default. Whenever somebody shares a page with the group, all group members get an email. You may want to uncheck this setting in very large groups where lots of pages get shared but members do not have to be notified.


	Click the Save Group button to finish creating your group, or click the Cancel button to abort the group creation process.





Note

Le nom du groupe que vous choisissez n’a pas besoin d’être unique sur la plateforme. D’autres groupes peuvent avoir le même nom. Donc, pour les distinguer plus facilement, il est recommandé d’inclure une description.






5.3.2. Créer un groupe en tant qu’administrateur du site

When you have site admin rights, you have an additional setting when you create a group: You can choose to add new users to a group automatically. That way, any new user who creates an account after the group is created becomes a member of this group.


[image: Users auto-add option for site admins]
Add users to a group automatically.




Note

Cette fonction est très intéressante lorsque vous désirez mettre sur pied une communauté dans laquelle chaque utilisateur est invité à venir participer, par exemple, à la vie des forums. Sur mahara.org [http://mahara.org] cette option est utilisée à fin que chaque nouvel utilisateur devienne membre du groupe « Mahara community » dans lequel prennent place les discussions, en anglais, autour de Mahara.

All other group settings still apply.






5.3.3. Modifier les paramètres généraux du groupe

Vous pouvez modifier les paramètres du groupe de trois emplacements différents dans Mahara, en cliquant sur le bouton Modifier |edit| :


	My Groups overview page


	Find Groups page


	La page d’accueil du groupe




Vous vous retrouvez alors sur la même page que lorsque vous créez un groupe et pouvez alors modifier les paramètres du groupe.


Avertissement

You can change the group type to a different one. Please be careful if you do so especially from a controlled course group. If users have submitted portfolio pages to that group, they remain locked eve when you change the group type.









          

      

      

    

  

    
      
          
            
  
5.4. À l’intérieur d’un groupe


Note

L’accès et / ou la modification modification des fonctionnalités montrées et décrites ci-après est fonction du rôle que vous possédez dans le groupe.




5.4.1. Page d’accueil du groupe

The group homepage is the central space for a group. There you can get a quick overview of the group and reach all the places that you wish to take a look at in a group. You see a few things per default on the group homepage.


[image: Group homepage]
Group homepage for an « Invite only » group




	Nom du groupe


	If you are a member in the group, you see your status and whether you can leave the group or not. If you are an admin of the group, you see the Edit and Delete buttons.


	Group navigation


	Informations de base sur le groupe :


	Group administrators so that you can contact them easily


	Type de groupe


	Date de création du groupe


	statistics on the number of group members, pages, files and folders






	Derniers messages publiés dans les forums et un lien vers ces derniers


	Group members and a link to the full list




Si vous êtes administrateur du groupe, vous pouvez ajouter d’autres blocs sur page d’accueil du groupe. Consultez la rubrique blocs, dans le chapitre des pages pour une liste des blocs disponibles.




5.4.2. Membres

Sur la page des membres, un administrateur de groupe peut


	invite multiple users to the group at once or add multiple users in bulk if it is a invite or controlled membership group.


	search for group members


	view basic information about group members like



	leur nom


	leur rôle


	their profile introduction


	leur date d’entrée dans le groupe









	change the role of a user


	remove a user from the group





[image: Group members page]
Page des membres du groupe affichée avec le rôle d’administrateur du groupe



If you are not a group admin, you are not able to invite or add people from the members page and you cannot change the role or remove a user from a group.




5.4.3. Forums

The forums are visible to all group members. If you created a public group, anybody online would be able to see the forum discussions. However, they would need to log in to participate. Forums in public groups receive an RSS feed so that users can subscribe to them, e.g. the mahara.org community forums [http://mahara.org/interaction/forum/index.php?group=1].


[image: Group forum]
Page d’aperçu des forums du groupe




	Si ont vous a attribués les droits nécessaires, vous pouvez créer de nouveaux forums an cliquant sur le bouton Nouveau forum.


	Nom et description brève des buts du forum


	Administrateurs et modérateurs (s’il en est) du forum


	Nombre de sujets dans le forum


	Bouton S’abonner / Se désabonner si l’administrateur du forum permet cette fonctino


	Edit button [image: edit] for making changes to the forum settings for group admins and moderators
Delete button [image: delete] for making changes to the forum settings for group admins and moderators





5.4.3.1. Créer un nouveau forum

Un administrateur du groupe peut créer un nouveau forum dans le groupe


[image: Add a forum to a group]
Basic set up of a forum




	Cliquez sur le bouton Nouveau forum pour créer un nouveau forum.


	Titre : Donnez un nom à votre nouveau forum


	Description : Décrivez brièvement les buts de ce nouveau forum. Ce texte apparaîtra sous le nom du forum dans la liste de l’onglet Forums. Il permet aux utilisateurs de décider plus facilement s’il est intéressant pour eux d’entrer dans le forum ou pas.


	Mode d’affichage des réponses : Sélectionnez le mode d’affichage des réponses aux messages du forum.


	Réponses emboîtées dans toute la discussion : Les réponses de chaque message sont placées les unes sous les autres et indentées les unes par rapport aux autres. Il n’y a pas de limites dans le niveau d’indentation.


	Expand to max: Indentation to indicate the replies to individual post specifying the maximum level of indentation (pops up once this option is chosen). All replies beyond the chosen level are not indented further.


	Réponses en lignes : Il n’a pas d’indentation entre le message et ses réponses, la structure du forum est plate.






	Cliquez sur le bouton Enregistrer pour valider les modifications ou pour continuer avec les Préférences.




En plus des préférences de base, ils existent des options supplémentaires que l’administrateur peut modifier.


[image: Choose further settings in the forum]
Choisir d’autres paramètres dans le forum




	Automatically subscribe users? Choose whether group users will be subscribed to this forum automatically. When subscribed, users will receive notifications when new posts and replies are made in the forum. Users will have the option to unsubscribe if they do not want to be notified.


	Ordre : Par défaut, votre nouveau forum est placé en queue de liste des forums existants. Toutefois, vous pouvez modifier ici sa position en cliquant sur le bouton radio du forum après lequel vous désirez voir apparaître votre nouveau forum.


	Modérateurs : Choisissez un ou plusieurs modérateurs pour votre forum. Ces derniers peuvent modifier ou supprimer des messages ou des discussions entières. Ils peuvent aussi fermer ou ouvrir une discussion ou l’épingler afin qu’elle apparaissent toujours en tête du forum. Les modérateurs peuvent en plus procéder à des tâches d’administration sans toutefois avoir tous droits d’un administrateur.


	Sélectionnez un ou plusieurs utilisateurs de la liste de droite Modérateurs potentiels ou recherchez une personne en particulier.


	Cliquez sur le bouton flèche droite [image: right-arrow] pour ajouter le ou les utilisateurs dans la liste des Modérateurs actuels.


	Pour enlever le rôle de modérateur à un utilisateur, sélectionnez-le dans le liste de droite Modérateurs actuels et cliquez sur le bouton flèche gauche [image: left-arrow] pour supprimer l’utilisateur de la liste.






	Who can create topics: Decide who in your group is allowed to create topics within a forum. If set to « All group members », any group member can create new topics and reply to existing topics. If set to « Moderators and group admins », only moderators and group administrators can start new topics, but once topics exist, all users can post replies to them.


	Fermer les nouvelles discussions : Si cette option est sélectionnée, toute nouvelle discussion sera automatiquement fermée par défaut. Seuls les modérateurs ou les administrateurs pourront alors ajouter des nouveaux messages au fil de la discussion. Cette option est particulièrement adaptée à une discussion qui a comme but de communiquer des informations officielles dans votre groupe.


	Cliquez sur le bouton Enregistrer pour valider les modifications que vous avez faites ou sur le bouton Annuler pour retourner aux préférences initiales.







5.4.3.2. Ajouter un sujet de discussion

Si vous en avez le droit, vous pouvez ajouter un nouveau sujet de discussion dans le forum en cliquant sur le bouton Nouvelle discussion.


[image: Admin screen when in the forum topic list]
Add a new topic to a forum.




Note

Un administrateur a toujours les deux boutons Modifier le forum et Supprimer le forum pour effectuer ses deux actions sur chaque forum.




	Subject: Type the concise description of what you wish to discuss in this forum thread.


	Body: Elaborate on the topic.


	Épingler : cette option n’est disponible qu’aux administrateur et aux modérateurs. Elle permet à bloquer cette discussion en tête des discussions du forum.


	Fermer : cette option n’est disponible qu’aux administrateurs et aux modérateurs. Elle permet d’empêcher les utilisateurs non administrateur ou modérateur d’ajouter des contributions à cette discussion. Ils peuvent toutefois consulter l’entier de la discussion.


	Cliquez sur le bouton Envoyer pour créer votre nouvelle discussion ou cliquez sur le bouton Annuler pour stopper la création de votre discussion.





Note

Quand vous écrivez le corps de votre premier message ou celui en réponse à un précédent message sur le forum, vous pouvez formater votre texte à l’aide de la barre d’outil graphique (si elle est activée). Elle vous permet de facilement ajouter des éléments multimédia dans vos messages. Toutefois, vous ne devez pas copier-coller les adresses URL de vos images qui sont stockée dans votre zone de dépôt de fichiers. Ces documents ne sont accessibles que par le système de permissions accordées au niveau des pages de Mahara et ne s’afficheront donc pas normalement si vous les incluez dans un message du forum.

Dans certains groupes, vous pouvez être amené à téléverser des documents dans la zone de dépôt du groupe, afin que chaque membre du groupe puisse y accéder. Vous pouvez alors utiliser un lien vers ces documents, car ceux qui accéderont aux messages de votre groupe sont membres du groupe et ont par conséquent accès aussi aux fichiers du groupe. Faites toutefois attention que les membres peuvent, peut-être aussi, avoir le droit de supprimer des documents, ce qui pourrait poser problème si un message du forum fait référence à un document qui ait été supprimé.



Once you have finished writing your forum topic, it is displayed in the list of forum topics. Others can see it immediately. The administrator and moderator of the forum can edit or delete a topic. Regular members cannot do so.


[image: First post in a forum topic]
First post in a forum topic




	Le titre du forum


	Le titre du sujet de discussion


	L’image du profil et le nom de la personne qui a écrit le message. Le nom est lié à la page du profil de la personne en question


	Le nombre de messages que cette personne a écrits dans l’ensemble des forums


	La date et l’heure de publication du message


	Le message en lui-même


	Le bouton Répondre pour participer à la discussion







5.4.3.3. Répondre à un sujet de discussion ou à un message

Everybody can reply to a forum topic or other posts therein unless the moderator or administrator had closed the topic. The replies are intended to make it easier to see to which comment you replies except in forum topics that do not use indentation.


[image: reply to a forum post]
Répondre à un message du forum




	Cliquez sur le bouton Répondre en dessous du message auquel vous désirez répondre. Le message auquel vous répondez est ensuite affiché au dessus de votre réponse durant le temps de la rédaction afin que vous puissiez facilement vous y référer si nécessaire.


	Set a different subject if you want to by clicking on Click to set a subject. This is most often not necessary and usually only used if the topic evolves into a different discussion. However, in such cases, a new forum topic should be opened.


	Write your comment.


	Cliquez sur le bouton Envoyer pour publier votre réponse ou sur le bouton Annuler pour stopper la procédure.





Note

Une fois que vous avez cliqué sur le bouton Envoyer, vous avez un certain temps pour modifier votre message avant qu’il soit publié et envoyé aux utilisateurs qui ont souscrit à l’envoi des messages du forum. La durée durant laquelle vous pouvez modifier votre message a été fixée par votre administrateur dans la préférence du site délai avant envoi.

[image: edit-post]

Quand vous (ou un administrateur ou un modérateur) modifiez ce message après le délai, la date, l’heure et la personne qui a modifié le message sont indiquées sous « Modifications de ce message ».






5.4.3.4. Effacer un message, un sujet de discussion ou un forum

Un modérateur ou un administrateur peut toujours modifier ou supprimer un message, un sujet de discussion ou l’entier d’un forum.


Avertissement

Une fois qu’un message, un sujet de discussion ou un forum a été supprimé, cette action n’est pas réversible et le contenu est définitivement perdu.






5.4.3.5. Actions en lot sur les forums

Les administrateurs de groupe et les modérateurs des forums peuvent effectuer des opérations par lots sur les forums d’un groupe.


[image: Forum bulk actions]
Actions en lot sur les forums




	Sélectionner les sujets de discussion sur lesquels vous désirez réaliser des opérations par lots.


	Choisissez une action à accomplir depuis la liste des actions disponibles dans le menu déroulant. Vous pouvez choisir entre


	épingler : Les sujets de discussion resteront en tête des tous les autres sujets de discussion.


	ne pas épingler : Les sujets de discussion seront replacés dans leur ordre chronologique.


	fermer : Seuls les administrateurs et les modérateurs pourront ajouter des messages à ces sujets de discussion.


	ouvrir : Tout le monde pourra à nouveau ajouter des messages à ces sujets de discussion.






	Cliquez sur le bouton Modifier les discussion sélectionnées pour valider vos modifications.









5.4.4. Pages

Les membres d’un groupe ont accès aux pages partagées. Il peut s’agir :


	des pages créées dans le groupe


	des pages partagées avec le groupe




Ces dernières correspondent à celles qu’un utilisateur a rendu accessibles au groupe depuis sa page personnelle en les partageant avec le groupe. Les membres du groupe ne peuvent pas modifier ces pages.

Depending on the group type, either only administrators or also regular group members can create and edit group pages.


Avertissement

Ceux qui peuvent modifier des pages du groupe peuvent ainsi ajouter ou supprimer des blocs sur ces pages. Il n’existe pas un système de suivi des versions qui permettrait de savoir qui a fait quoi sur les différentes pages. Les utilisateurs doivent se faire confiance mutuellement et collaborer à la maintenance des pages. Dans le cas contraire, il est préférable de ne leur laisser que de partager les pages avec le groupe.




5.4.4.1. Page d’accueil du groupe

The group homepage can only be edited by the group administrator. It contains a number of default blocks. You can add more blocks to it to customize the page for the group. Please refer to the overview of blocks for a list of all the blocks that you can use in the group homepage.




5.4.4.2. Pages de groupe régulières

Créer et modifier des pages de groupe est très similaire à la création, à la modification et au partage des pages personnelles. Tous les blocs ne pas disponibles lors de la modification des pages de groupe dans l”éditeur de pages, ceci notamment parce qu’elles appartiennent à un contexte différent. Veuillez vous référer à la présentation des blocs pour une liste exhaustive des blocs que vous pouvez utiliser dans les pages de groupe.


Voir aussi

Pour savoir comment envoyer une page à évaluation à un groupe, afin de recevoir une évaluation par un tuteur, veuillez consulter la section sur les commentaires dans le manuel.








5.4.5. Fichier

The files area in a group holds all files that are uploaded by group members who have the permission to do so. The uploading process works as the one in the personal files.

En comparaison de votre espace de fichiers personnel, celle du groupe comprend des options supplémentaires :


[image: group file permissions]
Préférences de partage d’un fichier du groupe



When you have the permission to upload a file, you can also determine additional permissions of who can view the file and edit its metadata. An administrator has all rights, but you can restrict them to regular group members or tutors in a course group.


	Page : Vous pouvez voir le fichier dans la zone de dépôt du groupe et l’ajouter à vos pages personnelles.


	Modifier : Vous pouvez modifier le nom du fichier, sa description, ses mots-clés et les permissions.


	Publier : Vous pouvez inclure un fichier du groupe dans une page de votre portfolio personnel que vous publiez.










          

      

      

    

  

    
      
          
            
  
5.5. Mes amis

Your friends are special group on Mahara. You can share your portfolio pages easily with them and get in touch with them quickly by going to this page. They differ from a regular group in that they do not have discussion forums, pages or share files. If you do wish to do that with your friends, you have to create a regular group for them.

Vous pouvez demander à d’autres utilisateurs de rejoindre votre liste d’amis de différentes manières :


	Allez sur leur page de profil et cliquez sur le lien Demande de rejoindre sa liste d’amis.


	Aller sur la page Trouver des amis et ainsi vous pourrez rechercher des amis potentiels.





[image: My Friends page]
« My friends » page




	Si vous avez un grand nombre de demande d’ajout sur la liste d’amis d’autres utilisateurs, vous pouvez filtrer l’affichage en ne montrant qu’une catégorie d’utilisateurs (amis actuels ou demandes en attente).


	La page de son profil, en cliquant sur nom.


	If a friend is in the pending state, approve or deny the request.


	Send a message to the friend if you wish to do so.


	Si vous désirez enlever cet utilisateur de votre liste d’amis, cliquez sur le lien Retirer de la liste d’amis.


	If you are a group administrator in a group that one of your friends belongs to, you can edit his group membership here as well.








          

      

      

    

  

    
      
          
            
  
5.6. Rechercher des contacts

If you want to establish your social network on Mahara, you can use the Find friends page to find people to connect to. An alphabetical list of all users on the system is provided.


[image: Find friends page]
« Find friends » page




	Use the search box to search for a name.


	All results are listed. You can click on the name to view that user’s profile page.


	You find more information about this user and can take more actions:


	The name of the institution of which he is a member


	Send this user a message without requesting friendship


	Send this user a friend request









Note

You can prevent others from sending you messages or friend requests if you disabled these in your account settings.




5.6.1. Envoyer une demande de contact

You send a friend request from the Find friends page by clicking on the Send Friend Request! link next to the user you want to be friends with.


[image: Send friend request]
Devenir son ami




	Give a reason why want to request friendship of this user. This reason can be important if the other person does not know you well, and thus may likely reject your request.


	Cliquez sur le bouton Envoyer la demande pour faire parvenir votre justification et votre demande à personne désirée, ou cliquez sur le bouton Annuler pour annuler cette procédure.







5.6.2. Accepter la demande de devenir l’ami d’un utilisateur

Quand un autre utilisateur vous demande d’entrer dans sa liste d’amis, vous recevez une notification que vous pouvez lire dans votre boîte de réception.


[image: Pending friend request]
Demandes en suspens d’ajout à sa liste d’amis



Quand vous cliquez sur la demande, vous êtes redirigé vers la page Mes amis où toutes les demandes en attentes sont affichées.


[image: Page with all pending friend requests]
Afficher toutes les demandes en suspens d’ajout à une liste d’ami




	View the name of the person requesting friendship and a short desciption if one had been written. You can click on the name and see the profile page.


	Read the reason why this user requests friendship.


	Click the Approve Request! link to approve the friend request. Once you approved a friend request, you appear immediately on that user’s My friends page and the user on yours.


	Click the Deny Request link to deny friendship.


	Click the Send message button to communicate with the user before making your decision about the friend request.







5.6.3. Refuser la demande d’un utilisateur de venir dans sa liste d’amis

Quand une personne vous envoie une demande de venir dans sa liste d’amis, allez sur la page Mes amis pour lister les demandes en suspens.


	Next to the person whose request you wish to deny, click the Deny Request link.


	Indiquez la raison pour laquelle vous refusez la demande, pour autant que vous souhaitez en donner une.


	Click the Deny friend request button to send you message off or click the Cancel button to abort your action.


	The user receives a notification that includes your reason for denial.










          

      

      

    

  

    
      
          
            
  
5.7. Pages partagées

This page lists the most recently modified or commented on pages that have been shared with:


	vous directement


	vous comme ami


	vous commen membre d’un groupe




Not displayed are pages that have only been shared with:


	the public


	tous les utlisateurs connectés




That means, if a page has been shared with all logged-in users and in addition with you, you see the page on your shared pages. Otherwise, it does not appear here.

The shared pages are a quick way to find the pages that you may be most interested in looked at.

Vous ne pouvez pas supprimer ou créer quoi que ce soit depuis cette page. Il s’agit d’une page page d’affichage seulement.


[image: Shared pages list]
« Shared pages » list




	You can filter the pages that have been shared with you by title, desctiption and tags or by tags only.


	The title and author of the page are linked so that you can jump to them quickly.


	The description of the page as well as the tags are displayed.


	Indique le nombre de commentaires pour chaque page.


	Le début du dernier commentaire sur la page ainsi que le nom de son auteur et la date de publication sont affichés.


	By clicking on the View comment button you can read the entire comment.








          

      

      

    

  

    
      
          
            
  
5.8. Discussions

La page Discussions contient l’ensemble des sujets de discussion des forums des groupes dont vous êtes membre. Les discussions sont triées en ordre chronologique inversé, en commençant avec les derniers commentaires.


[image: Latest posts in discussion forums]
Les derniers messages dans les discussions sur les forums




	Le titre des sujets de discussion du forum, de même que le nom du groupe auquel est rattaché le forum sont affichés. Ils sont liés aux éléments cités, que vous pouvez donc directement accéder en les cliquant.


	Le nombre de messages dans cette discussion est affiché


	Le début du dernier commentaire dans le sujet de discussion est affiché, de même que le nom de son auteur (lié à la page de profil de ce dernier) et la date de publication.


	Le nombre total de sujets de discussion du forum est affiché. Quand ce nombre est supérieur à 10, seuls les dix premiers sujets de discussion sont affichés, les suivants peuvent être accédés par la barre de navigation en dessous du bloc.








          

      

      

    

  

    
      
          
            
  
6. Blocs

Les blocs pour les productions internes et externes sont utilisés pour créer des pages de portfolio et des pages de  groupes. Un grand nombre de blocs est disponible dans Mahara. D’autres peuvent être utilisés si les plug-ins [http://wiki.mahara.org/Plugins] sont installés.



	6.1. Contenu externe
	6.1.1. Flux externe

	6.1.2. External video

	6.1.3. Google Apps





	6.2. Fichiers, images et vidéos
	6.2.1. File(s) to Download

	6.2.2. A Folder

	6.2.3. Image Gallery

	6.2.4. Du code HTML

	6.2.5. An Image

	6.2.6. Embedded Media





	6.3. Général
	6.3.1. Creative Commons License

	6.3.2. Navigation

	6.3.3. Your Plans

	6.3.4. Recent Forum Posts

	6.3.5. Text Box

	6.3.6. My Inbox

	6.3.7. Latest Pages

	6.3.8. Group Info

	6.3.9. Group Members

	6.3.10. Group Pages





	6.4. Journaux
	6.4.1. Afficher l’intégralité d’un journal

	6.4.2. Afficher un article d’un journal

	6.4.3. Afficher les articles récents





	6.5. Profil
	6.5.1. Information de contact

	6.5.2. My Friends

	6.5.3. My Groups

	6.5.4. My Pages

	6.5.5. Information du profil

	6.5.6. Mon mur





	6.6. Curriculum vitae
	6.6.1. Afficher l’entier du curriculum vitae

	6.6.2. Afficher une rubrique du curriculum vitae





	6.7. Les blocs et les différentes catégories de pages dans Mahara









          

      

      

    

  

    
      
          
            
  
6.1. Contenu externe

Avec l’aide des blocs de contenu externe, vous pouvez inclure des flux RSS, des médias externes ou des documents GoogleApps, etc. dans la page.


6.1.1. Flux externe

[image: External feed]
Intégrer un flux RSS ou ATOM externe, pour afficher un blogue externe par exemple.


[image: Configure external feed]
Configurer le bloc des flux externes




	Block Title: If you leave the title blank, the title of the feed will be taken.


	Emplacement du flux: Indiquez ici l’URL complète d’un flux RSS ou ATOM valide. Si le flux n’est pas affiché, essayez de l’afficher dans un lecteur de flux habituel pour vous assurer que l’URL est correcte.


	Éléments à afficher: Décidez du nombre d’éléments récents du flux que vous souhaitez afficher. Vous pouvez en choisir jusqu’à 20.


	Show feed items in full?: If you do not select this option, only a heading will be shown for each feed item, e.g. the blog heading of a post. If you select this option, the entire content of the feed item will be shown, e.g. the entire blog post or in case of a flickr RSS feed, the photo and its description.


	Cliquez sur le bouton « Enregistrer » pour valider vos changements, ou cliquez sur le bouton Supprimer pour enlever ce bloc de votre page.





Note

Si votre flux n’est pas mis à jour automatiquement, demandez s’il vous plaît à votre administrateur de vérifier les paramètres du cron.






6.1.2. External video

[image: External video]
Embed an external video from:


	YouTube [http://youtube.com]


	Google Videos [http://video.google.com/]


	TeacherTube [http://www.teachertube.com]


	Scivee.tv [http://www.scivee.tv/]





[image: Configure external video]
Configure the external video block




	Block Title: Choose a title for your video.


	Video URL: Paste the video embed code or the URL of page where the video is located.


	Width and Height: Choose the width and the height for the video.


	Cliquez sur le bouton « Enregistrer » pour valider vos changements, ou cliquez sur le bouton Supprimer pour enlever ce bloc de votre page.





Note

If you use the embed code for a video, you still have to provide the correct width and height for the video although they are already exist in the embed code. Mahara ignores these variables from the embed code.






6.1.3. Google Apps

[image: Google Apps]
Intégrez tout le contenu suivant, disponible via Google (Apps):


	livres


	calendriers


	documents, classeurs, présentations


	cartes




Vous pouvez uniquement afficher le contenu, mais pas immédiatement modifier les documents, classeurs ou présentations. Vous devrez être connecté à votre compte Google (Apps) pour se faire. Vous pouvez utiliser ce bloc avec un compte Google classique, personnel ou avec le compte Google Apps de votre institution (collège, lycée) si vous en avez un.


Note

Si certains documents ont une restriction liée à un domaine Google Apps ou à une personne en particulier, un écran de connexion est affiché.




[image: Configure external feed]
Configurer le bloc Google Apps




	Block Title: Choose a title for your embedded content.


	Code d’intégration ou URL: Suivant le type de contenu que vous souhaitez afficher, vous devez fournir alternativement le code d’intégration ou l’URL. Cliquez sur le bouton [image: help] pour avoir plus d’information sur comment intégrer chaque composant de Google.


	Hauteur: Choisissez la hauteur pour le contenu intégré. La largeur est ajustée automatiquement à la largeur du bloc.


	Cliquez sur le bouton « Enregistrer » pour valider vos changements, ou cliquez sur le bouton Supprimer pour enlever ce bloc de votre page.




Document Google


	Open the Google Docs document.


	Click Share and then Publish to the Web (upper right-hand corner) OR if you use the new interface: Click File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper right-hand corner.


	Cliquez sur le bouton Démarrer la publication


	Copiez le document


	Paste the link / embed code into the Embed code or URL box in the Google Apps block.




Feuille de calcul Google


	Open the Google Docs spreadsheet.


	Click Share and then Publish to the Web (upper right-hand corner) OR if you use the new interface: Click File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper right-hand corner.


	Cliquez sur le bouton Démarrer la publication


	Copiez le lien


	Collez le lien dans la rubrique Inclure le code or l’URL du bloc Google Apps.




Présentation Google


	Open the Google Docs document.


	Click Share and then Publish to the Web (upper right-hand corner) OR if you use the new interface: Click File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper right-hand corner.


	Cliquez sur le bouton Démarrer la publication


	Copy the document link or embed code and adjust any of the other settings if you wish.


	Paste the link / embed code into the Embed code or URL box in the Google Apps block.




Collections Google


	In Google Docs click My collections or Collections shared with me (list on left side)


	Click and select the collection that you wish to embed -> click Sharing -> Settings OR if you use the new interface: Click on the arrow to the right of the collection name and then on Share -> Share. Alternatively, put a checkmark in front of the collection that you wish to share and go to the More menu item -> Share -> Share.


	Change the permissions to Public and save your changes.


	Copiez le lien


	Paste the linke into the Embed code or URL box in the Google Apps block.




Visionneuse Google Document

This functionality works like the preview functionality in Gmail. You can embed the file, which is directly accessible over the Internet. You just have to paste the complete URL (including the filename) on which the file is accessible to the Google Apps block.

If you use the new interface, you must publish the document first:
Click File -> Publish to the web. You do not have to set any sharing options via the Share button in the upper right-hand corner.

Google Docs Viewer currently supports embedding of the following file types: PDF, TIFF, PPT, DOC, DOCX.


Note

The files you uploaded to Mahara are not directly accessible, so you can’t embed those files.



Agenda Google


	Ouvrez l’agenda de Google.


	Cliquez sur le petit triangle à côté du nom du l’agenda que vous désirez inclure.


	Click on the calendar settings.


	On the Calendar details tab scroll down to Embed This Calendar.


	Personnalisez l’apparence de l’agenda, puis copiez le code d’inclusion.


	Collez le code d’inclusion dans la rubrique Inclure le code ou l’URL du bloc Google Apps.




Google Maps


	Ouvrez Google Maps


	Click My Maps (My Places in the new interface) link on the upper left side.


	Cliquez sur le nom de la carte que vous souhaitez incorporer.


	Click Link (the link icon in the new interface) link on the upper right side.


	Personnalisez l’apparence de votre carte et copiez le code d’incorporation.


	Collez le code d’inclusion dans la rubrique Inclure le code ou l’URL du bloc Google Apps.





Note

Use steps 2 and 3 only if you wish to embed your Google map. If you wish to embed any Google map, you can skip steps 2 and 3.



Google livres


	Ouvrez Google Livres.


	Recherchez le livre que vous désirez incorporer.


	Cliquez sur le titre du livre.


	Click on Link on the upper right side.


	Copiez le code d’inclusion pour le livre.


	Collez le code d’inclusion dans la rubrique Inclure le code ou l’URL du bloc Google Apps.





Note

Ce lien n’apparaît que si vous avez les droits d’incorporer ce livre.









          

      

      

    

  

    
      
          
            
  
6.2. Fichiers, images et vidéos

These artefacts are internal Mahara ones to display links to files that you have uploaded, folders that contain files, show images, embed audio and video files.


6.2.1. File(s) to Download

[image: Files to download]
Sélectionnez les fichiers qui pourront être téléchargés par ceux qui accéderont votre portfolio


[image: Configure the block Files to download]
Configure the file(s) to download block




	Block Title: Choose a title for your document block.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Déposer fichier : Vous n’avez pas besoin de retourner dans Fichier de la zone Contenu pour téléverser un fichier. Vous pouvez le faire directement depuis cette page.


	Chemin du dossier : Le fil d’Ariane vous montre dans quel dossier vous êtes actuellement.


	Vous pouvez modifier les paramètres du fichier (nom, description, mots-clés) directement depuis cette page, en cliquant sur le bouton Modifier.


	Sélectionnez le ou les fichiers que vous souhaitez afficher, en cliquant sur le bouton Sélectionner.


	Cliquez sur le bouton Retirer pour retirer un fichier de la liste de ceux que le bloc doit afficher sur votre page.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.





Note

You cannot re-order files once you have them selected. You would need to remove them and select them again in the correct order.



Quand le bloc est placé sur une page du portfolio, les informations suivantes sont affichées :


	le nom du fichier


	la description du fichier


	la taille du fichier


	la date à laquelle le fichier a été téléversé


	un lien vers une page d’informations supplémentaires sur le fichier





[image: File download details]
Informations sur les fichiers qui peuvent être téléchargés.



Quand un utilisateur clique sur le lien Détails, il est conduit sur une page d’informations supplémentaires sur le fichier en question. Depuis cette page, l’utilisateur peut signaler aux administrateurs que le contenu de ce fichier est discutable, ou ajouter ce fichier à sa liste de suivi.


[image: Metadata for a file]
Plus d’informations un fichier qui peut être téléchargé.




Note

Si vous avez autorisé les commentaires sur les fichiers, paramètre que vous pouvez configurer dans les informations du fichier, les utilisateurs pourront laisser des commentaires ou des évaluations directement sur cette page pour ce fichier et pas seulement pour l’ensemble de la page où il est affiché.






6.2.2. A Folder

[image: Display an entire folder]
Sélectionnez les fichiers qui pourront être téléchargés par ceux qui accéderont votre portfolio


[image: Configure the block Folder]
Configure the folder block




	Block Title: If you leave the title blank, the title of the folder that you choose to display will be taken.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Chemin du dossier : Le fil d’Ariane vous montre dans quel dossier vous êtes actuellement.


	Vous pouvez toujours modifier les informations de ce dossier (non, description, mots-clés) en cliquant sur le bouton Modifier.


	Choose the folder you wish to display by clicking on the Select button. If you want to revert your selection, click the Remove button.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.







6.2.3. Image Gallery

[image: Display an image gallery]
Select a folder with images or individual images to show in a gallery.


[image: Configure the block Image Gallery]
Configure the image gallery block




	Block Title: Choose a title for your image gallery block.


	Image Selection: You can choose to display all images from a specific folder or you can select the images individually.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Chemin du dossier : Le fil d’Ariane vous montre dans quel dossier vous êtes actuellement.


	Vous pouvez toujours modifier les informations de ce dossier (non, description, mots-clés) en cliquant sur le bouton Modifier.


	Choisissez le dossier que vous désirez afficher en cliquant sur le bouton Sélectionner.


	Si vous voulez supprimer votre sélection, cliquez sur le bouton Retirer.


	Style: Decide to show all selected images as thumbnails or as slideshow where you only see one image at a time.


	Largeur : Spécifiez la largeur (en pixels) de vos images. Les images sont retaillées à cette largeur, leur hauteur étant recalculée proportionnellement.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.





Note

Si vous décidez d’afficher le contenu entier d’un dossier dans votre galerie d’images, les images que vous ajouteriez plus tard dans ce dossier seront automatiquement ajoutées à la galerie.






6.2.4. Du code HTML

[image: Include HTML code]
Affiche le contenu d’un document HTML


[image: Configure the block Some HTML]
Configure the html block




	Block Title: Choose a title for your block.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Déposer fichier : Vous n’avez pas besoin de retourner dans Fichier de la zone Contenu pour téléverser un fichier. Vous pouvez le faire directement depuis cette page.


	Chemin du dossier : Le fil d’Ariane vous montre dans quel dossier vous êtes actuellement.


	Vous pouvez modifier les paramètres du fichier (nom, description, mots-clés) directement depuis cette page, en cliquant sur le bouton Modifier.


	Sélectionnez le fichier contenant du code HTML que vous désirez afficher votre page en cliquant sur le bouton Sélectionner.


	Cliquez sur le bouton Retirer pour cesser d’afficher ce document sur votre page.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.





Note

You can only display a self-contained HTML file in a Mahara page, but not an entire site because the links to the files are not retained correctly when you upload files to Mahara.






6.2.5. An Image

[image: Display an image in a block]
Affiche une seule image dans un bloc.


[image: Configure the block Some HTML]
Configure the image block




	Block Title: Choose a title for your block.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Déposer fichier : Vous n’avez pas besoin de retourner dans Fichier de la zone Contenu pour téléverser un fichier. Vous pouvez le faire directement depuis cette page.


	Chemin du dossier : Le fil d’Ariane vous montre dans quel dossier vous êtes actuellement.


	Vous pouvez modifier les paramètres du fichier (nom, description, mots-clés) directement depuis cette page, en cliquant sur le bouton Modifier.


	Sélectionnez le fichier contenant du code HTML que vous désirez afficher votre page en cliquant sur le bouton Sélectionner.


	Cliquez sur le bouton Retirer pour cesser d’afficher ce document sur votre page.


	If your file has a description you can choose to display it. The description could contain the source of the photo for example.


	Fixez la largeur (en pixels) de votre photo. Si vous ne donnez pas de valeur dans cette rubrique, la largeur de l’image sera adaptée à la taille de votre bloc.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.







6.2.6. Embedded Media

[image: Embed a video or audio file]
Display an embedded video or audio file from your uploaded files. You can display mp3, mp4 and flv files.


[image: Configure the block Some HTML]
Configure the media block




	Block Title: Choose a title for your block.


	Files area: Choose from which area of Mahara you would like to select a file. If you are not a member of a group and not an admin, you may only see My Files. If you have access to files elsewhere, these contexts are shown as well, e.g. the Site Files.


	Déposer fichier : Vous n’avez pas besoin de retourner dans Fichier de la zone Contenu pour téléverser un fichier. Vous pouvez le faire directement depuis cette page.


	Chemin du dossier : Le fil d’Ariane vous montre dans quel dossier vous êtes actuellement.


	Vous pouvez modifier les paramètres du fichier (nom, description, mots-clés) directement depuis cette page, en cliquant sur le bouton Modifier.


	Sélectionnez le fichier contenant du code HTML que vous désirez afficher votre page en cliquant sur le bouton Sélectionner.


	Cliquez sur le bouton Retirer pour cesser d’afficher ce document sur votre page.


	If your file has a description you can choose to display it.


	Choose the width and height (in pixels) for your video.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.





Note

Seuls les fichiers dont le format est autorisé sur votre plateforme seront affichés. Si vous avez téléversé un document MP4 mais qu’il n’apparaît pas ici, vous devez vérifier si le codec qui a servi à enregistrer ce fichier est le bon. Seul le H.264 peut être utilisé par Mahara.









          

      

      

    

  

    
      
          
            
  
6.3. Général

The artefacts in this tab are of a general nature or did not fit into any other category and can be used around the site.

Quand vous créez une page dans un groupe, les blocs navigation et vos projets ne sont pas disponibles, car vous ne pouvez pas créer ni de collections ni de projets dans un groupe. Par contre, vous pouvez utiliser les blocs suivants lorsque vous modifiez ou créez la page d’accueil d’un groupe.


	Group Info


	Group Members


	Group Pages





6.3.1. Creative Commons License

[image: Add a Creative Commons license]
Add a block to your page which lets users know under which Creative Commons license your page is published.


[image: Configure the block Files to download]
Configure the Creative Commons block




	Block Title: Choose a title for your document block.


	Autorisez-vous les utilisations commerciales de votre création ? : Décidez si les utilisateurs peuvent utiliser le résultat de votre travail pour buts commerciaux ou non.


	Autorisez-vous les modifications de votre création ? : Décidez comment les autres utilisateurs peuvent ou non modifier le travail que vous avez fourmi ou le réutiliser dans leurs propres créations.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.





Voir aussi

For more information about the licenses and their terms, visit the Creative Commons web site [http://creativecommons.org/licenses/].






6.3.2. Navigation

[image: Add a navigation block for a collection]
Ajoute un bloc de navigation avec des liens sur chaque page d’une collection.


Note

You must create at least one collection first in order to use this block.




[image: Configure the navigation block]
Configure the navigation block




	Block Title: The title of the collection is chosen automatically unless you provide a different one.


	Collection : Choisissez la collection dans le menu déroulant pour laquelle vous désirez créer et afficher le bloc de navigation.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.







6.3.3. Your Plans

[image: Add a plan to your page]
Affiche un de vos projets dans un bloc.


Note

You must create at least one plan first in order to use this block.




[image: Configure the navigation block]
Configure the plans block




	Block Title: The title of the plan is chosen automatically unless you provide a different one.


	Choisissez le projet à afficher : Sélectionnez le projet dont vous voulez afficher les tâches sur votre page.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.





[image: Embedded plan]
Affiche le contenu d’un projet sur une page du portfolio. En cliquant sur chacun des titres, vous affichez les descriptions des différentes tâches du projet.






6.3.4. Recent Forum Posts

[image: Add recent forum posts]
Affiche sur la page les n derniers messages postés dans un groupe.


Note

Vous devez être membre d’au moins un groupe pour pouvoir utiliser ce bloc.




[image: Configure the recent forum posts block]
Configure the recent forum posts block




	Block Title: The title of the block is generated automatically unless you provide a different one. The default title is « Recent Forum Posts ».


	Group: Choose the group whose forum posts shall be displayed.


	Maximum number of posts to show: Decide how many of the latest forum posts you wish to show. The default value is 5.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.







6.3.5. Text Box

[image: Add text]
Ajoute une zone de texte à votre page. Cette fonction est utile lorsque vous désirez afficher une information que vous ne voulez pas garder dans un journal, par exemple un extrait de texte.


Avertissement

If you remove a text box from a page, its content is deleted forever and cannot be retrieved anymore. Only in the upcoming Mahara 1.5 version will text boxes be artefacts that can be stored and re-used.




[image: Configure the recent forum posts block]
Configure the text box block




	Block Title: Provide a title for your text.


	Block Content: Write your text. You can include formatting, external images etc.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.





Note

Nous vous recommandons de ne pas placer dans ces boîtes de texte des images qui ont été préalablement téléversées sur Mahara. Il n’est pas garanti que ces dernières puissent être affichées lorsqu’un utilisateur vient visiter la page, s’il n’a pas les droits sur l’image depuis une autre page. Tous les accès dans Mahara sont gérés en fonction des pages et aux blocs des productions à travers elles. Une image dans une boîte de texte n’est pas considérée comme une production et n’hérite par conséquent pas des droits donnés à la page.






6.3.6. My Inbox

[image: My Inbox block]
The My Inbox block displays the latest messages that you have received in Mahara.


Note

Ce bloc ne peut être placé que sur votre « Tableau de bord »




[image: Configure the inbox block]
Configure the inbox block




	Block Title: The automatic title for this block is « Recent Activity ». You can set another one if you wish.


	Types de messages à afficher : Sélectionnez les différents types de messages que vous désirez afficher dans ce bloc.


	Maximum number of items to display: Decide how many pages shall be shown on your dashboard. You can choose between 5 and 100.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.







6.3.7. Latest Pages

[image: Latest pages block]
The Latest Pages block displays the latest pages to which you have access across Mahara.


Note

Ce bloc ne peut être placé que sur votre « Tableau de bord »




[image: Configure the latest pages block]
Configure the latest pages block




	Block Title: The automatic title for this block is « Latest pages ». You can set another one if you wish.


	Maximum de pages à afficher : Décidez du nombre maximum de pages à afficher sur votre Tableau de bord. Les valeurs possibles vont de 5 au minimum à 100 au maximum.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.







6.3.8. Group Info

[image: Add the group info block]
Ce bloc est placé par défaut sur la page d’accueil de chaque groupe. Il n’y a pas de configuration possible. Le bloc contient des informations sur :


	l’administrateur du groupe


	le type du groupe


	la date de création du groupe


	le nombre de membres dans le groupe


	le nombre de pages créées dans le groupe


	le nombre de fichiers téléversés dans le dépôt du groupe


	le nombre de dossiers créés dans le groupe







6.3.9. Group Members

[image: Add the group members block]
Ce bloc est affiché par défaut sur la page d’accueil de chaque groupe. Vous pouvez décider d’afficher le nom et l’image du profil des membres.


[image: Configure the group pages block]
Configure the group members block




	Block Title: The automatic title for this block is « Members ». You can set another one if you wish.


	Shown Members: Choose how many members (between 1 and 20) are shown on the group homepage. All others are accessible via the Members tab in the group.


	Order: Choose the order in which members are displayed. Options are:


	Derniers : affiche les n derniers membres qui ont rejoint le groupe


	Au hasard : laisse à Mahara le soin de choisir n membres de manière aléatoire






	Cliquez sur le bouton Enregistrer pour valider vos modifications, ou cliquez sur le bouton Annuler pour laisser le bloc dans l’état initial.







6.3.10. Group Pages

[image: Add the group pages block]
Ce bloc est placé par défaut sur la page d’accueil de chaque groupe. Permet d’afficher les pages créées et/ou partagées par ce groupe.


[image: Configure the group pages block]
Configure the group pages block




	Block Title: The automatic title for this block is « Group pages ». You can set another one if you wish.


	Display Group pages? Decide whether to display pages that were created in the group. « Yes » is the default option.


	Display Shared pages? Decide whether to display pages that users shared with the group. « No » is the default option.


	Cliquez sur le bouton Enregistrer pour valider vos modifications, ou cliquez sur le bouton Annuler pour laisser le bloc dans l’état initial.










          

      

      

    

  

    
      
          
            
  
6.4. Journaux

Vous pouvez incorporer dans une page le contenu de vos journaux de différentes manières :


	afficher l’intégralité du journal


	afficher un article d’un journal


	afficher les derniers articles d’un journal





Note

Vous devez avoir créé au moins un journal pour pouvoir afficher quelque chose dans ce bloc.




Avertissement

Vous pouvez permettre la copie de votre journal (articles). Choisissez cette option avec soin, car une fois qu’un utilisateur aura copié un article d’un de vous journaux, il apparaîtra que c’est lui qui aura écrit cet article. Ceci pourrait conduire à des situations de plagiat. Toutefois, c’est option intéressante lorsqu’une personne désire mettre en place un système de gabarits à titre d’exemple, afin de faciliter la construction de l’apprentissage.




6.4.1. Afficher l’intégralité d’un journal

[image: Display an entire journal]
Affiche l’intégralité d’un de vos journaux sur votre page.


[image: Configure the journal block]
Configure the journal block




	Block Title: The title of the journal is chosen automatically unless you provide a different one.


	Journal : Sélectionnez le journal duquel vous désirez afficher les articles. Si vous avez plusieurs journaux, vous pouvez aussi effectuer une recherche afin de trouver celui que vous désirez utiliser.


	Articles par page : Décidez du nombre maximum d’articles à affiche sur la page. Les articles au-delà de ce nombre sont accessibles via la barre de navigation de la page.


	Permission de copie du bloc : Vous décidez ce qui doit se passer avec ce bloc lorsqu’un utilisateur qui en a le droit copie votre page : Les options sont :


	Sauter ce bloc lors de la copie de la page


	Les autres pourront afficher votre journal sur leur page


	Les autres obtiendront leur propre copie de votre journal






	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.





Note

Si vous partagez la page dans laquelle vous avez un article d’un de vos journaux qui y est affiché, le journal en question se voit automatiquement créer un flux RSS auquel vos lecteurs peuvent souscrire et lire depuis leur lecteur de flux RSS favori.






6.4.2. Afficher un article d’un journal

[image: Display one journal entry]
Affiche l’intégralité d’un de vos journaux sur votre page.


[image: Configure the journal entry block]
Configure the journal entry block




	Block Title: The title of the journal post is chosen automatically unless you provide a different one.


	Journal Entry: Select the journal entry you wish to display. If you have many posts, you can also search for the one you want to use.


	Permission de copie du bloc : Vous décidez ce qui doit se passer avec ce bloc lorsqu’un utilisateur qui en a le droit copie votre page : Les options sont :


	Sauter ce bloc lors de la copie de la page


	Les autres utilisateurs peuvent alors utiliser votre article dans leurs propres pages


	Les autres utilisateurs reçoivent leur propre copie de l’article que vous avez écrit






	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.







6.4.3. Afficher les articles récents

[image: Display recent journal posts]
Affiche l’intégralité d’un de vos journaux sur votre page.


[image: Configure the recent journal entries block]
Configure the recent journal entries block




	Block Title: Choose a title for your block.


	Journal: Select the journal(s) from which you wish to display the latest posts. If you have many journals, you can also search for the one you want to use.


	Items to show: Decide how many posts you want to display.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.





Note

If you have multiple journals, you can display recent posts from all of them.









          

      

      

    

  

    
      
          
            
  
6.5. Profil

The artefact blocks in this tab allow you to include information that you provided in the Profil into your portfolio. If you want to make changes to the text or the images, you will have to go to Content -> Profile.

Furthermore, you can also put certain blocks onto your Mahara profile page that only exist for that particular page:


	My Friends


	My Groups


	My Pages


	Mon mur





6.5.1. Information de contact

[image: Add contact information]
Ajoute un bloc sur la page avec les informations de contact.


Note

Only display as much information as you wish anybody to see. Especially when you make your pages available to the public, i.e. everybody on the internet, or all logged-in users, decide carefully whether you want to display your street address and / or phone number.




[image: Configure the block Contact Information]
Configure the contact information block




	Block Title: Choose a title for your block.


	Email Address Decide whether to display one of your email addresses that Mahara knows.


	Fields to show: Decide which fields shall appear on the page. Put a checkmark in front of each one that you want to show. Displayed are only the ones for which you provided content.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.







6.5.2. My Friends

[image: Add the friends block]
Ajoute un bloc qui affiche la liste de vos contacts avec leur nom et l’image de leur profil. Ce bloc est placé par défaut sur votre page du profil.

Vous n’avez qu’à placer ce bloc sur votre page du profil. Il n’y a pas d’autre configuration possible pour ce bloc.




6.5.3. My Groups

[image: Add the groups block]
Ajoute un bloc qui affiche sur la page de votre profil la liste de groupes auxquels vous appartenez. Ce bloc est placé par défaut sur votre page du profil.

Vous n’avez qu’à placer ce bloc sur votre page du profil. Il n’y a pas d’autre configuration possible pour ce bloc.




6.5.4. My Pages

[image: Add the pages block]
Ajoute un bloc sur la page de votre profil qui affiche toutes les pages que vous avez créées. Ce bloc est placé par défaut sur votre page du profil. Vous devriez toujours laisser ce bloc sur la page de votre profil, car c’est la manière la plus facile pour les autres utilisateurs d’accéder aux pages que vous auriez publiées.

Vous n’avez qu’à placer ce bloc sur votre page du profil. Il n’y a pas d’autre configuration possible pour ce bloc.


Note

When a user views your profile page, he only sees the pages to which he has access. That also means that you see all your pages while others may see none or just a few.






6.5.5. Information du profil

[image: Add profile fields]
Ajoute un bloc qui affiche les rubriques de votre profil sur la page.


Note

Only display as much information as you wish anybody to see. Especially when you make your pages available to the public, i.e. everybody on the internet, or all logged-in users, decide carefully whether you want to display your street address and / or phone number.




[image: Configure the block Profile information]
Configure the profile information block




	Block Title: Choose a title for your block.


	Fields to show: Decide which fields shall appear on the page. Put a checkmark in front of each one that you want to show. Displayed are only the ones for which you provided content.


	Profile Picture: Choose to display one of your profile pictures or none.


	Email Address Decide whether to display one of your email addresses that Mahara knows.


	Introduction Text: If you do not want to display the introduction text from your profile, you can write another one just for this page here. However, it will be lost when you delete this block.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.







6.5.6. Mon mur

[image: Add the wall block]
Ajoute un bloc sur la page du profil qui affiche le contenu du mur. Ce bloc est affiché par défaut sur la page du profil.

Vous n’avez qu’à placer ce bloc sur votre page du profil. Il n’y a pas d’autre configuration possible pour ce bloc.







          

      

      

    

  

    
      
          
            
  
6.6. Curriculum vitae

Sur n’importe quelle page de votre portfolio, vous pouvez décider d’afficher l’entier de votre curriculum vitae ou seulement quelques-unes de ses rubriques. Si vous optez pour la deuxième possibilité, vous avez plus de contrôle sur l’arrangement des informations.


6.6.1. Afficher l’entier du curriculum vitae

[image: Add your entire résumé to your page]
Ajoute un bloc contenant l’ensemble des rubriques de votre curriculum vitae.


[image: Configure the block Your Entire Résumé]
Configure the full résumé block




	Block Title: Choose a title for your block.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.







6.6.2. Afficher une rubrique du curriculum vitae

[image: Add one résumé field to your page]
Ajoute un bloc sur la page qui ne contient qu’une seule rubrique du curriculum vitae.


[image: Configure the block Your Entire Résumé]
Configure the One Résumé Field block




	Block Title: The title of the résumé field you want to display is chosen automatically unless you provide a different one.


	Rubrique à afficher : Sélectionnez la rubrique de votre curriculum vitae que vous désirez afficher ici. Vous ne pouvez sélectionner qu’une seule rubrique à la fois.


	Vous pouvez vous rendre directement dans la section curriculum vitae de votre profil, au moyen de cette fenêtre surgissante, afin de compléter votre CV.


	Cliquez sur le bouton Enregistrer pour valider vos modifications ou cliquez sur le bouton Annuler pour laisser le bloc dans son état initial. Le bouton Retirer, en bas de la page, n’apparaît que lorsque vous placez le bloc sur votre page sans y avoir encore sélectionné de fichiers à afficher.





Note

Normalement, seules les rubriques du CV pour lesquelles vous avez entré de l’information apparaissent dans cette liste. Toutefois, si vous avez entré de l’information dans les rubriques « compétences » ou « objectifs » de votre CV, toutes les rubriques seront listées, même si elles sont vides.









          

      

      

    

  

    
      
          
            
  
6.7. Les blocs et les différentes catégories de pages dans Mahara

Certains blocs n’existent que dans certains contextes de pages. Par exemple, le mur ne peut être placé que sur la page de profil alors que la boîte de texte peut être sur n’importe quelle page. Il y a un certain nombre de contextes de pages qui peuvent avoir différents blocs :


	page de portfolio


	page de groupe


	page d’institution


	page de site


	page de profil


	page du tableau de bord




La liste suivante montre dans quels contextes chaque bloc, et par conséquent chaque production, peut être utilisé. Elle montre aussi quel bloc peut être copié. L’idée originale de cette liste vient du travail qu’avait fait Synergy Learning pour Mahara 1.3.

External content













	Bloc

	Utilisateur

	Groupe

	Institution

	Site

	Tableau de bord

	Profil

	Page d’accueil du groupe
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Flux externe
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Google Apps




	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]






Files, images and video
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	Tableau de bord
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File(s) to Download
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A Folder




	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]



	
[image: html]

Du code HTML
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Image Gallery
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Embedded Media




	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]






General
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Creative Commons License
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Text Box




	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]

	[image: check]



	
[image: plans]

Your Plans
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Recent Forum Posts
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Group Info
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My Inbox
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Journals
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Afficher l’intégralité d’un journal
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Afficher un article d’un journal
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Afficher les articles récents




	[image: check]

	
	
	
	[image: check]

	[image: check]

	





Profile













	Bloc

	Utilisateur

	Groupe

	Institution

	Site

	Tableau de bord

	Profil

	Page d’accueil du groupe





	
[image: contactinfo]

Information de contact
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Résumé
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Afficher l’entier du curriculum vitae
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Afficher une rubrique du curriculum vitae




	[image: check]

	
	
	
	[image: check]

	[image: check]

	









          

      

      

    

  

    
      
          
            
  
7. Préférences



	7.1. Préférences du compte
	7.1.1. Nouveau mot de passe

	7.1.2. Modifier le nom d’utilisateur

	7.1.3. Préférences du compte

	7.1.4. Supprimer le compte





	7.2. Notifications

	7.3. Boîte de réception

	7.4. Institution membership









          

      

      

    

  

    
      
          
            
  
7.1. Préférences du compte

Les préférences du compte utilisateur sont accessibles via la page Préférences. Le lien pour accéder à la page se trouve en haut à droite de la fenêtre, à côté de la Boîte de réception et du lien Déconnexion.


7.1.1. Nouveau mot de passe

You can change your Mahara password on the Settings page:


	Entrez le mot de passe actuel


	Enter your preferred new password in the New Password and Confirm password box.


	Faites d’autres modifications des préférences si vous le désirez.


	Cliquez sur le bouton Enregistrer




Your password must have a minimum of six characters. It must contain at least one number, and at least two letters. Passwords are case sensitive and must be different from your username.


[image: Change password]
Modifier votre mot de passe




Note

If you do not see the New password box, you cannot change your password in Mahara. Your login and password are managed elsewhere. This is the case if your institution has set up single sign-on to other applications for example. If you want to change your password, please contact your institution administrator. He will be able to tell you where you can change your password.






7.1.2. Modifier le nom d’utilisateur

Vous avez besoin d’un nom d’utilisateur pour vous connecter à Mahara. Si votre accès n’est ni géré par un système d’accès unique interplateforme (single-sign on ou SSO) ou ni par une autre méthode d’accès, vous devriez voir cette rubrique. Vous pouvez alors modifier votre nom d’utilisateur en tout temps.


Note

Les noms d’utilisateur comprennent entre 3 et 30 caractères et ne peuvent contenir que des lettres, des chiffres ou des symboles communs à l’exception des espaces.




[image: Change username]
Modifier votre nom d’utilisateur






7.1.3. Préférences du compte

The general account options are visible to all users no matter whether they can change their usernames and passwords or not.


[image: General account options]
Afficher et modifier vos préférences générales de votre compte




	Friends control: Choose whether other users may add you to their friends list. If you are added to a friends list, the owner of that list is added to your list. When you remove someone from your friends list you are also removed from their list.


	HTML editor: An HTML editor is available for use on some sections of the site. This is known as a “What you see is what you get” (WYSIWYG) editor. This allows you to apply formatting to your text like in a word processor. If the editor is turned off you can only enter plain text. If you do not have this option, the site admin may have disabled it.


	Email: Use this setting to stop Mahara from sending you emails. It is advised that you generally regulate what is sent via email and what is not in the notifications.


	Message from other users: Use this setting to choose who you wish to receive messages from. Use the notifications area to decide how you will receive these messages. Note: These restrictions will not apply to users with the “administrator” or “staff”.


	Language: If your Mahara instance is offered in multiple languages, you can choose in which one you want to navigate the site. The menu items and the contextual help appear in the language you have chosen. However, the content does not.


	Afficher des boutons d’ajout/suppression de colonnes lors de la modification des pages : Vous pouvez afficher les boutons Ajouter et Supprimer dans l’éditeur de pages afin de modifier rapidement le nombre de colonnes figurant sur votre page. Voir aussi : modifier présentation <edit_layout>`


	Enable multiple journals: By default, you have one journal. If you would like to keep more than one journal, choose this option.


	Maximum tags in cloud: Decide how many tags you wish to display in your personal tag cloud.


	Show information about Mahara on the homepage: You choose this option if you want to display the quick links on your dashboard.


	Mobile upload token: Enter a token, e.g. a word, her and on your Android phone or iPhone to enable uploads. Your token changes automatically after each upload. See Mahara mobile for more information on using Mahara with a mobile device.


	Click the Save button whe you have finished making your changes.





Avertissement

If you disable your email address, you cannot reset your password as that requires a sending of an email to your address.






7.1.4. Supprimer le compte

If your Mahara site allows self-registration, you can delete your own account by clicking on the Delete account link on the top of the settings page.


Avertissement

Faites attention en choisissant cette commande, car toutes vos productions et vos pages du portfolio seront supprimées également, sans moyen d’être restaurées par la suite. Toutes vos informations seront irrémédiablement supprimées du serveur. Vous pouvez préalablement faire une sauvegarde de toutes vos informations (à l’exclusion de celles contenues dans les groupes) en exportant votre portfolio.









          

      

      

    

  

    
      
          
            
  
7.2. Notifications

Mahara envoie des notifications pour un certain nombre de raisons ou d’activités. Il s’agit de :


	Messages système : il s’agit de messages générés par la plateforme Mahara ou envoyés par l’un des administrateurs du site ; par exemple, une confirmation de la création de votre compte d’utilisateur.


	Messages des autres utilisateurs : concerne des messages envoyés à vous par d’autres utilisateurs de la plateforme.


	Liste de suivi : concerne les notifications d’activités sur les productions, les pages ou les journaux que vous surveillez.


	Nouvel accès à une page : vous recevez une telle notification lorsque qu’on vous donné l’accès à une page non publique. Vous recevez aussi un tel message si un groupe auquel vous appartenez se voit donné l’accès à une page non publique. Vous ne recevez pas de notification si la page est accessible publiquement ou à disposition de tous les membres authentifiés.


	Messages des institutions : concerne des messages générés automatiquement par le système, par ex. un message de confirmation de l’acceptation dans une institution, la suppression à venir d’une institution, la confirmation de votre demande de faire partie d’une institution.


	Messages des groupes : concerne les messages automatiquement générés par le système, par ex. les demandes d’utilisateurs pour rejoindre un groupe.


	Feedback: notification of any feedback or comments received on any pages, artefacts or journal posts.


	Nouveaux messages des forums : notifications des nouveaux messages placés dans les forums auxquels vous vous êtes abonnés.


	Contact us: messages to administrators that are sent via the Contactu us form.


	Contenu discutable : messages d’alerte aux administrateurs, envoyés par des utilisateurs qui désirent signaler du contenu non conforme à la charte d’utilisation de la plateforme, ou contraire aux règles légales ou morales.


	Repeat virus upload: messages to adminsitrators about users who repeatedly upload virus-infected files. Virus checking must be turned on.


	Fichiers acceptés après nettoyage antivirus : messages envoyés aux administrateurs après que le système antivirus ait nettoyé puis relâché un document corrompu par un virus.




You may select how you receive notifications for each activity type. To do so, go to Settings -> Notifications.
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Notifications




	Sélectionnez la manière de vous faire notifier chaque type d’activité. Mahara vous propose quatre méthodes de notification :


	Email: your primary email address will receive an email each time the activity occurs.


	Email digest: your primary email address will receive an email each day with a list of the activities of the last 24 hours. Typically, this email is sent at around 6 p.m., but this can be changed.


	Inbox: your notifications area will display a list of activity notifications received.


	None: This is only available to administrators for notifications that are only intended for administrators. They can opt to not receive any notifications for certain types.









Note

Seul un administrateur avec un accès au serveur web peut modifier l’heure à laquelle le courrier quotidien de synthèse est envoyé. Ceci est configuré grâce à la variable $emaildigest dans le fichier htdocs/notification/emaildigest/lib.php.




Note

Si vous choisissez la méthode d’envoi Courriel ou Résumé par courriel, toutes les activités seront aussi enregistrées dans votre Boîte de réception. Elles seront marquées automatiquement comme lues. Ces notifications sont automatiquement supprimées de votre boîte de réception après 60 jours.






7.3. Boîte de réception

Vous pouvez afficher les messages et notifications reçus pour votre compte, dans votre Boîte de réception, à laquelle vous accédez à l’aide du lien en haut et droite de votre fenêtre Mahara, à côté de Préférences et Déconnexion.


[image: You inbox]
Votre boîte de réception




	Type d’activité : Vous pouvez filtrer les notifications reçues par type d’activités afin de n’afficher qu’une partie de ces notifications.


	Objet : Correspond au titre de la notification ou du message reçu. Il s’agit d’un lien qui vous permet d’un clic d’afficher son contenu.


	Date : Indique la date à laquelle la notification a été reçue.


	Lues : Vous pouvez sélectionner toutes ou certaines notifications sur cette page que vous souhaitez marquer comme lues.


	Cliquez sur le bouton Marquer comme lu pour marquer comme lu les notifications que vous aurez préalablement sélectionnées. Les notifications qui ont été envoyées par messagerie électronique sont automatiquement marquées comme lues. Les notifications lues sont alors suivies d’un point vert.


	Supprimer : Sélectionnez sur la page une ou plusieurs notifications que vous désirez supprimer.


	Cliquez sur le bouton Supprimer pour supprimer définitivement les notifications que vous avez préalablement sélectionnées.


	Naviguer dans l’ensemble des notifications reçues à l’aide de la barre de navigation en bas de la page.


	You can delete all notifications at once. That will delete every notification no matter whether you see them on the screen or not. They cannot be retrieved again. Only when you had sent messages to your email will you still be able to view them if you have not deleted them there as well.








          

      

      

    

  

    
      
          
            
  
7.4. Institution membership

You can see in which institution(s) you are a member when you go to Settings -> Institution membership. You may be able to leave your current institution and join other institutions if they allow self-registration. If you cannot leave your institution, you must ask your institution administrator to remove you.


Note

Leaving an institution does not mean that your account will be deleted. You keep your content and portfolio pages.
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	Click on Settings -> Institution Membership to view your institution membership.


	Memberships: Here you see to which institution(s) you belong. Click on the Leave institution button to remove yourself from the institution. If you do not see this button next to an institution, you cannot remove yourself but must ask an institution administrator to do so.


	Requests: If you have already requested membership in an institution, it will be listed here. You must wait for an institution administrator to approve your request. If you wish to cancel a request, click the Cancel request button.


	Request membership of an institution: Choose the institution from the drop-down menu that you wish to join.


	You can provide an ID if you have one for this institution, but that is optional.


	Click the Send request button, and the institution administrator is notified of your request and will dea with it.








          

      

      

    

  

    
      
          
            
  
8. Administration du site

L’administration d’un site Mahara est réservée aux administrateurs du site qui ont tous les privilèges. Les administrateurs des institutions ont moins de privilèges que les administrateurs du site. Un autre chapitre leur est consacré, plus loin dans ce manuel.
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8.1. Vue d’ensemble


8.1.1. Navigation

As site administrator you have an additional navigation item, Site Administration. When you click on it, your navigation changes completely to give you quick acess to all the areas for the administration of Mahara.


[image: Top level navigation for site admin]
Top level navigation for a site admin once inside « Site Administration »



When you click on one of the items, a second-level navigation opens up with the sub items. You also see the sub items on the main page of the site administration.


[image: Site admin overview page]
Site admin overview page






8.1.2. Enregistrer votre site Mahara

You can choose to register your Mahara site with mahara.org [http://mahara.org], and help us to build up a picture of the Mahara installations around the world and to get a picture by how many users Mahara is used.


[image: Register your Mahara site]
Enregistrer votre site Mahara



Vous pouvez afficher les données qui seront envoyées à notre serveur. En envoyant des mises à jour de ce données de manière hebdomadaire nous permet de tenir nos statistiques à jour. Toutes les informations récoltées restent confidentielles. Nous ne pouvons connaître entre autre que la version de Mahara que vous utilisez; le nombre de fois que les différents blocs sont utilisés sur les pages des portfolios; et le nombre de vos utilisateurs; etc.




8.1.3. Informations sur le site

Les Informations sur le site vous affiche une synthèse concerncant :


	Comment votre site est utilisé.


	Quand votre site a été installé pour la première fois.


	La taille de votre base de données


	How much sitea data has been accumulated.


	La version de Mahara que vous utilisez.


	Indique si votre cron fonctionne ou pas
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Informations sur le site



Si vous avez des problèmes avec votre installation Mahara et que vous souhaitez demander de l’aide à la communauté Mahara sur les forums <http://mahara.org/group/view.php?id=1>`_, cette information ainsi que le numéro de version du Mahara que vous utilisez sont indispensable pour vous aider. De plus, connaître la version de votre Mahara vous permet de savoir si vous possédez la dernière mise à jour comprenant des corrections de bogues ainsi que des amélioration dans la sécurité de la plateforme.


Note

Le script cron est très important pour le bon fonctionnement de Mahara. Des tâches vitales sont effectuées régulièrement par Mahara, à travers ce script. Vous pouvez trouver plus d’information sur la manière de configurer cron dans le wiki [https://wiki.mahara.org/index.php/System_Administrator%27s_Guide/Cron_Job].






8.1.4. Statistiques du site

Vous pouvez demander à Mahara d’afficher des statistiques sur l’usage des ressources par les utilisateurs.


8.1.4.1. Informations sur tout le site

Les informations sur tout le site comprennent :


	La date d’installation de votre site


	Number of registerered users (« Users »), i.e. everybody who has an account


	Le nombre d’utilisateurs actifs, soit tous les utilisateurs qui se sont connectés au moins une fois pour effectuer une tâche sur votre plateforme.


	Le nombre de groupes total et le nombre moyen de groupes auxquels appartient un utilisateur


	Le nombre de pages total et le nombre moyen de pages par utilisateur


	La taille de la base de donnée


	L’occupation du disque


	La version de Mahara


	Les informations sur le cron





[image: Overview of the site]
Overview of the site






8.1.4.2. Utilisateurs

Dans l’onglet Utilisateurs de statistiques du site, vous accéder aux informations sur


	les valeurs moyennes concernant un utilisateur



	le nombre moyen d’amis par utilisateur ainsi que le nom de la personne ayant le plus d’amis


	le nombre moyen de pages par utilisateur ainsi que le nom de l’auteur ayant créé le plus de pages


	le pourcentage moyen du quota d’espace disque utilisé avec le nom de l’utilisateur ayant le plus utilisé d’espace disque.









	les statistiques journalières sur les utilisateurs, incluant le nombre d’utilisateurs qui se sont connectés, ont été créés, et existent au total pour jour donné


	Appartenance aux institutions avec le nombre de membres pour chaque institution, listé de l’institution la plus peuplée à celle qui l’est le moins





[image: Statistics about users]
Statistics about users






8.1.4.3. Groupes

Dans l’onglet Groupes des statistiques du site, on trouve les informations sur


	le nombre de groupes en fonction du type de groupe



	groupe cours


	groupe standard









	le nombre de groupe par type d’accès



	controlled membership group


	invite group


	open membership group


	request membership group









	La liste des groupes en fonction de leur taille, du groupe le plus peuplé à celui qui l’est le moins



	nombre de membres


	nombre de pages


	nombre de forums


	nombres de messages dans les forums












[image: Statistics about groups]
Statistics about groups






8.1.4.4. Pages

L’onglet Pages de la page de statistiques du site comprend les informations suivantes



	les blocs les plus utilisés sur les pages des portfolios


	a graphique montrant la distribution de l’utilisation dans les pages de profil, de groupe et du portfolio


	les pages les plus vues, triées dans un ordre décroissant avec un lien vers chacune d’entre-elles et un lien vers chacun de leur auteur.








[image: Statistics about pages]
Statistics about pages








8.1.5. Fermer le site

Vous pouvez vouloir bloquer l’accès du site à vos utilisateurs, à l’exception des administrateurs, pour pouvoir effectuer des travaux de maintenance. Notamment lorsque vous désirez préparer votre serveur pour une sauvegarde ou une mise à jour de la base de données. A ce moment seuls les administrateurs pourront se connecter à votre Mahara jusqu’à ce que, soit vous débloquiez l’accès ou que la mise à jour de la base de donnée soit terminée.







          

      

      

    

  

    
      
          
            
  
8.2. Configurer le site

Dans Configurer le site vous pouvez:


	régler ici des préférences globales pour votre site Mahara


	modifier les pages du site


	spécifier l’affichage de certains éléments de menus


	autoriser la mise en réseau avec Moodle


	créer et partager des pages


	téléverser des fichiers





8.2.1. Réglages du site

Dans Réglages du site vous pouvez définir des préférences globales qui s’appliqueront par défaut à l’ensemble du site


Note

One or more fields in may be disabled if overridden by a setting in your config.php file.



Lorsque vous avez défini un ou plusieurs paramètres, cliquez sur le bouton Modifier les préférences du site en bas de la page.


8.2.1.1. Réglages site


[image: Site settings]
Réglages site




	Nom du site : Donnez un nom à votre site Mahara. Ce nom s’affiche dans certaines places su système, par exemple dans la barre de titre du navigateur web et dans les courriels envoyés aux utilisateurs. Faites attention à ce que ce nom ne soit pas trop long.


	Langue : Fixe la langue de l’interface a utiliser par défaut dans le site. Si vous avez installé plusieurs paquets de langue, vous verrez apparaître un menu déroulant listant toutes ces langues. Dans le cas contraire, la langue utilisée en standard, English, est affichée.


	Pays : Le pays sélectionné depuis la liste déroulante est le pays par défaut qui sera affiché à chaque fois qu’un pays doit être sélectionné, par exemple dans les informations de contact.


	Theme: Mahara comes with a number of themes that you can use. Choose one from the drop-down menu to make it the default theme for your site. If you have institutions set up, they can choose their own theme.


	Show homepage information: If enabled, information about Mahara and how it is used is displayed on the Mahara homepage for logged-out and the dashboard for logged-in users. Logged-in users can disable this. See also Quick links.


	Send weekly updates?: If checked, your site send weekly updates to mahara.org [http://mahara.org] with some statistics about your site. See also Register your Mahara site.





Note

Vous pouvez en tout temps installer des paquets de langue supplémentaires. Sur Mahara.org vous trouverez la liste complète des paquets disponibles [http://langpacks.mahara.org/] ainsi que des `informations complémentaires sur les paquets de langue <https://wiki.mahara.org/index.php/Language_Packs`_ sur le wiki.






8.2.1.2. Réglages utilisateurs
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Réglages utilisateurs




	Users can choose page themes: If this setting is enabled, users can select a theme for their portfolio page. The page is displayed with this theme to other users. Thus, an institution or site theme can be overwritten.


	Afficher les avatars distants : Si cette option est sélectionnée, l’image par défaut dans le profil de l’utilisateur est retrouvée, si elle existe, sur le site Gravatar [http://www.gravatar.com] (voir avatars distants pour plus d’info). Les utilisateurs doivent bien entendu avoir un compte créé sur Gravatar.


	Users can hide real names: If checked, users who have set a display name may choose to be searchable only by their display name, and will not be found in searches for their real name. In the site administration section of the site, users are always searchable by their real names. An administrator (site and institution) always sees the display name, first and last name and username.


	Search usernames: If checked, usernames can be searched on as part of « Search Users » on the dashboard and via Find friends.


	Anonymous comments: If checked, logged-out users / users without a login can leave comments on public pages or pages they can access via secret URL.







8.2.1.3. Options de recherche

Mahara est installé avec un plug-in qui vous permet de rechercher de l’information sur les utilisateurs et les pages. Si vous installez un autre plug-in de recherche, vous devez alors le sélectionnez dans ce menu déroulant.


[image: Search settings]
Options de recherche




Note

Le plug-in de recherche interne, peut être configuré dans Administration extensions.






8.2.1.4. Réglages groupes

Mahara n’a réellement de sens que s’il est utilisé pour favoriser les travail collaboratif, en groupe. Quelques réglages à ce sujet sont disponibles ici.
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Réglages groupes




	Who can create groups: You decide whether administrators, administrators and staff or everyone can create groups. The default setting is the most permissive « everyone » because Mahara is user-centered and gives the individual users a great deal of control over what they want to do. If you choose to limit the group creation to administrators (and staff), these need to be contacted to set up groups. There is no internal group request system.


	Who can create public groups: Choose whether everyone or only administrators can create public groups. These are groups for which you do not need to be a member of the group or even have a login to Mahara to view the group homepage, member listing and discussion forums.


	Allow group categories: If checked, administrators can create categories for users to assign to their groups. These categories can be used to filter groups in My groups and Find groups.







8.2.1.5. Réglages institution(s)

Vous pouvez créer plusieurs institutions dans Mahara est séparer les utilisateurs dans ces dernières afin de simplifier les procédures administratives, comme la gestion des utilisateurs et les permissions qui leur sont octroyées, et avoir un thème différent dans chaque institution.


[image: Institution settings]
Réglages institution(s)




	Utilisateurs dans plusieurs institutions : Si cette option est sélectionnée, les membres peuvent appartenir à plusieurs institutions en même temps.


	Avantage : Une personne qui appartient à deux ou plusieurs institutions n’a besoin que d’un seul compte.


	Désavantage : Si une ou plusieurs institutions utilisent des thèmes différents, l’utilisateur ne peut pas choisir lequel il désire utiliser pour lui.






	Durée avant notification d’échéance de l’institution : Si une durée est donnée ici, une notification sera envoyée aux administrateurs du site de de l’institution au préalable, avant la fermeture de l’institution. Cette durée peut être fixée en jours, semaines, mois ou années ou le paramètre « Indéterminé » peut être utilisé. Si ce dernier est choisi, les institutions sont créées pour une durée infinie par défaut.


	Suspendre automatiquement les institutions dont la date d’échéance est passée : Si cette option est sélectionnée, Mahara va pouvoir suspendre automatiquement les institutions à la fin de la période d’utilisation indiquée lors de leur création. Cela signifie qu’une fois l’institution suspendue,  les utilisateurs ne pourront plus se connecter à travers cette institution à moins qu’un administrateur ne renouvelle le bail.







8.2.1.6. Options comptes utilisateurs
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Options comptes utilisateurs




	Durée de session : Pour des raisons de sécurité, après une certaine durée d’inactivité, un utilisateur est automatiquement déconnecté. Cette rubrique spécifie cette durée en minutes. La valeur par défaut et de 1440 minutes (24 heures).


	Durée par défaut d’un compte : Si une valeur est indiquée ici, le compte d’un utilisateur expire automatiquement après que le délai ait été dépassé. Ce délai court depuis la date de création du compte. Une fois le compte expiré, l’utilisateur ne peut plus se connecter. Cette durée peut être exprimée en jours, semaines, mois ou année. La valeur « Indéterminé » permet de créer des comptes qui n’ont pas de délai d’expiration.


	Délai d’inactivité du compte par défaut : Si une valeur est entrée, le système considérera comme « inactif » un utilisateur qui ne s’est plus connecté pendant un temps plus long que cette valeur. L’utilisateur ne pourra plus alors se connecter à nouveau sur le système. Cette valeur peut être exprimée en jours, semaines, mois ou années. La valeur « Indéterminé » prévient les utilisateurs de n’être jamais être considérés comme inactifs. Cette valeur est celle utilisée par défaut.


	Délai d’avertissement pour expiration/suspension : Si une valeur est entrée, elle est utilisée par le système pour déterminer la date à laquelle il enverra une alerte aux utilisateurs dont le compte va bientôt être considéré comme inactif. Cette valeur peut être exprimée en en jours, semaines, mois ou années. La valeur « Indéterminé » prévient les utilisateurs de n’être jamais être considérés comme inactifs. Cette valeur est celle utilisée par défaut.







8.2.1.7. Réglages sécurité
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Réglages sécurité




	Virus checking: If you want all files uploaded by users to be run through a ClamAV virus scan, you should select the virus checking option. You have to have ClamAV [http://www.clamav.net/] installed on your server.


	Path to clam: The filesystem path to clamscan or clamdscan for virus checking. It is assumed that a failure of ClamAV to run will mean that a file should be treated as a virus, and a quarantine directory will be automatically set up by your Mahara installation.


	Antispam : Il existe trois niveaux de blocage disponibles pour les formulaires accessibles par le public, comme le formulaire de demande de contact ou celui d’enregistrement. Un envoi depuis un formulaire n’est jamais rejeté sans avertissement. Normalement, un message d’erreur est affiché à l’utilisateur lui demandant d’essayer d’envoyer son formulaire à nouveau, si le précédent essai a été considéré comme un spam. Les trois niveaux de blocage sont :


	Aucun : Aucun contrôle n’est effectué lors de l’envoi des formulaires.


	Basic : Quelques tests de base sont effectués. Les formulaires avec ces adresses de courriel mal formées ou des corps de messages contenant un trop grand nombre d’URLs sont rejetés.


	Advanced: Performs additional checks to determine whether email addresses are real or contain URLs that are blacklisted. This requires an internet connection.






	Activer le service Spamhaus : Si cette option est activée, les URLs sont vérifiées par le système Spamhaus DNSBL. Le projet Spamhaus [http://www.spamhaus.org] produit et maintient gratuitement une liste noire des sites indésirables, à l’usage des sites à faible traffic. Une version professionnelle du service (payante) existe, mais elle n’est pas supportée dans Mahara. Veuillez vous référer aux conditions d’utilisation de Spamhaus DNSBL [http://www.spamhaus.org/organization/dnsblusage.html] avant d’activer cette option.


	Activer le service SURBL URL : Si cette option est activée, les URLs seront vérifiées par le système SURBL DNSBL. SURBL [http://www.surbl.org] produit et maintient gratuitement une liste noire des sites indésirables, à l’usage des organisations de moins de 1’000 utilisateurs. Un service professionnel est aussi disponible, mais n’est pas supporté dans Mahara. Veuillez vous référer aux conditions d’utilisation de SURBL [http://www.surbl.org/usage-policy.html] avant d’activer cette option.


	Empêcher l’utilisation de ressources externes par l’utilisateur dans le code HTML : Activer cette option enlève juste la possibilité aux utilisateurs d’inclure dans leurs messages de forums ou dans les blocs HTML des images ou des ressources externes au serveur. Il est recommandé d’utiliser cette option, car elle permet de neutraliser certains styles d’attaques virales relativement bien faites (phishing). Consultez la documentation sur HTML purifier [http://htmlpurifier.org/live/configdoc/plain.html#URI.DisableExternalResources] pour plus de détails.







8.2.1.8. Réglages proxy
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Réglages proxy




	Proxy address: If your site uses a proxy server to access the internet, specify the proxies in hostname:portnumber notation.


	Modèle d’authentification du proxy : Sélectionnez le modèle d’authentification approprié pour le proxy (aucun ou simple [NCSA]), si nécessaire.


	Justificatif d’identité du proxy : Entrez ici les informations nécessaires pour que votre proxy puisse authentifier votre serveur web, dans le format nom_utilisateur:mot_de_passe







8.2.1.9. Réglages de la messagerie
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Réglages de la messagerie




	Hôte SMTP : Si vous désirez forcer Mahara à utiliser un serveur SMTP spécifique en lieu et place de celui du système, entrez ici le nom du ce serveur, par exemple smtp.exemple.qc.ca. Il est possible de spécifier plus d’un serveur, en séparant chacun d’eux par un point-virgule, par exemple smtp1.exemple.be;smtp2.exemple.be`, mais gardez à l’esprit que les informations d’authentification et les autres paramètres (numéro de port, etc) seront les mêmes pour tous les serveurs. Il n’est pas possible d’avoir des informations de connexion différentes pour chacun des serveurs SMTP de la liste. Cette fonctionnalité est donc particulièrement intéressante si vous utilisez différents serveurs qui ne nécessitent pas d’authentification ou si votre liste comprend différentes adresses accédant au même système SMTP qui peut donc être accédé avec les mêmes paramètres.


	Port SMTP : Si votre serveur SMTP utilise un port différent du standard (25), vous pouvez spécifier ici le numéro de port à utiliser. Quand les communications sont cryptées, le port par défaut est le 465 pour SSL et 587 pour TLS. Vous ne devez spécifier un port que si vous devez utiliser un autre port que ceux proposés par défaut. Contrôlez ces paramètres avec votre prestataire de service de messagerie électronique.


	Utilisateur : Si votre serveur SMTP nécessite une authentification, entrez ici le nom d’utilisateur adéquat.


	Mot de passe : Si votre serveur SMTP nécessite une authentification, entrez ici le mot de passe en lien avec l’utilisateur entré précédemment.


	SMTP mode sécurisé : Si votre serveur SMTP permet de crypter les communications, cliquez sur cette option pour l’activer.


	System mail address: This email address is the address that emails are sent from when using Mahara.







8.2.1.10. Réglages généraux
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	Autoriser les pages publiques : Si cette option est activée, les utilisateurs peuvent créer des pages dans leur portfolio est les rendre accessibles à des personnes extérieures au système.


	Allow public profiles: If checked, users can set their profile pages to be accessible to the public rather than only to logged-in users. However, only logged-in users can use interactive features such as the wall.


	Enable portfolio search: If checked, the « Search My Portfolio » side block is displayed in the Content and Portfolio sections of the site.


	Enable tag cloud: If checked, users see a side block in the Content and Portfolio sections of the site with a list of their most frequently used tags.


	Nombre maximal de mots-clés dans le nuage : Entrez ici le nombre de mots-clés à afficher dans le nuage par défaut. Les utilisateurs peuvent modifier cette valeur en se rendant dans leur page de Préférences.


	Small page headers: If checked, a small header and site navigation block are displayed when viewing or editing portfolio page instead of the standard header. This option gives more space for the portfolio content itself.


	Afficher les utilisateurs connectés : Si cette option est sélectionnée, un bloc avec la liste des utilisateurs connectés durant les 10 dernières minutes apparaît en marge de la page courante (consulter aussi la rubrique tableau de bord).


	Acceptation de la charte d’utilisation : Si cette option est sélectionnée, vous forcez les utilisateurs à accepter la « Charte d’utilisation », ou les « Conditions générales », avant de terminer leur enregistrement. Vous pouvez éditer la page des « Conditions générales » avant d’activer cette option. Vous la trouvez sous Modifier les pages du site.


	Permettre le dépôt par téléphone mobile : Si cette option est sélectionnée, les utilisateurs peuvent indiquer dans leurs Préférences un jeton d’authentification pour permettre la connexion et l’envoi de documents de leurs outils mobiles dans Mahara.









8.2.2. Modifier les pages du site

Vous pouvez modifier ici le contenu de certaines pages du site et des pages qui sont en lien en bas de l’écran :


	À propos


	Accueil (Tableau de bord)


	Accueil des non-connectés


	Protection des données


	Conditions d’utilisation





Note

Due to a quirk in the system, you do not see the text on the first page that is displayed in the editor - generally « Home (Dashboard) ». In order to edit it, you need to click on a different page in the dro-down menu first and then select it again to see its text.



Toutes les pages contiennent un texte par défaut que vous pouvez modifier entièrement. Chaque page doit contenir un texte. Vous pouvez utiliser l’éditeur graphique pour modifier vos pages et appliquer des styles sur le contenu.
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Modifier les pages du site




	Choose the page you want to edit from the drop-down menu.


	Change the text in the editor window. Some text is obligatory.


	Cliquez sur le bouton Enregistrer.







8.2.3. Menus

Il y a deux menus modifiables dans Mahara :


	Liens et ressources


	Menus de bas de page





8.2.3.1. Liens et ressources

The Links and resources menu appears to all users on most pages. You can decide which links or files are available to everybody - also those without a login - and which ones only logged-in users shall see.


[image: Add external links to the menu]
Add external links to the Links and resources menu




	Choisissez dans le menu Liens et ressources le type de ressources que vous voulez modifier: celles destinées au public ou celles destinées aux utilisateurs connectés.


	Choisissez le type Lien externe.


	Donnez un nom, qui sera affiché dans le menu, pour votre lien


	Indiquez l’adresse URL du lien en incluant http:// or https://.


	Cliquez sur le bouton Ajouter




Vous pouvez aussi ajouter à votre menu des documents que vous avez téléversés dans la zone de dépôt du site.


[image: Add site file to menu]
Add a site file to the Links and resources menu




	Choisissez dans le menu Liens et ressources le type de ressources que vous voulez modifier: celles destinées au public ou celles destinées aux utilisateurs connectés.


	Sélectionnez le type Fichier du site


	Donner un nom, qui sera affiché dans le menu, à votre fichier.


	Choose the file you want to display.


	Cliquez sur le bouton Ajouter




Une fois que vous avez ajoutés des liens et des fichiers dans votre menu, vous pouvez les modifier ou les supprimer.


Note

Si vous souhaitez lister vos ressources dans un ordre déterminé, veuillez créer ces dernières dans cet ordre. Il n’est pas possible de modifier à postériori l’ordre des ressources mises dans le menu.




[image: Links and Resources menu]
Links and resources menu result






8.2.3.2. Menu de bas de page

Vous pouvez contrôler ici les pages du site qui s’afficheront en bas de chaque page.


[image: Footer menu]
Menu de bas de page




	Select which pages shall appear in the footer on each page. You can change the text of « Terms and Conditions », « Privacy Statement » and « About » in Edit site pages.


	Click the Save changes button to save your selection.









8.2.4. Gestion du réseau

Les fonctionnalités de mise en réseau permettent de faire communiquer différentes sites Mahara ou Moodle [http://moodle.org]. Si les fonctions du réseau sont activées, vous pouvez les utiliser pour configurer un système d’authentification unique (single sign-on – SSO) pour les utilisateurs utilisants à la fois Moodle et Mahara ou pour des ceux qui doivent travailler dans plusieurs instances de Mahara.

Depuis Moodle 2.0, vous pouvez paramètrer Moodle pour permettre aux utilisateurs d’enregistrer dans Mahara un certain nombre de contenu créé dans Moodle. Ceci se fait grâce à la fonction portfolio [http://docs.moodle.org/22/en/Portfolio].
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Networking overview



Pour pouvoir bénéficier des fonctions de réseau pour toutes les institution, vous devez :


	Choose « Yes » from the drop-down menu at Enable networking.


	Decide whether you wish to auto-register all hosts or not. If you choose « Yes », an institution is created for any host that connects allowing these users to log in to your Mahara site. We recommend you leave the default « No » because that gives you more control over which Moodle or Mahara instances can connect.


	Cliquez sur le bouton Enregistrer.




En fonction du site sur lequel vous désirez vous connecter, vous devez donner d’autres informations sur cette page, en particulier le dossier source ou WWW root et la Clé publique du serveur distant.


Voir aussi

The comprehensive guide for setting up a Mahoodle [https://wiki.mahara.org/index.php?title=System_Administrator%27s_Guide/Moodle%2F%2FMahara_Integration] can be consulted when connecting Mahara and Moodle.






8.2.5. Pages

Vous créez et copiez des pages du sites comme n’importe quelle autres pages du portfolio. Toutefois tous les blocs ne sont pas disponibles sur une page de site. Consultez :ref:`blocs dans différents contextes <blocks_in_context>`pour plus d’informations.
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Site pages



Une fois que vous avez créé une page de site, vous pouvez la partager avec d’autres utilisateurs de Mahara.




8.2.6. Partager

Vous pouvez partager les pages du site comme n’importe quelles autres pages.


Voir aussi

Refer to the share options for regular portfolio pages for further information.
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Share site pages






8.2.7. Fichiers

Vous pouvez téléverser ici les fichiers que vous désirez inclure dans le menu liens et ressources ou dans les pages du site. Vous pouvez ajouter des fichiers qui se trouvent dans le dossier principal dans le menu des ressources disponibles aux utilisateurs connectés. Les fichiers que vous placez dans le dossier public peuvent être utilisés dans le menu accessible aux utilisateurs externes ou qui ne ne sont pas connectés.


Voir aussi

The process of uploading and managing files is very similar to files in your personal files area.
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8.3. Utilisateurs

Avec le menu Utilisateurs de l’administration du site vous pouvez :


	rechercher des utilisateurs


	modifier les préfrences pour un ou plusieurs utilisateurs


	suspendre et supprimer des utilisateurs


	promouvoir des utilisateurs au rôle d’administrateurs ou de membres du personnel


	contrôler les préférences de notification


	add users manually or by CSV





8.3.1. Recherche d’utilisateurs

Les administrateurs du site peuvent rechercher n’importe quel utilisateur sur l’entier du site. Vous pouvez rechercher un utilisateur en connaissant son


	prénom


	nom de famille


	nom d’affichage


	nom d’utilisateur


	adresse de courrier électronique





Note

The display name is not shown in the user list. That will be a feature of Mahara 1.5.
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Vous pouvez combiner la recherche avec des critères pour filtrer les résultats. Attention en utilisant trop de critères vous risquez de n’obtenir aucun résultat.


	Vous pouvez activer le filtre sur le nom ou le prénom, en cliquant sur les lettres en haut de l’écran.


	Type the name, display name, username or email address or any partial thereof you wish to search for in the search field.


	Sélectionnez depuis le menu déroulant l’institution dans laquelle vous désirez effectuer votre recherche d’utilisateurs.


	Click the Search button [image: search] to start searching.


	Affichez vos résultats. Le tri est effectué par défaut de manière alphabétique ascendante sur le prénom. Toutefois, vous pouvez changer le critère de tri, en cliquant sur la rubrique de votre choix; et l’ordre de tri en cliquant sur le triangle, qui permet passer du tri ascendant au tri descendant.


	Cliquez sur le nom d’utilisateur de l’utilisateur pour lequel vous désirez effectuer des actions supplémentaires.







8.3.2. Réglages compte

On the Account settings page of a user in the administration area, you can perform a number of actions to manage the user’s account. However, you cannot change personal information about this user, e.g. name, email, from this page. This can only be done in the Content area of the user’s account.


[image: User account settings]
Overview of the user account settings page




	Se connecter sour le nom


	Modifier les réglages globaux du compte


	Modifier les paramètres des institution


	Suspend and / or delete this user





8.3.2.1. Se connecter comme

As administrator you have the power to log in as any user that you manage ans masquerade as them. If you are a site administrator, you can log in as any user while institution administrators can only perform this action for any user who is in their user management.

It is a great function for troubleshooting a user account because you see everything as the user would without having to know his password.


Avertissement

This function can easily be misused by an administrator because he can make changes to the user’s portfolio and artefacts as well as participate in groups while logged in as that user. Users should be aware of this function and that an administrator can enter their account.

La charte d’utilisation des sites utilisant Mahara devrait clairement faire état de cette possibilité, ainsi que de fixer le cadre éthique et légal de l’usage de cette fonction. Il est indispensable que le travail collaboratif ainsi que celui qui est effectué dans le cadre d’un portfolio personnel soient protégés. Il importe que, dans l’idéal, seul un nombre limité de personnes aient les droits d’administration au sein d’une institution et qu’une seule personne soit administrateur du site.




[image: Login as another user]
Login as another user




	Click on the user’s name to go to his profile page.


	Cliquez sur le bouton Se connecter comme pour devenir cet utilisateur. Vous verrez alors une barre rouge en haut de l’écran qui vous signalera pendant toute la durée de cette connexion sous une autre identité que vous n’êtes plus entrain de naviguer à travers le site comme administrateur mais comme la personne dont vous avez pris l’identité.





[image: Stop masquerading as another user]
Stop masquerading as another user



When you want to return to your own account again, click the Become [your user name] again link at the top of the browser window.




8.3.2.2. Modifier les réglages globaux du compte

Vous pouvez afficher et régler un grand nombre de préférences globales dans le compte d’un utilisateur.


Note

En fonction de la méthode d’authentification associée à cet utilisateur, vous ne pourrez peut-être pas modifier tous les paramètres décrits ci-dessous.
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Site account settings of a user




	Changer le nom d’utilisateur : Donnez un nom d’utilisateur différent à ce compte. Cette rubrique n’est pas modifiable si le compte est géré par une méthode d’authentification externe à Mahara.


	Réinitialiser mot de passe : Donnez un nouveau mot de passe pour ce compte. Cette rubrique n’est pas modifiable si le compte est géré par une méthode d’authentification externe à Mahara.


	Force password change on next login: Check this box if the user shall change his password when he next logs in. This field is not available when the account is managed by an external authentication method.


	Site staff: Check this box if the user shall be able to create controlled groups.


	Site administrator: Check this box if the user shall have full administrative rights.


	Email: Check this box to disable the sending of emails for this user. If email is disabled notifications and messages can only be viewed in the internal inbox. Depending on your setup, if emails are bounced back to the sender, then email may be automatically disabled.


	Échéance du compte : Sélectionnez une date à laquelle le compte de cet utilisateur sera automatiquement désactivé. La valeur par défaut et que le compte ne sera jamais désactivé. La date du jour est toujours affichée comme option possible, mais en grisé, donc inactive. Vous pouvez décider d’une date automatique ou d’une durée maximale pour tous les comptes sur votre plateforme en vous rendant dans la zone des Options comptes utilisateurs de la page des Réglages du site.


	File quota (MB): Change the storage allowance for a user’s personal files area. The default value as set in the files configuration in the plugin administration.


	Méthode d’authentification : Sélectionnez la méthode d’authentification que cet utilisateur doit utiliser pour se connecter à votre Mahara. Les méthodes d’authentification peuvent être configurées dans la page d”administration de l’institution. En fonction de la méthode d’authentification que vous choisissez, vous devez indiquer un nom d’utilisateur distant pour faire le lien entre ce compte d’utilisateur et celui de la plateforme d’authentification.


	Cliquez sur le bouton Enregistrer lorsque vous avez terminé de modifier les paramètres globaux.





Avertissement

Quand l’adresse de courriel est désactivée, les utilisateurs ne peuvent pas demander de réinitialiser leur mot de passe, puisqu’aucun message électronique ne peut leur être envoyé.






8.3.2.3. Modifier les paramètres des institution

Vous pouvez afficher et modifier les paramètres pour chaque institution à laquelle appartient l’utilisateur. En fonction des paramètres fixés dans les paramètres des institutions du site, un utilisateur peut appartenir à plus d’une institution.
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Institution settings for a user




	Choose the institution from the drop-down menu to which you want to add this user.


	Click the Add User to Institution button to make him a member of this institution.


	Échéance de l’affiliation : Si vous le désirez, vous pouvez fixer une date après laquelle l’utilisateur perdra automatiquement son appartenance à l’institution. Si vous choisissez l’option Non spécifié, l’utilisateur restera à jamais membre de l’institution.


	Idendifiant ID : Vous pouvez donner un numéro d’identifiant à cet utilisateur dans le cadre de cette institution. Cette rubrique ne peut pas être modifiée par l’utilisateur.


	Institution staff: Check this box if you want to give this user staff rights in this institution. This will allow him to create controlled groups.


	Institution admin: Check this box if you want to make this user an administrator of this institution. This will allow him to manage all users in this institution.


	Cliquez sur le bouton Mettre à jour pour enregistrer vos modifications.


	Click the Remove user from this institution button to disassociate this user from this institution. The user will stay in any other institution that he may be in, and he will also keep his account no matter whether he is in an institution or not.







8.3.2.4. Suspendre l’utilisateur

Les motifs qui poussent un administrateur à suspendre un utilisateurs comprennent généralement le non respect des conditions d’utilisations des services ou des comportements inadaptés pendant leur usages. Les utilisateurs suspendus ne peuvent plus se connecter à vos services mais leurs données restent toutefois stockées sur le serveur.


[image: Suspend a user]
Suspend a user




	Il est recommander, dans un soucis de transparence, d’indiquer à l’utilisateur suspendu la raison de cette suspension. Cela permet aussi, lorsqu’il y a plusieurs administrateurs qui gèrent la plateforme, de se rappeler de ces raisons lorsqu’il convient de retraiter le cas de l’utilisateur en question.


	Click the Suspend User button to disallow the user from logging in.




When a user has been suspended, the following suspension message appears on his account settings stating the reason for the suspension and giving the administrators the possibility to unsuspend the user by clicking on the Unsuspend User button.


[image: Suspension notice]
Suspension notice on the account settings page



When the user tries to log in, he will see the suspension message and the reason. He can then contact an administrator via the « Contact Us » form for further action.


[image: Suspended user tries to log in]
Suspended user tries to log in and gets suspension message






8.3.2.5. Supprimer l´utilisateur

A user can delete his own account from Mahara on his account settings if he is allowed to by his institution. Site administrators can also delete user accounts at any time.
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Delete a user account



Click the Delete User button to delete this user account permanently. This action cannot be undone. As this is a permanent action, you see a confirmation pop-up window that you will have to acknowledge.


Avertissement

When you delete a user account, all personal data is wiped from the system. This applies to everything that is in a user’s Content and Portfolio area. This action cannot be undone. His contributions in groups, e.g. forum messages, uploaded files and pages created in a group, are still available, but are made anonymous by changing the name the « Deleted user » as author where an author is shown.




Note

If an account was deleted by accident - either by a user or by an administrator - swift action may result in recovery of (most of) the data from a backup file. This requires access to the server’s backups and the backend of Mahara. More information is available on the wiki [https://wiki.mahara.org/index.php/System_Administrator%27s_Guide/Restoring_a_deleted_user].








8.3.3. Suspended users

A list of all suspended users is available in the sub-menu Suspended users. Here you can unsuspend or delete them.
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List of all suspended users




	Sélectionnez le(s) utilisateur(s) pour le ou lesquels vous désirez effectuer la même action.


	Click the Unsuspend Users button to reinstate the accounts for all selected users.


	Click the Delete Users button to delete all selected users in bulk. This account cannot be undone and all personal information of these users will be deleted (see delete user).







8.3.4. Staff users

Sur cette page vous pouvez décider quels utilisateurs vous désirez intégrer dans le personnel du site. Les membres potentiels – en fait tous les utilisateurs du site – sont listés dans la colonne de gauche, alors que celle de droite vous informe des utilisateurs qui appartiennent déjà au groupe du personnel du site.
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Give site staff rights




	From the list under Potential Staff, select the users you wish to make site staff. You can also select multiple users at once using Ctrl and Shift click.


	If you have too many users on your site and you cannot see / find the user you want, you can search for him in the Search box.


	Add the potential staff members to the right-hand side - Current Staff - by clicking on the right-arrow button [image: right-arrow].


	If you want to remove an existing or accidentally added site staff member, you can remove him from the list on the right-hand side by clicking on him.


	Then click on the left-arrow button [image: left-arrow], and he is removed from the list.


	Lorsque vous avez sélectionné tous les membres que vous désirez placer dans la liste des membres du personnel du site, cliquez sur le bouton Envoyer.







8.3.5. Administrateurs du site

Site administrators have powerful rights on Mahara. They can make far-reaching changes and also log in as other users. Be careful whom you give these rights. One site administrator is needed for each site. The total number of site administrators should be kept small.


[image: Site admins]
Give site admin rights




	From the list under Potential Admins, select the users you wish to make site administrators. You can also select multiple users at once using Ctrl and Shift click.


	If you have too many users on your site and you cannot see / find the user you want, you can search for him in the Search box.


	Ajoutez les utilisateurs sélectionnés dans la colonne de droite – Administrateurs actuels – en cliquant sur le bouton Flèche droite [image: right-arrow].


	If you want to remove an existing or accidentally added site admin, you can remove him from the list on the right-hand side by clicking on him.


	Then click on the left-arrow button [image: left-arrow], and he is removed from the list.


	Lorsque vous avez sélectionné tous les utilisateurs auxquels vous voulez accorder les droits d’administration du site, cliquez sur le bouton Envoyer







8.3.6. Notifications administrateurs

The Admin Notifications page lists all users with institution and site admin access on your site. It shows their selected notification preferences for all admin notifications. There should be at least one administrator receiving each type of message generated. Admin notifications are:


	Demandes de contact


	Contenu discutable


	Dépôts répétés de fichiers infectés


	Fichiers acceptés après nettoyage anti-virus





[image: Admin notifications]
Overview of the admin notification types






8.3.7. Ajouter un utilisateur

Vous pouvez ajouter des utilisateurs à votre site en créer leur compte manuellement, l’un après l’autre.
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Add a user manually




	Cliquez sur le bouton radio Créer un nouvel utilisateur si vous désirez créer un nouveau compte vide pour un utilisateur. Indiquez alors le prénom, le nom de famille et l’adresse courriel de ce dernier.


	Click the Upload Leap2A File radio button if you want to import a user from another Mahara instance or a system that supports the Leap2A standard. Such a user could have exported his portfolio from another Mahara instance.


	Give the new user a username. The username may contain letters, numbers and most common symbols. It must be from 3 to 236 characters in length. Spaces are not allowed.


	Choose a password for the account. The password must be at least six characters long and contain at least one digit and two letters.


	Check this box if the new user should have site staff rights.


	Check this box if the new user should have site administrator rights.


	Review the allocated file quota. You may change it here for this user.


	Choose the institution of which the user should be a member.


	Check this box if the new user should have institution administrator rights in the chosen institution.


	Click the Create User account button.


	The user will receive an email with his account details.





Note

You can change the settings under Basic Details on the account settings page.






8.3.8. Add users by CSV

You can use this function to upload new users in bulk via a csv file (comma-separated file). The first row of your csv file should specify the format of your data. For example, it should look like this:

username,password,email,firstname,lastname,studentid

This row must include:


	nom d’utilisateur


	mot de passe


	courriel


	prénom


	nom




Le fichier doit aussi comprendre les informations des rubriques qui ont été marquées comme rubriques obligatoires pour tous les utilisateurs, et aussi pour toutes les rubriques qui sont marquées comme rubriques verrouillées pour l’institution dans laquelle vous ajoutez les utilisateurs.

All other fields are optional. This is the full list of fields that you can add in addition to your csv file upload


	studentid - Numéro de l’étudiant qui est affiché dans le profil


	preferredname - Nom d’affichage


	introduction -  Le texte d’introduction affiché dans le profil


	officialwebsite - Site web officiel ou professionnel


	personalwebsite - Site web personnel


	blogaddress - URL vers les blogue de l’utilisateur


	address - Adresse postale de l’utilisateur


	town - Localité


	city - Ville


	country - Pays


	homenumber - Numéro de téléphone privé


	businessnumber - Numéro de téléphone professionel


	mobilenumber - Numéro de téléphone mobile


	faxnumber - Numéro de fax


	icqnumber - Nom d’utilisateur sur ICQ


	msnnumber - Nom d’utilisateur sur MSN


	aimscreenname - Nom d’utilisateur sur AIM


	yahoochat - Nom d’utilisateur sur Yahoo Chat


	skypeusername - Identifiant Skype


	jabberusername - Identifiant Jabber


	occupation - Emploi actuel, affichée dans le profil


	industry - Secteur d’activité, affiché dans le profil


	maildisabled - Option pour stopper l’envoi de courriel par Mahara


	remoteuser - Nom d’utilisateur sur la plateforme d’authentificaiton distante




When you have created your csv file, you are ready to upload it.


[image: Add users by csv file]
Add users by csv file




	Institution: Choose the institution and the authentication method for the user accounts that you upload. You cannot change the authentication method later on in bulk, but only for each user individually.


	CVS file: You must upload a csv file by clicking on the Browse button and then selecting it from the files on your computer.


	Force password change? If you select this option, users need to change their password before they can log in for the first time.


	Email users about their account? If you select this option, users will receive an email with their account information. This is in particular good for internal accounts. For user accounts that are managed for example by SSO with Moodle or through LDAP, you do not have to select this option because the users should already know their login information.


	Click the Add Users by CSV button to upload the users.





Note

En fonction de la configuration de votre serveur ou de la taille de votre installation, vous ne pourrez peut-être pas créer/mettre à jour tous les utilisateurs à la fois. Si cela devait vous arriver, travaillez alors avec plusieurs fichiers CSV contenant au maximum 100 lignes de création ou modifications de comptes utilisateur.









          

      

      

    

  

    
      
          
            
  
8.4. Groupes

Dans le menu Groupes de l”Adminsitration vous pouvez :


	ajouter des administrateurs aux groupes


	supprimer des groupes


	modifier les catégories des groupes





8.4.1. Vue d’ensemble

The first page you see when you click on the Groups menu is the Administer Groups page.


	Rechercher un groupe par son nom ou sa catégorie.


	Group name. The table is sorted alphabetically according to the group names.


	Number of group members


	Number of group administrators


	Group type


	Group category


	Visibility


	Cliquez sur le bouton Configurer [image: manage] pour ajouter ou supprimer des administrateurs au groupe.


	Cliquez sur le bouton Supprimer [image: delete] pour supprimer un groupe.







8.4.2. Add / remove group administrators

You can add to or remove administrators from a group by clicking on the Manage button [image: manage] on the Administer Groups page.


[image: Add or remove group administrators]
Add or remove group administrators




	From the list under Potential Admins, select the group members you wish to make group administrators. You can also select multiple users at once using Ctrl and Shift click.


	If you have too many users on your site and you cannot see / find the user you want, you can search for him in the Search box.


	Add the potential administrator to the right-hand side - Current Admins - by clicking on the right-arrow button [image: right-arrow].


	If you want to remove an existing or accidentally added group administrator, you can remove him from the list on the right-hand side by clicking on him.


	Then click on the left-arrow button [image: left-arrow], and he is removed from the list.


	Quand vous avez effectué toutes les actions de gestion des administrateurs que vous désiriez, cliquez sur le bouton Enregistrer.







8.4.3. Gérer les groupements

Les groupements vous aident à filtrer vos groupes de manière plus efficace dans les pages Mes groupes ou Recherche de groupes. Un administrateur de groupe peut aussi assigner un groupe à un groupement si l’option des groupements a été activée par l’administrateur du site.

Site administrators can manage group categories on the Group Categories page under Groups in the Site Administration.


[image: Manage group categories]
Gérer les groupements




	Enable group categories for the entire site by placing a checkmark into the check box and then click the Submit button.


	Le nom des différents groupements existants est affiché.


	Vous créez un nouveau groupement en entrant son nom dans la rubrique et en cliquant sur le bouton Ajouter.


	Pour modifier le nom d’un groupement, cliquez sur le bouton Modifier [image: edit]; modifiez son nom; et cliquez ensuite sur le bouton Mettre à jour. Si vous désirez revenir en arrière en annulant votre modification, cliquez sur le bouton Annuler.


	Click on the Delete button [image: delete] to permanently delete a group.





Note

Group categories are not hierarchical and are available to everybody on the site. Any user who can create groups can assign a group category.









          

      

      

    

  

    
      
          
            
  
8.5. Institutions

You can use Mahara as multi-tenanted instance. That means that several different institutions can share one Mahara installation. That allows users from these different institutions to:


	partager des pages avec tous les autres utilisateurs


	placer des commentaires sur les pages des autres utilisateurs


	travailler collaborativement dans de groupes à travers plusieurs institutions




In the Site Administration you can set up as many institutions as you wish. Institution administrators can only administer their users but not make any changes to site settings.

You can also use the possibility to set up institutions if you wish different parts of your organisation to use different themes, have different default settings and / or authentication methods.


8.5.1. Vue d’ensemble

On Site Administration -> Institutions -> Institutions you see an overview of all institutions that exist on this Mahara installation.


[image: Overview page for institutions]
Overview page for institutions




	Search for a particular institution by its name.


	Institutions are listed alphabetically


	Number of registered members in this institution


	Maximum allowed members in this institution


	Number of institution members with staff rights


	Number of institution members with institution administrator rights


	Cliquez sur le bouton Modifier [image: edit] pour modifier les paramètres de l’institution.


	Cliquez sur le bouton Supprimer [image: delete] pour supprimer une institution. Vous ne pouvez supprimer une institution que lorsqu’elle ne contient plus de membres.


	Click the Add Institution button when you want to create a new institution.


	Click the Edit Members button when you want to add or remove members from an institution.


	Click the Edit Staff button when you want to add or revoke staff rights for an institution member.


	Click the Edit Admins button when you want to add or revoke institution administrator rights for an institution member.





Note

The institution « No Institution » is the default « institution ». It cannot be deleted as it is the standard Mahara site.






8.5.2. Ajouter une nouvelle institution

When you want to add an institution by clicking on the Add button on Site Administration -> Institutions -> Institutions, you need to fill in basic information. You can change all the settings except the institution name later on.


[image: Add a new institution]
Add a new institution




	Nom institution : La saisie de cette rubrique est obligatoire. Le nom doit être unique dans la base de donnée de Mahara. Il doit être formé d’un seul mot et ne contenir aucun symbole ou chiffre.


	Nom affiché de l’institution : La saisie de cette rubrique est obligatoire. Elle contient le nom de l’institution qui sera utilisé dans l’ensemble de site lors de l’affichage d’information sur cette institution.


	Institution expiry date: Set the expiry date for this institution by selecting the year, month and day from the drop-down menus when taking the checkmark off the « Not specified » check box. Institutions do not expire by default.


	If you specify an expiry date for this institution, two things will happen. Once the warning time for institution expiry has been reached, site and institution administrators will be emailed about this institution’s impending expiry.


	Si l’option Suspendre automatiquement les institutions dont la date d’échéance est passée est activée, lorsque la date d’échéance est passée, l’institution sera automatiquement suspendue, et les utilisateurs membres de cette seule institution ne pourront plus se connecter.


	The warning time for institution expiry and the auto-suspend expired institutions options can be found in the institution settings under Site Administration -> Configure Site -> Site options.






	Registration allowed? Check this box when you want to allow self-registration of new users. As institution administrators, you will be asked to confirm that users can join your institution. If you decline, their account will be associated with « No Institution ». When you do not allow registration, nobody can ask to join your institution or leave it without your permission.


	Default membership period: You can set how long users will remain associated with this institution per default. Choose an option from the drop-down menu and then specify the number of days, weeks, months or years. After this length of time, the users will be removed from the institution. Users will receive an email before this time reminding them that they will be removed soon. However, that does not mean that they will lose their account. They will still have that.


	Theme: Use the drop-down menu to choose the theme that you wish to use for this institution. All pages in that institution will receive that theme. When users from other institutions view portfolio pages that were created in this institution, they will see this institution’s theme on these pages. If Site Default is selected, when a site administrator changes the site default theme, the theme for the users of this institution will change, too. You can install more themes in the theme folder on the server. Check out the community-contributed themes [https://wiki.mahara.org/index.php/Themes/Contributed_themes].


	Nombre maximum de comptes utilisateurs autorisés : Vous spécifiez ici le nombre de membres maximum que peut compter une l’institution. Si vous laissez cette rubrique vide, cela signifie à Mahara que le nombre n’est pas limité. Une des raisons d’un accès non réussi par SSO pour un nouvel utilisateur qui se connecterai pour la première fois, peut venir du fait que l’institution ait déjà atteint son maxima en terme d’utilisateurs. Aucune erreur n’est pourtant envoyée mis à part que la connexion est impossible. Veillez à vérifiez cette valeur en cas de problème de connexion avec des utilisateurs.


	Locked fields: Put a check mark into each check box for which users are not allowed to change the value. Disabled check boxes are for profile fields which are locked in the institution settings for « No Institution ». These profile fields are locked at the site level and cannot be unlocked for individual institutions.


	Cliquez sur le bouton Envoyer pour enregistrer vos modifications.


	Cliquez sur le bouton Annuler pour quitter la page en remettant les paramètres dans leur état d’origine.





Note

Bloquer les rubriques du profil telles que celle du nom, du prénom et du nom d’affichage peut être bénéfique pour les institutions dans lesquelles on désire identifier les utilisateurs par leur vrai nom et prénom et que l’on ne désire pas qu’ils puissent créer des noms d’affichage.






8.5.3. Modifier une institution

Once you have created your institution, you can edit its settings or also suspend the institution. You will have to choose at least one authentication method for this institution so that user accounts can be created.


Note

Only site administrators can add, edit and delete authentication methods for an institution and suspend it.



Vous pouvez avoir autant de méthodes d’authentification pour une institution que vous le souhaitez. Les méthodes d’authentification sont utilisées par Mahara dans l’ordre dans lequel elle figure sur la page de réglages de l’institution. Sans méthode d’authentification, aucun utilisateur ne peut accéder à l’institution.

Before you can use the IMAP, LDAP, SAML or XMLRPC authentication methods, you must install their extensions:


	internal: user accounts are created by Mahara and the passwords and logins are kept in an internal database.


	IMAP: les utilisateurs sont authentifiés en par leur compte de messagerie sur un serveur IMAP. Ce plugin est pratiquement peu utilisé par la communauté Mahara et il ne fait pas l’objet d’un suivi attentif de l’équipe de développement.


	LDAP: user accounts are authenticated against an LDAP server.


	SAML : un Prestataire de service d’authentification SAML 2.0 qui contient les comptes de vos utilisateurs est nécessaire pour pouvoir utiliser cette méthode d’authentification avec Mahara.


	XMLRPC: This is the authentication method used for MNet to connect Mahara with Moodle or another Mahara.


	Aucun : Cette méthode ne devrait être utilisée que lors de phases de test de votre serveur Mahara. Avec cette méthode, il n’y a pas de contrôle. Tout le monde peut se connecter en créant un compte sans contrôle et accéder à cette institution.





Avertissement

Faites attention lorsque vous choisissez la méthode d’authentification Aucune. Cette méthode permet à quiconque de créer un compte et à se connecter sur votre site Mahara, sans contrôle. N’utilisez cette méthode d’authentification que lors des phases de test et n’oubliez pas de l’enlever lorsque vous passez votre site en phase de production.




8.5.3.1. Authentification par IMAP

Vous pouvez utiliser cette méthode d’authentification si vos utilisateurs sont déjà inscrits sur un serveur de messagerie de type IMAP.


[image: Set up IMAP authentication]
Set up IMAP authentication




	Nom de l’autorité : Saisissez un nom quelconque que vous désirez pour identifier cette autorité. Il est préférable que vous utilisez un nom court. Cette rubrique doit être saisie.


	Nom d’hôte ou adresse : Indiquez l’adresse URL ou le nom d’hôte. Cette rubrique doit être saisie


	Numéro de port : Spécifiez sur quel port le serveur IMAP fonctionne. La valeur par défaut est 143. Cette rubrique doit être saisie.


	Protocol: Selecte the IMAP protocol you are using by selecting it from the drop-down menu. This setting is required:


	IMAP


	IMAP / SSL


	IMAP / SSL (self-signed certificate)


	IMAP / TLS






	URL de changement de mot de passe : Si vos utilisateurs ne peuvent modifier leur mot de passe que de manière centralisée, veuillez indiquer ici l’URL de la page qui permet de faire cela.


	Cliquez sur le bouton Envoyer pour enregistrer vos modifications.


	Cliquez sur le bouton Annuler pour annuler l’opération.







8.5.3.2. Authentification par un serveur LDAP

Use this authentication method to authenticate again an LDAP server so that your users can log in with their usual login and password.
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Set up LDAP authentication




	Nom de l’autorité : Saisissez un nom quelconque que vous désirez pour identifier cette autorité. Il est préférable que vous utilisez un nom court. Cette rubrique doit être saisie.


	URL de l’hôte : Spécifiez l’adresse URL de l’hôte en utilisant la bonne forme (par exemple : ldap://ldap.example.com). Vous pouvez indiquez plus d’un serveur LDAP en séparant leur adresse par une ,. Cette rubrique doit être saisie.


	Contextes : Contient la liste de contextes dans lesquels les utilisateurs sont inscrits dans le serveur LDAP. Séparez les différents contextes par des , (par exemple : ``ou=users,o=org;ou=other,o=org`). Cette rubrique doit être saisie.


	Type d’utilisateur : Sélectionnez dans le menu déroulant le type d’utilisateur qui correspond à celui utilisé par votre serveur LDAP. Vous avez le choix entre :


	Novell Edirectory


	posixAccount (rfc2307)


	posixAccount (rfc2307 bis)


	sambaSamAccount (v. 3.0.7)


	MS Active Directory


	default






	User atrribute: Enter the attribute used to search for users. It is often cn. This field is required.


	Recherche dans les sous-contextes : Choisissez « Oui » si vous désirez que la recherche des utilisateurs se fasse aussi dans les sous-contextes de l’arbre du serveur LDAP. Cette rubrique doit être saisie.


	Non distinctif : Si vous désirez utiliser la fonction bind-user pour rechercher des utilisateurs, veuillez le spécifier ici. Quelque chose comme « cn=ldapuser,ou=public,o=org ». Laissez la rubrique vide pour une connexion anonyme.


	Mot de passe : Entrez le mot de passe pour le « nom distinctif ».


	Version LDAP : Sélectionnez la version de votre serveur LDAP depuis le menu déroulant. Cette information est requise.


	Cryptage TLS : Sélectionnez cette option si vous désirez utiliser la méthode de chiffrage des données.


	Mettre à jour les informations utilisateur lors de la connexion : Sélectionnez cette option si vous souhaitez que les informations du profil des utilisateurs soient mises à jour à chaque connexion avec les informations contenues sur le serveur LDAP. Cette option peut toutefois empêcher des utilisateurs d’autres sites Mahara de se connecter sur votre serveur.


	We auto-create users: Check this box to create user accounts on Mahara automatically when a user autheticates successfully but does not yet have an account.


	Rubrique LDAP pour le prénom : Entrez le nom de la rubrique qui contient le prénom de vos utilisateurs dans le LDAP.


	Rubrique LDAP pour le nom : Entrez le nom de la rubrique qui contient le nom de famille de vos utilisateurs dans le LDAP.


	Rubrique LDAP pour le courrier : Entre le nom de la rubrique qui contient l’adresse de courrier de vos utilisateurs dans le LDAP.


	Cliquez sur le bouton Envoyer pour enregistrer vos modifications.


	Cliquez sur le bouton Annuler pour annuler l’opération.







8.5.3.3. Authentification SAML

Sélectionnez cette méthode d’authentification si votre organisation travaille déjà avec un prestataire de service d’authentification SAML 2.0. Ceci fonctionne si votre prestataire vous permet une connexion sur plusieurs applications.
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	Attribut de l’institution (contient « … ») : Entrez l’attribut qui va être envoyé de prestataire du service d’identité (IdP) signifiant à quelle institution appartient l’utilisateur. Ceci est normalement en lien avec les attributs présent dans le LDAP (le service de connexion du IdP), par exemple eduPersonOrgDN. Cette rubrique est obligatoire.


	Institution value to check against attribute: Enter the value that will be checked against the institution attribute value as passed from the IdP. If the institution regex checkbox is selected, this value can be a regular expression that will be used to check against the institution attribute value. This field is required.


	Vérification partielle avec le nom court de l’institution : Sélectionnez cette option pour considérer la valeur entrée dans « Valeur de l’institution à contrôler avec l’attribut » comme une expression régulière.


	Attribut utilisateur : Entrez le nom de l’attribut qui sera envoyé par l’IdP et qui contient le nom d’utilisateur de l’utilisateur. Cette rubrique est obligatoire.


	Match username attribute to remote username: Check this box if you want to match the user attribute value to the remote username field assigned to a given user (not the real Mahara username).


	Mettre à jour les infos utilisateur lors de la connexion : Sélectionnez cette option si vous désirez mettre à jour le prénom, le nom et l’adresse courriel des utilisateurs à chque connexion et en fonction des informations envoyées par le IdP.


	We auto-create users: Check this box to create user accounts on Mahara automatically when a user autheticates successfully but does not yet have an account.


	Rubrique SSO pour le prénom : Entrez le nom de l’attribut qui sera envoyé par le IdP et qui contient le prénom de l’utilisateur.


	Rubrique SSO pour le nom : Entrez le nom de l’attribut qui sera envoyé par le IdP et qui contient le nom de l’utilisateur.


	Rubrique SSO pour l’adresse de courriel : Entrez le nom de l’attribut qui sera envoyé par le IdP et qui contient l’adresse de courriel de l’utilisateur.


	Cliquez sur le bouton Envoyer pour enregistrer vos modifications.


	Cliquez sur le bouton Annuler pour annuler l’opération.





Avertissement

This security issue only affects sites which make use of the SAML authentication plugin and have more than one SAML identity provider.

By default, SAML authentication instances have the « Match username attribute to Remote username » setting unchecked. This means that a user logging in using single sign-on will log in as the local Mahara user whose Mahara username matches their SAML username attribute.

In this configuration, someone with control over any SAML identity provider could gain control over any user account on that Mahara site by setting the username attribute appropriately. In other words, administrators of one institution could control users in other institutions.

To fix this, site administrators of multi-institution sites with SAML authentication in use should ensure that the « Match username attribute to Remote username » setting is enabled in each SAML-enabled institution, unless usernames are guaranteed to be unique across all SAML providers.






8.5.3.4. MNet / XMLRPC authentication

Use the XMLRPC authentication for connection a Mahara instance to a Moodle or other Mahara installation for sharing login information. With Moodle 2 that does not only mean that you can log in to Mahara via Moodle, but also that you can transfer certain activities into your Mahara portfolio from Moodle [http://docs.moodle.org/20/en/Portfolios].

A Moodle site can only be connected to Mahara once no matter how many institutions you have set up.


Note

Vous devez avoir activé le service réseau pour pouvoir bénéficier de ce type de méthode d’authentification.
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	Nom de l’autorité : Saisissez un nom quelconque que vous désirez pour identifier cette autorité. Il est préférable que vous utilisez un nom court. Cette rubrique doit être saisie.


	Racine WWW : Entrez l’adresse web de la racine de votre application distante, par exemple http://exemple.fr. Cette rubrique doit être renseignée.


	Site name: Enter the name to present to your users to identify the remote site. If you enable SSO, they may click on this name to start a session at the remote site. This fiel is required.


	Application : Choisissez le type d’application qui se trouve de l’autre côté. Vous avez le choix entre « Mahara » et « Moodle ».


	Port number: Enter the port number that the remote application is listening at. You probably will not need to change this unless you are connecting to a https service or your remote application is running on a non-standard port. This field is required.


	Parent authority: If you set a parent authority from the already existing authentication methods, users will be able to log in using that authority as well as MNet. For example, you could set up LDAP authentication and have that be the parent of this MNet authority. That means that users will be able to log in via Mahara’s in-built login form using their LDAP credentials as well as via MNet from their Moodle. You do not have to set a parent authority. If you do not, users using MNet will only be able to access Mahara via MNet, i.e. log in to Moodle or the other Mahara first.


	Message d’erreur d’authentification : Entrez ici un message à afficher lorsqu’un utilisateur essaie de se connecte avec un mauvais mot de passe ou un mauvais identifiant. Le message ne s’affiche que si vous n’avez pas indiqué d’autorité parente.


	Direction SSO : Sélectionnez la direction de l’authentification par SSO dans le menu déroulant :


	Connexion par SSO sur ce serveur par des utilisateurs distants : Sélectionnez cette option si vous désirez autoriser des utilisateurs d’un site distant à se connecter directement à votre site Mahara, sans avoir à entrer à nouveau leur nom d’utilisateur et leur mot de passe.


	Connexion des utilisateurs à d’autres applications par SSO à partir d’ici : Sélectionnez cette option si vous désirez que vos utilisateurs puissent, depuis Mahara, se connecter sur une autre plateforme sans avoir à y entrer à nouveau leur nom d’utilisateur et leur mot de passe.






	Mettre à jour les renseignements des utilisateurs lors de la connexion : Activez cette option pour mettre à jour dans votre Mahara les informations sur les utilisateurs, à chacune de leur connexion à partir du site distant . Par exemple, en venant de Moodle, les rubriques suivantes sont stockées dans Mahara :


	prénom (toujours)


	nom de famille (toujours)


	adresse de courriel (toujours)


	Images du profil


	description (correspond à la rubrique « introduction » du profil dans Mahara)


	ville


	pays


	langue


	préférences sur l’éditeur HTML






	We auto-create users: Check this box to create user accounts on Mahara automatically when a user autheticates successfully but does not yet have an account.


	Importation du contenu ici : Tous les services liés par le protocole SSO n’offrent pas forcément cette fonctionnalité. Mais si c’est le cas, comme avec Moodle 2.x, ceci permet aux utilisateurs de ce service d’envoyer des informations directement dans Mahara depuis le site distant. Cette option dépend l’activation de « Connexion par SSO sur ce serveur des utilisateurs distants » pour l’option « Direction SSO ». Il est aussi préférable d’avoir activé l’option « Création automatique des utilisateurs ici » pour que le transfert de contenu soit possible.


	Cliquez sur le bouton Envoyer pour enregistrer vos modifications.


	Cliquez sur le bouton Annuler pour annuler l’opération.





Voir aussi

Refer to the comprehensive guide about setting up Mahoodle [https://wiki.mahara.org/index.php/System_Administrator%27s_Guide/Moodle//Mahara_Integration], the combination of Mahara and Moodle, for step-by-step instructions on how to set everything up on the Moodle side and on Mahara. The guide explains the steps for both Moodle 1.9 and Moodle 2.x.






8.5.3.5. Ordre d’utilistion des méthodes d’authentification

If you have set up multiple authentication methods in one institution, you can decide on the order in which are checked.
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Ordre d’utilistion des méthodes d’authentification




	Utilisez la flèche vers le haut et la flèche vers le bas pour déplacer une méthode d’authentification d’une position vers le haut ou vers le bas de la liste.


	Pour supprimer une méthode d’authentification, cliquez sur le lien Supprimer [x].





Note

Vous ne pouvez pas supprimer une méthode d’authentification s’il existe encore des utilisateurs sur votre plateforme qui sont liés à cette méthode pour se connecter. Donc avant de pouvoir supprimer une méthode d’authentification, vous devez attribuer à tous les utilisateurs qui dépendent de cette dernière une autre méthode d’authentification.








8.5.4. Menbres

Under Institutions -> Members you can add and remove members from one institution in bulk. As site administrator, you can always add members to an institution. As institution administrator, you can only invite users to become members.

Vous pouvez filtrer les utilisateurs afin d’afficher moins de résultat sur la page afin de faciliter la suppression ou l’ajout de nouveaux membres dans votre institution.


	Utilisateurs ayant demandé leur affiliation à l’institution


	Utilisateurs n’ayant pas demandé de devenir membre d’une insitution


	Membres actuels de l’institution





8.5.4.1. Utilisateurs ayant demandé leur affiliation à l’institution

Si vous avez activez l’option de l’enregistrement automatique des nouveaux utilisateurs, ceux qui ne sont pas encore membres pourront demander leur affiliation.


Voir aussi

You can check your settings on self-registration:


	when you are an institution admin: Institution administration -> Manage institutions -> Settings -> Registration allowed?


	when you are a site admin: Site administration -> Institutions -> click the Edit button [image: edit] next to the institution you want to check -> Registration allowed?




Les utilisateurs peuvent demander à rejoindre une institution depuis la page des membres de l’institution.



Les administrateur de l’institution reçoivent alors une notification de la requête de l’utilisateur à rejoindre l’institution. Les administrateurs du site ne reçoivent que les demandes qui concernent l’institution « No institution ».


[image: Accept or decline institution membership request]
Deal with an institution membership request




	Utilisateurs à afficher : Sélectionnez Utilisateurs ayant demandé leur affiliation à l’institution.


	Institution : Sélectionnez dans le menu déroulant le nom de l’institution dans laquelle vous désirez ajouter des utilisateurs. Si vous n’êtes l’administrateur que d’une seule institution, son nom est affiché à la place du menu déroulant.


	Utilisateurs ayant demandé leur affiliation à l’institution : Sélectionnez les utilisateurs que vous désirez ajouter à l’institution.


	Recherche : Vous pouvez aussi rechercher des utilisateurs particuliers en utilisant la boîte de recherche, si la liste est trop longue.


	Ajoutez les utilisateurs en cliquant sur le bouton flèche droite [image: right-arrow].


	Utilisateurs à ajouter/rejeter : Si vous déplacez par accident des utilisateurs dans la liste des utilisateurs à ajouter/rejeter, vous pouvez les enlever de cette dernière en cliquant à nouveau sur leur nom.


	Puis cliquez sur le bouton flèche gauche [image: left-arrow] pour le retirer de la liste.


	Quand vous avez placé tous les utilisateurs que vous désirez dans la liste des utilisateurs à ajouter/rejeter, cliquez sur le bouton Ajouter membres.


	Alternativement vous pouvez décider de décliner leur demande à rejoindre l’institution en cliquant sur le bouton Rejeter la demande. Les utilisateurs en question recevront un message indiquant le fait que vous avez décliné leur demande.







8.5.4.2. Utilisateurs n’ayant pas demandé leur affiliation à l’institution

An admin can also take the initiative and invite users into an institution.


[image: Invite users to become institution members]
Invite users to become institution members




	Utilisateurs à afficher : Sélectionnez Utilisateurs n’ayant pas demandé leur affiliation à l’institution.


	Insitution : Sélectionnez dans le menu déroulant l’institution pour laquelle vous aimeriez inviter des utilisateurs à venir s’affilier.


	Non membres : Sélectionnez depuis cette liste les utilisateurs auxquels vous désirez envoyer une invitation à rejoindre l’institution.


	Recherche : Vous pouvez aussi rechercher des utilisateurs particuliers en utilisant la boîte de recherche, si la liste est trop longue.


	Ajoutez les utilisateurs à la liste Utilisateurs à inviter/ajouter, en cliquant sur le bouton flèche droite [image: right-arrow].


	Si vous mettez par accident une personne dans la liste des personnes à inviter, vous pouvez la retirer en cliquant sur son nom.


	Puis cliquez sur le bouton flèche gauche [image: left-arrow] pour le retirer de la liste.


	When you have all the members you wish to invite to the institution, click the Invite users button.


	The users receive a notification and can accept or decline the institution membership invitation.







8.5.4.3. Membres actuels de l’institution

Vous pouvez supprimez des utilisateurs d’une institution, par exemple lorsqu’ils ont quitté votre école ou votre université, mais que vous désirez toutefois les garder comme utilisateurs de votre Mahara; ou lorsqu’ils doivent juste passer d’une institution à une autre sur le même Mahara.


[image: Remove users from an institution]
Remove users from an institution




	Utilisateurs à afficher : Sélectionnez Membres actuels de l’institution.


	Institution : Sélectionnez dans le menu déroulant le nom de l’institution pour laquelle vous désirez afficher les membres. Si vous n’êtes l’administrateur que d’une seule institution, le menu est remplacé par le nom de l’institution que vous administrez.


	Membres actuels : Sélectionnez dans la liste les utilisateurs que vous souhaitez retirer de l’institution.


	Recherche : Vous pouvez aussi rechercher des utilisateurs particuliers en utilisant la boîte de recherche, si la liste est trop longue.


	Aoutez les utilisateur à la liste Utilisateurs à retirer en cliquant sur le bouton flèche droite [image: right-arrow].


	Si vous avez placé un utilisateur par accident dans la liste des utilisateurs à retirer de l’institution, vous pouvez le retirer de la liste en cliquant sur son nom.


	Puis cliquez sur le bouton flèche gauche [image: left-arrow] pour le retirer de la liste.


	Quand vous avez sélectionné tous les membres que vous désirez retirer de l’institution, cliquez sur le bouton Retirer utilisateurs.









8.5.5. Personnel de l’institution

You can give users staff rights in an institution in which they are members. The staff role will allow them to create course groups. This page allows you to do that in bulk for many users at once.


Voir aussi

You can also give staff rights on the user account settings page.




[image: Give users institution staff rights]
Give users institution staff rights.




	Institution : Sélectionnez dans le menu déroulant l’institution pour laquelle vous voulez promouvoir des membres comme personnel de l’institution.


	Institution Members: Select the institution members who shall get staff rights.


	Recherche : Vous pouvez aussi rechercher des utilisateurs particuliers en utilisant la boîte de recherche, si la liste est trop longue.


	Ajoutez les utilisateurs à la liste Personnel de l’institution en cliquant sur le bouton flèche droite [image: right-arrow].


	Si vous avez placé par erreur un membre de l’institution dans la la liste des membre à promouvoir en tant que personnel de l’institution, vous pouvez le supprimer de celle-ci en cliquant sur nom. Il retrouvera alors sa fonction de membre mais n’appartiendra plus au groupe du personnel de l’institution.


	Puis cliquez sur le bouton flèche gauche [image: left-arrow] pour le retirer de la liste.


	Lorsque vous avez sélectionné tous les membres dont vous voulez promouvoir le statut comme membre du personnel de l’institution, cliquez sur le bouton Envoyer.







8.5.6. Administrateurs de l’institution

Vous pouvez promouvoir un membre d’une institution au rôle d’administrateur de cette dernière. Les administrateurs d’une institution peuvent gérer les utilisateurs de celle-ci. Cette page vous permet d’effectuer ces tâches en masse, sur plusieurs utilisateurs à la fois.


Voir aussi

You can also give admin rights on the user account settings page.




[image: Give users institution admin rights]
Give users institution admin rights.




	Institution : Sélectionnez dans le menu déroulant l’institution pour laquelle vous aimeriez promouvoir des membres au rôle d’administrateur de l’institution.


	Institution Members: Select the institution members who shall get admin rights.


	Recherche : Vous pouvez aussi rechercher des utilisateurs particuliers en utilisant la boîte de recherche, si la liste est trop longue.


	Add the users to the list Current Admins by clicking on the right-arrow button [image: right-arrow].


	Si vous avez placé par accident un membre dans la liste des administrateurs actuels ou que vous voulez retirer les droit d’administration de l’institution à un administrateur, vous pouvez retirer le membre de la liste des administrateurs actuels en cliquant sur son nom. Le membre retrouvera alors son rôle initial et perdra ses droits d’administrateur de l’institution.


	Puis cliquez sur le bouton flèche gauche [image: left-arrow] pour le retirer de la liste.


	Lorsque vous avez sélectionné tous les membres que vous désiriez promouvoir comme administrateur de l’institution, cliquez sur le bouton Envoyer.







8.5.7. Pages de l’institution

Vous pouvez créer des pages pour votre institution. Bien que vous puissiez toujours, en tant qu’utilisateur régulier, créer des pages que d’autres utilisateurs pourraient copier dans leur propre portfolio, l’avantage des pages d’institution réside dans le fait qu’elles peuvent être automatiquement copiées dans le portfolio d’un nouvel utilisateur qui rejoindrait l’institution.


[image: Create institution pages]
Create institution pages




	When you are in Site administration -> Institutions -> Pages, click on the institution in the drop-down menu for which you want to create or edit institution pages.


	If you have a lot of institution pages, you can search for a particular one by searching for it. You can search in the title, description and tags or only in tags.


	Click on the Create Page button to start a new institution page.


	Click on the Copy Page button to start a new page from a copy of an already existing one. This does not have to be an institution page but can be any page that you are allowed to copy.


	Afficher une page d’institution que vous avez déjà créée.


	Click on the Edit button [image: edit] to change an existing institution page.


	click on the Delete button [image: delete] to delete an institution page.





Note

Creating and editing an institution page is very similar to creating and editing a portfolio page. Not all blocks are available when editing an instituion page in the page editor though due to the different context. Please refer to the overview of blocks for a list of all the blocks that you can use in an institution page.






8.5.8. Partager des pages de l’insitution

You can see a list of all institution pages from an institution under Site administration -> Institutions -> Share.


[image: Share institution pages]
Partager des pages de l’insitution




	Select the institution from the drop-down menu for which you want to see the institution pages.


	Pages : La liste des les pages d’institution pour cette institution est alors affichée ici.


	Page(s) partagée(s) : Affiche la liste des autorisations d’accès attribuées pour chaque page partagée.


	Click on the Edit Access button [image: edit_access] to change the permissions of who can view and copy a page.


	Cliquez sur le bouton URLs secrètes [image: edit] pour définir une ou plusieurs URLs secrète pour la page.




Sharing an instution page is very similar to sharing a portfolio page. The only difference is that you can allow new institution members to receive a copy of an institution page immediately upon joining the institution.


[image: Setting for copying an institution page for new institution members]
Setting for copying an institution page for new institution members




	When you clicked on the Edit Access button [image: edit_access] on the Share page for institution pages, click on the check box Allow copying under Advanced Options.


	Après avoir sélectionné cette option, la boîte à cocher Copier pour les nouveaux membres de l’institution apparait. Sélectionnez alors cette nouvelle option si vous désirez que tout nouveau membre de l’institution reçoive une copie de cette page dans son portfolio, au moment où il rejoindra l’institution pour la première fois.







8.5.9. Fichiers

The files area in an institution holds all files that are uploaded by institution administrators as institution files. The uploading process works as the one in the personal files.







          

      

      

    

  

    
      
          
            
  
8.6. Extentions

Extensions in Mahara serve to provide certain functionality in the system. Extensions can be installed at any point and also hidden.


8.6.1. Administration extensions

The Plugin administration lists all the plugins that are currently installed on your Mahara and provides a link to the plugin configuration settings where available.

Il n’y a pas de fonction de désinstallation des extension dans Mahara. Une extension peut être toujours accédée par tout utilisateur qui en connaît l’URL ou en a l’accès. Au lieu d’activer ou de désactiver une extension dans les préférences des utilisateurs, il suffit d’utiliser les liens Cacher et Montrer. Quand une extension de production (artefact) a été cachée, Mahara arrête d’afficher le bloc (blocktype) correspondant dans les pages des portfolios.

Si vous voulez supprimer définitivement une extension de Mahara, vous devez supprimer son code et toutes les informations contenues dans la base de données qui concerne cette extension. Attention à ce que vous faites. En effaçant des informations importante à Mahara vous prenez le risque à rendre votre plateforme inaccessible ou non opérationnelle.


Note

Les fonctionnalités de base de Mahara peuvent être désactivées une à une afin de les rendre non accessibles aux utilisateurs, en les cachant. Ceci peut être utile si vous utilisez Mahara conjointement avec d’autres outils qui offrent des fonctionnalités semblables à celles offertes par Mahara ou si vous souhaitez simplement ne pas offrir une fonctionnalité de Mahara à vos utilisateurs. Toutefois ce type de décision doit être mûrement réfléchi car cela signifie aussi que les utilisateurs auront de facto mois de diversité dans les productions qu’ils pourront utiliser dans leurs portfolios.



In the following, only the plugins that have additional settings are discuessed.


8.6.1.1. Type de plugin: File / internalmedia

Configure which file types users can embed into the Embedded Media block. If you disable a file type that has already been used in a block, it will not be rendered any more.

Mahara comes with Flowplayer [http://flowplayer.org/], a media player that can play flv, mp4 (in H.264 format) and mp3 files. Videos are embedded and audio files played with the help of this player.

D’autres format de vidéos peuvent aussi être activés, mais les utilisateurs doivent alors posséder sur le ordinateur le logiciel nécessaire pour les lire, il faut aussi que les plugin adéquats doivent être installés dans le navigateur web qui sera utilisé.


[image: Configure the Embedded Media block]
Configure the Embedded Media block




	Sélectionnez les types de fichiers que vous désirez autoriser à vos utilisateurs de placer sur leurs pages de leurs portfolios.


	Cliquez sur le bouton Enregistrer pour sauver vos modifications.





Note

Si vous autorisez des formats de fichier qui ne peuvent pas être affichés par Flowplayer, certains utilisateurs qui n’auraient pas les logiciels nécessaires ne pourront pas voir ou écouter ces médias.






8.6.1.2. Type de bloc : Wall

Vous pouvez limiter le nombre de caractères de chacun des messages qui seront écrits sur le Mür. Les messages déjà placés ne seront pas modifiés.


[image: Configure wall settings]
Configure wall settings




	Fixez le nombre maximum de caractères que vous autorisez pour les messages à placer sur votre mür.


	Cliquez sur le bouton Enregistrer pour sauver vos modifications.







8.6.1.3. Type de production : Comment

Si vous activez l’option de l’évaluation par note, chaque élément pourra être évalué par une échelle de 1 à 5 représentée par des petites étoiles.


Note

La note ne peut pas être appliquée seule. Il faut aussi ajouter un commentaire ou joindre un fichier.




[image: Enable comment ratings]
Enable comment ratings




	Sélectionnez cette option si vous désirez autoriser l’évaluation par notes.


	Cliquez sur le bouton Enregistrer pour sauver vos modifications.







8.6.1.4. Type de productions : File


	Quota par défaut : Vous fixez ici le quota d’espace disque par défaut qui sera appliqué à tous les nouveaux utilisateurs. Le quota des utilisateur déjà existants ne sera pas modifié.


	Quota maximum : Vous fixez ici la valeur maximale du quota d’espace disque qu’un administrateur a le droit de fixer pour un utilisateur dans l’institution qu’il administre. Les quotas déjà attribués aux utilisateurs existants ne seront pas revus à la baisse.


	Upload agreement: Enable this option if you would like to force users to agree to certain terms before they can upload a file to the site. They must accept this agreement before tey are able to choose a file from their computer to upload to Mahara. A default agreement is provided, but you can also write your own and use that instead.


	Profile picture size: Choose the maximum size of the profile pictures for users. All images uploaded to the profile pictures area will be resized to these dimensions.


	Default comment permissions: The selected artefact types have comments enabled per default. Users can override these settings for individual artefacts in the files area. You can enable comments for:


	Fichiers


	Dossiers


	Images


	Images du profil


	archives, soit les fichiers compressés






	Cliquez sur le bouton Enregistrer lorsque vous avez terminé de faire vos modifications.







8.6.1.5. Type de production : Profile

For profile information you can decide which fields a user must provide when a user account is created manually or via csv file. These fields are marked mandatory.

The profile fields marked public are available for all logged-in users to search upon within another user’s public profile area.


[image: Choose mandatory and public profile fields]
Choose mandatory and public profile fields




	Select the fields that you wish to make mandatory and / or public.


	Cliquez sur le bouton Enregistrer pour sauver vos modifications.







8.6.1.6. Authentification : SAML

Si vous désirez utiliser le système d’authentification SAML pour votre site, vous devez indiquer ici le chemin pour atteindre la librairie php SAML.


[image: Prepare your site for SAML authentication]
Prepare your site for SAML authentication




	SimpleSAMLphp chemin d’accès à la librairie : Indiquez ici le chemin d’accès à dossier qui contient la librairie de SimpleSAMLphp, par exemple, si le chemin d’accès à fichier exécutable autoload.php est /chemin-vers/simplesamlphp_1_3/lib/_autoload.php alors cette valeur doit être /chemin-vers/simplesamlphp_1_3/


	SimpleSAMLphp chemin d’accès au fichier de configuration : Indiquez ici le chemin d’accès au dossier qui contient le fichier de configuration à utiliser avec ce prestataire de services (SP) SimpleSAMLphp, par exemple : si le chemin vers le fichier config.php et /chemin-vers/simplesamlphp_1_3/config/config.php cette valeur doit être /chemin-vers/simplesamlphp_1_3/config/


	Cliquez sur le bouton Enregistrer pour sauver vos modifications.







8.6.1.7. Interaction : Forum

The post delay setting determines the time (in minutes) that users have for editing their forum posts before they are mailed out. Once a forum post has been mailed and further edits are made, the date, time and editor are kept track of in the post.


[image: Set the edit time before the forum post is finalised]
Set the edit time before the forum post is finalised




	Détermine le temps après lequel le message est envoyé et que les modifications ultérieures seront indiquées dans le message.


	Cliquez sur le bouton Enregistrer pour sauver vos modifications.









8.6.2. Filtres HTML

Mahara uses HTML Purifier [http://htmlpurifier.org/] to filter out malicious code that could threaten the security of the system. If you have code, e.g. iFrames or javascript that you wish to use and that otherwise gets filtered out, you will have to write a filter to circumvent that. Filters should always be specific to their purpose and not give “carte blanche” to ensure security as much as possible.

Mahara already comes with a number of installed filters. Others can uploaded and then be installed. If you have downloaded a new set of HTML filters, you can install them by unzipping the file into the folder /htdocs/lib/htmlpurifiercustom and then click the Install button.







          

      

      

    

  

    
      
          
            
  
8.7. Fonctions expérimentales

As site administrator you have two experimental features available to you:


	exportation par lot au format Leap2A


	importation par lots au format Leap2A




You cannot access these features from any navigation, but must type in the URL directly.


Avertissement

L’export ou l’import de portfolios utilisent beaucoup de ressources informatiques. De ce fait les fonctions de gestion par lots des utilisateurs, requièrent beaucoup plus de mémoire vive que lors d’un usage courant de Mahara. Veuillez commencer par faire des essais sur une installation de test ou procéder à des importations/exportations avec un faible nombre d’utilisateurs, avant de vous lancer dans la gestion d’une institution en entier.




8.7.1. Exportation par lots au format Leap2A

[votre adresse URL normale de Mahara]/admin/users/bulkexport.php

Si vous devez exporter le portfolio de plusieurs utilisateurs en une seule fois, vous pouvez effectuer cette tâche à l’aide de la page d’exportation par lots. Rappelez-vous qu’il s’agit d’une fonction expérimentale dans la version actuelle de Mahara.


[image: Experimental feature: Bulk export]
Experimental feature: Bulk export




	Institution : Choisissez depuis quelle institution vous désirez exporter tous les portfolios des utilisateurs dans le format Leap2A.


	Usernames to export: Alternatively, choose this option if you only wish to export some users” portfolios.


	Cliquez sur le bouton Exporter utilisateurs pour lancer le processus d’exportation. Celui-ci peut durer relativement longtemps.





Note

You can look up the usernames on the user search page.






8.7.2. Importation par lots au format Leap2A

[votre adresse URL normale de Mahara]/admin/users/bulkimport.php

Si vous devez importer le portfolio de plusieurs utilisateurs en une seule fois, vous pouvez effectuer cette tâche à l’aide de la page d’exportation par lots. Rappelez-vous qu’il s’agit d’une fonction expérimentale dans la version actuelle de Mahara. Vous devez posséder les fichiers au format Leap2A pour effectuer cette tâche. Les fichiers au format HTML ne sont pas importables de cette manière.

La manière la plus simple d’importer le portfolio d’un ensemble d’utilisateurs et de posséder le fichier d’exportation créé lors d’une exportation par lot au format Leap2A. Si cela n’est pas possible, vous pouvez créez à la main le fichier ZIP adéquat.


8.7.2.1. Importation par lots en utilisant un fichier d’exportation par lots


[image: Experimental feature: Bulk import]
Experimental feature: Bulk import




	Idéalement et le plus souvent, on souhaite importer des utilisateurs qui ont été  exportés en lots depuis une autre plateforme Mahara (= migration). De ce fait, le fichier d’export par lots contient toutes les informations nécessaires ainsi que tous les fichiers des utilisateurs à migrer.


	Institution : Choisir l’institution dans laquelle les nouveaux utilisateurs seront placés.


	Fichier d’importation de masse : Choisissez le fichier ZIP qui contient les portfolios à importer en masse. Un nouveau compte d’utilisateur sera créé pour chaque nouveau portfolio.


	**Envoyer aux utilisateurs un courriel au sujet de leur compte ? » » : Sélectionnez cette option si vous désirez qu Mahara envoie un courriel à chaque utilisateur après que leur nouveau compte soit créé. Ceci peut être particulièrement important si vous vous avez dû modifier leur nom d’utilisateur ou s’ils ne sont pas au courant que leur compte a été modifié.


	Cliquez sur le bouton Importer comme débuter le processus. Soyez patient car l’importation de nombreuses données peut prendre du temps.





Note

Avant d’importer ces nouveaux nouveaux utilisateurs, vous pouvez modifier leur nom d’utilisateur dans le fichier usernames.csv contenu dans le fichier ZIP que vous avez précédemment exporté avec l’option d’exportation en masse.






8.7.2.2. Importation en masse en partant de zéro

Si vous désirez importer les portfolios d’utilisateurs pour lesquels vous n’aviez pas préalablement procédé à une exportation en masse, cela reste possible de le faire d’un seul tenant.


	Créez un dossier et nommez-le par exemple : mahara-import-en-masse.


	Créez le fichier CSV usernames.csv que vous placez dans votre dossier mahara-import-en-masse.


	Créez une ligne pour chaque utilisateur. Cette ligne doit contenir le nom d’utilisateur et le nom du fichier ZIP qui contient les documents à importer au format Leap2A. Les deux informations doivent être séparées par une virgule.


	Créer un sous-dossier que vous nommez users. Ne le nommez pas différemment, sinon l’importation ne fonctionnera pas.


	Placez tous les fichiers Leap2A que vous désirez importer dans une institution dans le sous-dossier users. Vérifiez ensuite que chacun de ces fichiers est référencé dans le fichier usernames.csv.


	Créez une archive ZIP du dossier mahara-import-en-masse, après que vous y ayez ajouté tous les utilisateurs.


	Dans un navigateur web, allez à [l’URL de votre site Mahara]/admin/users/bulkimport.php.


	Institution : Choisir l’institution dans laquelle les nouveaux utilisateurs seront placés.


	Fichier d’importation de masse : Choisissez le fichier ZIP qui contient les portfolios à importer en masse. Un nouveau compte d’utilisateur sera créé pour chaque nouveau portfolio.


	**Envoyer aux utilisateurs un courriel au sujet de leur compte ? » » : Sélectionnez cette option si vous désirez qu Mahara envoie un courriel à chaque utilisateur après que leur nouveau compte soit créé. Ceci peut être particulièrement important si vous vous avez dû modifier leur nom d’utilisateur ou s’ils ne sont pas au courant que leur compte a été modifié.


	Cliquez sur le bouton Importer comme débuter le processus. Soyez patient car l’importation de nombreuses données peut prendre du temps.





Note

Le fichier CSV usernames.csv doit correspondre à l’exemple ci-dessous et ne doit pas contenir de ligne d’en-tête :


"petra","mahara-export-leap-user4-1334451885.zip"

"polly","mahara-export-leap-user5-1334451888.zip"













          

      

      

    

  

    
      
          
            
  
9. Administration des institutions

Les administrateurs des institutions peuvent gérer les membres et les pages de ces dernières, mais ne peuvent pas modifier le site lui-même. Ils peuvent :


	modifier les paramètres de l’institution


	rechercher des utilisateurs au sein de leur(s) institution(s)


	suspendre des utilisateurs au sein de leur(s) institution(s)


	ajouter des utilisateurs l’un après l’autre ou au moyen d’un fichier csv


	inviter les utilisateurs de leur institution


	retirer les utilisateurs de leur institution


	modifier le rôle des membres et le promouvoir comme personnel ou administrateur


	créer et partager des pages dans leur(s) institution(s)


	téléverser des fichiers dans leur(s) institution(s)




La plupart des ces fonctionnalités ressemblent à celles qu’ont les administrateurs du site, en ce qui concerne les utilisateurs et la gestion des institutions.





          

      

      

    

  

    
      
          
            
  
10. Mahara mobile

Vous pouvez utiliser certaines fonctionnalités de Mahara depuis un téléphone mobile ou une tablette, qui ont possèdent des outils permettant de se connecter à Internet. En fonction du matériel utilisé, toutes les fonctionnalités ne sont pas nécessairement accessibles sur votre mobile.

Si vous possédez un appareil fonctionnant sous le système d’exploitation Android ou un iPhone, vous pouvez utiliser des applications spécifiques pour téléverser des documents directement depuis votre appareil dans Mahara.


10.1. MaharaDroid

Le logiciel ouvert (open source) MaharaDroid [http://code.google.com/p/maharadroid/] permet aux utilisateurs d’outils sous Android de partager / téléverser du contenu dans une instance Mahara. Vous pouvez faire cela avec n’importe quel contenu que vous pouvez partager sur votre tablette ou téléphone sous Android.

Vous n’avez pas à installer d’autre plug-in ou programme supplémentaires pour bénéficier de ces fonctionnalités mobiles. Référez-vous aux instructions sur le site MaharaDroid pour de plus amples informations quant à la manière de configurer l’application et de la lier à Mahara.




10.2. PortfolioUp

PortfolioUp [http://www.brightcookie.com/our-services/consulting-additional-services/portfolioup/] est une application pour iPhone qui permet de téléverser des images, depuis votre bibliothèque d’images de l’iPhone, dans Mahara. Vous devez aussi installer un plug-in supplémentaire dans Mahara pour que l’application puisse fonctionner.







          

      

      

    

  

    
      
          
            
  
1. Liste des travaux à effectuer





          

      

      

    

  

    
      
          
            
  
2. Information pour les rédacteurs de documentation sur Mahara

Voici la liste de mes travaux en cours sur la documentation. Je propose des normes et des recommandations sur un certain nombre de choses. Je désire les centraliser dans un seul endroit où d’autres contributeurs pourront s’y référer. ;-)

Les points de la liste ne font pas référence à un ordre particulier


	Les copies d’écran sont placées dans le texte comme des figures et comprennent un texte alternatif si l’image ne peut pas être chargée, de même qu’une description de la figure. Cette dernière recevra la numérotation ad hoc lors de l’exportation en PDF.


	Les encadrés sont à utiliser pour :



	note : pour tout ce qui doit retenir l’attention de l’utilisateur


	alerte: pour ce qui doit être traité avec précaution


	voir aussi : pour référencer les autres documents qui pourraient intéresser l’utilisateur. Des références à d’autres documents peuvent aussi être intégrées directement dans le texte.


	à faire : pour créer une liste de choses à faire









	Les boutons comme Enregistrer ou Copier page et aussi les sections du portfolio comme Contenu, Portfolio, etc., sont mises en évidence en corps gras (avec un seul *).


	Des petis boutons peuvent être placés dansle texte.


	Les copies d’écran des sections de Mahara ne sont pas placées dans le texte mais reçoivent la directive « figure ». Elles comprennent toujours un code  « alt » ainsi qu’une brève description qui s’affiche au bas de l’image et est numérotée dans LaTeX PDF.


	Les copies d’écran doivent avoir aussi peu d’instruction de pas à pas que possible. Il est préférable de n’avoir sur l’image qu’un numéro dans texte, afin qu’il soit plus facile à assurer la traduction des instructions dans plusieurs langues. Cela permet aussi aux traducteurs de modifier la traduction sans préalablement être obligés de refaire les copies d’écran.


	Inline images that are refered to in the textsuch as [image: edit] should be included as shortcuts with the reference at the bottom of the page.


	Une entrée d’index doit être créée pour chaque section


	Les sections importantes doivent être divisées en plusieurs pages, afin de les rendre plus faciles à modifier et à gérer.


	reStructuredText ne gère pas la hiérarchie dans le niveau d’en-têtes. Ces derniers dépendent des fichiers individuels. Toutefois, pour être cohérent, la convention suivante existe :



	Titre 1, par ex. 1.: ===============


	Titre 2, par ex. 1.1.: —————


	Titre 3, par ex. 1.1.1.: ~~~~~~~~~~~~~~~


	Titre 4, par ex. 1.1.1.1.: ^^^^^^^^^^^^^^^









	Une structure à plus de 4 niveaux doit être évitée.


	Les copies d’écran de la version originale du manuel ont été réalisée avec Shutter sous Ubuntu. Il est ensuite facile d’ajouter les puces numérotés pour indiquer les étapes à effectuer. Toutefois il est possible d’utiliser d’autres logiciels mais il serait bien que la couleur de la numérotation reste la même (soit #4C711D).


	La numérotation sur les copies d’écran se réfèrent au pas-à-pas décrit sur la page.


	Les copies d’écran ne devraient montrer que les zones importantes et non l’entier de l’écran, la barre d’adresse URL, etc.
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Register your Mahara Site

You can choose to register your Mahara Sie with I
manars.org, and help us fo build up a icture of the Mahara
installation base around the world. Registeing will remove
this notce.

You can register your site, and preview the information that
will be senton the Site Registration page.

Mahara: Site Information

View Full Sie Statistics
Site Installed: 27 June 2011

Database Size: 13.3M5

Mahara version: 1.4.1testing

Cron: Cron s not running.

See the installation guide for instructions
on how to setit up.

Close Site

You may close the site 1o everyone
‘except administrators. This will be useful
when preparing for a database upgrade.
‘Only administrators will be able to log in
until you either reopen the site, or an
upgrade s successfully completed.

Configure Site

+ Site options - Configure basic ste options such as the name, language and
theme.

« Edit site pages - Edit the content of various pages around the site

* Menus - Manage the links and files within the Links and Resources and Footer
Menus

+ Networking - Configure networking for Mahara

* Site Pages - Create and administer pages and page Templates for the entire:
site

« Site Files - Upload and administer files that can be putin the Links and
Resources Menu and in Site Pages

Manage Users

+ User Search - Search all users and perform administrative actions on them

+ Suspended Users - Suspend or reactivate users ffom using the site

« Site Staff - Assign users Staff permissions

+ Site Admins - Assign Site Administrator access rights

+ Admin Notifications - Overview of how adminisirators receive system
notifications

« Add User - Create a new user

+ Add Users by CSV - Upload a CSV file containing new users.

Manage Groups

+ Administer Groups - Appoint group administrators and delete groups.
+ Group Categories - Add and edit group categories

Manage Institutions
+ Institutions - Install and manage installed nstutons.
+ Institution Members - Associate users with nstutons.
+ Institution Staff - Assign users Staffpermissions
+ Institution Administrators - Assign Instution Administrator acoess ights

« Institution Pages - Create and administer Pages and Page Templates for an
Institution

« Institution Files - Upload and manage files or use in Institution Pages.

Administer Extensions

« Plugin Administration - Install and configure plugins
« HTML Filters - Enable new fillrs for HTML Purifier





